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Introduction to Robot Monitor /

Introduction to Robot Monitor
Robot Monitor is a tool that collects and presents IBM i, AIX, Linux, and VIOS partition performance
data in real time. This data is recorded and summarized for later presentation in other formats.

A single IBM i system or partition (known as the host system) manages the collection, storing, and
summarization of data. A PC is used to present most data to the user, and this PC communicates with
the host system. Performance data is collected under the supervision of programs running on a host
system.

The host system starts programs on itself and the remote machines, which send performance data
back to the host machine to be stored in the IBM i database. The host system manages this data for
real time display and later analysis. Communications are typically performed using TCP, although
SNA is supported in some environments.

Systems are able to monitor themselves (using a job called MON.LOCAL) during communications
failures and send the data to the central system when contact is reestablished. See the Robot
Monitor IBM i User Guide for more information.

Data (including individual monitors, disk data, summarized monitors, real-time data, and historical
data) is displayed using a graphical user interface (the GUI) that connects to the host system and
downloads the required data from server programs running on this machine. You can also store
summarized historical data locally or on another server using the GUI. The two main methods of
displaying the data in the GUI are summary dashboard views and more detailed system views. Both
the dashboard and system views provide drill-down functionality to allow you to view your data both
from a high level and a more granular level.

Partitioned systems are generally treated as separate systems, except that Robot Monitor can display
a list of allocations to the partitions on a single box. You also have the option of creating views that
cover groups of systems or all systems. There are special considerations for summarizing data at
higher levels when working with multiple systems, which are laid out in more detail in later sections
of this user guide.
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Getting Started / Configuring the Host System

Getting Started
After Robot Monitor has been installed on the PC and the host IBM i system, there are certain tasks
you must complete before you can use the software.

Configuring the Host System
The Robot Monitor graphical user interface (the GUI) needs to be configured with details on how to
contact the host system before you can run it. The configuration happens during the first Robot
Monitor installation and does not need to be configured again afterward.

If you want to change the configuration of the host system after the initial installation or configure a
new host system, you can do so from the Robot Monitor IBM i. See the Robot Monitor Green Screen
User Guide for more information.

Connecting to the Host System
Following installation of Robot Monitor to your PC, you can open Robot Monitor and connect to the
host system you set up during installation.

NOTE:You cannot connect to Robot Monitor using a different system unless that system is
configured as a host system.
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Getting Started / Connecting to the Host System

To connect to the host system and launch the GUI:

1. Enter the name of the host system you configured during set up. The IP address appears
automatically unless the system name is not recognized. You can use Verify to make sure the
host system is configured correctly.

2. If you are setup for an SSL connection, check the Use Secure Connection box. Otherwise,
leave the box unchecked.

3. Under Show Advanced, you have the following options:

l Enter the port number for the host system, if other than the default.

l Enter the job name of the IBM i jobs associated with your PC. Otherwise, leave the
value of *DFT to let Robot Monitor create a valid IBM i job name.

l If you need to use a different character translation table based on your locale, select the
appropriate code page from the Code Page dropdown. Otherwise, leave the default
value of Internal translation table.

4. Select Connect at Startup to bypass the logon screen when starting the GUI in the future.

NOTE: If you want to show the logon screen again, hold down Shift and start the
application. Release Shift when the logon screen appears.

5. Click Connect to launch the GUI and load the dashboard view.

You can also choose Work Offline instead of Connect. This allows you to work in the GUI
without being connected to the internet. Any work done while in Work Offline mode will be
saved until the next log on.
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Getting Started / Backing up your Configuration

Backing up your Configuration
After you install Robot Monitor on your PC, you can save the host configuration to a file and restore
it on another PC that is connected to the host system.

There are two ways to back up a configuration: by saving a file or sending the configuration through
an email. The following sections contain steps on how to create and save a backup of your host
configuration.

Backup to a File

To create a backup file of the host configuration, follow these steps:

1. Launch the Robot Monitor GUI on your system and log on to the host system for which you
want to create a backup.

2. From the Home Dashboard, click the File menu, then Backup/Restore Settings.

3. Select Backup to a File below the Backup Configuration options.

4. Under the items you wish to save, clear any you do not want included in the backup.
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Getting Started / Backing up your Configuration

You can save the following items:

l Your Communication Settings (the settings specified when connecting to the host
system)

l Your Dashboards (all dashboards or specific dashboards)

l Your Views (including all or specific Systems and Groups)

5. Enter the name and location of the place you want to save the backup file, or browse and
select a location from your PC.

6. Click Save Configuration File.

A message appears if the configuration exports successfully. If you want to see the backup file, click
Open Containing Folder to view its saved location.
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Getting Started / Backing up your Configuration

Email Configuration

To create a backup of the host configuration via email, follow these steps:

1. Launch the Robot Monitor GUI on your system and log on to the host system for which you
want to create a backup.

2. From the Home Dashboard, click the File menu, then Backup/Restore Settings.

3. Select Email Configuration below the Backup Configuration options.

4. Under the items you wish to save, clear any you do not want included in the backup.
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Getting Started / Restoring your Configuration

You can save the following items:

l Your Communication Settings (the settings specified when connecting to the host
system)

l Your Dashboards (all dashboards or specific dashboards)

l Your Views (including all or specific Systems and Groups)

5. Click Email Configuration File.

NOTE: In order for the email configuration to work, you need to have your email settings
defined. See the section on email options for more details.

Restoring your Configuration
Once a Robot Monitor configuration has been saved, you can restore it on multiple other systems.

To restore a saved configuration on a new PC, follow these steps:
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Getting Started / Restoring your Configuration

1. Launch the Robot Monitor GUI on your system and log on to the host system.

2. From the Home Dashboard, click the File menu, then Backup/Restore Settings to open the
Restore Configuration settings.

3. Enter the name and location of the configuration file, or browse and select a file from your PC.

4. Click the Load Configuration File button to open the restore options.

5. Clear any items in the configuration file that you do not want on your system, then click
Restore.

NOTE: If you choose to restore views from a configuration file, any currently defined views
on your PC will be overwritten.
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General Information / Robot Monitor Settings

General Information
The following pages describe general information about Robot Monitor.

Robot Monitor Settings
You can use the File menu to work with the following settings:

Tools
Use the settings under Tools to configure product security, export configurable elements as an MIB
file, view diagnostic information, and manage your licenses.

For more information, see Tools.

Automated Reports
Use Automated Reports to add graphs to a new report or run an existing report.

For more information, see Automated Reports.

Dashboard Slideshow Settings
Use the Dashboard Slideshow Settings to create a slideshow that cycles through your dashboards.

For more information, see Dashboard Slideshow Settings.

Print
This allows you to print your current screen, including dashboards and system views.

Export
This allows you to export your current view to an image, CSV, or text file.

For more information, see Export.

Options
Use the settings under Options to personalize your experience with Robot Monitor. This includes
email and speech settings.

For more information, see Robot Monitor Options.

Help

Use Help to open the Robot Monitor User Guide or go to the HelpSystems website.

Backup/Restore Settings
Use the backup and restore settings to save or restore your Robot Monitor configuration.

For more information, see Backing up your Configuration and Restoring your Configuration.

Quick Access Toolbar
The Quick Access Toolbar allows you to set up commands that you can use immediately without
having to access the File menu, Right-click menu, or Options ribbon for a particular view.
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General Information / Robot Monitor Settings

Depending on the view you are currently working with, some options on the Quick Access Toolbar
may not be available. Unavailable options are shaded (shown above).

Actions you can take:

l Click an available option to apply it to the current view. If you need a reminder, you can hover
over its icon to see what it is.

l If an icon has an arrow next to it, click it to display a drop-down list with more choices.

Clicking the option itself applies the top option by default. In this example, the command for
One Month would be applied.

l To access the Quick Access Toolbar Settings, click the Customize Quick Access Toolbar
button at the upper left-hand corner of the Robot Monitor GUI. Then, click More Commands...

Quick Access Toolbar Settings
The Quick Access Toolbar Settings window in Robot Monitor allows you to view, add, or remove
different commands from your Quick Access Toolbar. You can also add keyboard shortcuts for the
commands if you prefer to use hot keys instead of the GUI toolbar.

To access the Quick Access Toolbar Settings, click the Customize Quick Access Toolbar button
at the upper left-hand corner of the Robot Monitor GUI. Then, click More Commands...
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General Information / Robot Monitor Settings

Actions you can take:

l Choose a view from the Choose commands from drop-down list to see which related options
you can add to your Quick Access Toolbar. You can choose from the following views:

l To add commands to the Quick Access Toolbar, highlight the ones you want from the list on
the left and click Add.

l To remove commands from the Quick Access Toolbar, highlight them from the list on the right
and click Remove.

l To remove all commands applied to the Quick Access Toolbar and start over, click Reset.

l To change the order of the commands in your Quick Access Toolbar, highlight a command and
move it using the up and down arrows.

l Click Show Quick Access Toolbar below the Ribbon if you want the toolbar to appear below
the File menu instead of above it.

l Click Customize... if you want to setup keyboard shortcuts for frequently-used commands.
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General Information / Robot Monitor Settings

Customize Keyboard
Use the Customize Keyboard window in Robot Monitor to assign shortcut keys to the Quick Access
Toolbar options and commands.

Actions you can take:

l To add a shortcut key, select a category and corresponding command from the lists, then type
the key you want to apply it to into the Press new shortcut key field. Click Assign.

l To remove a shortcut key, select a shortcut key from the Current Keys list and click Remove.

l Click Reset All to remove all configured shortcut keys.

Tools
There are several tools you can use to manage Robot Monitor. They are listed below.

To get to the Tools menu, click the File menu, then Tools.

Security
This option allows you to log in and manage authorities. For details, see Security.
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General Information / Robot Monitor Settings

Export to MIB
Use this option to create a MIB file, containing all user-defined elements, that can be used by SNMP
managers such as Intermapper or HP Open view.

To export all user-defined elements:

1. If you are not on the Tools menu, click the File menu, then Tools.

2. Click Export to MIB.

3. Enter the name and location where you want to save the MIB file, then click the Export MIB
button.

4. After you have created the export, click the Open Containing Folder link to quickly access the
MIB file.

Program Log
Use this option to create a log file to help you diagnose issues with the Robot Monitor software.

To create a program log file:

1. If you are not on the Tools menu, click the File menu, then Tools.

2. Click Program Log.
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General Information / Robot Monitor Settings

3. To create a program log immediately, click Dump Flight Recorders.

4. To create a program log only when you exit Robot Monitor, check the Dump Flight Recorders
on Exit box.

Licenses
Use this option to manage your Robot Monitor licenses. You can load new licenses onto the IBM i
systems from here.

To load a new license file:

1. If you are not on the Tools menu, click the File menu, then Tools.

2. Click Licenses.

3. Browse to select the file you want.

4. Click Load Licenses from File.
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General Information / Robot Monitor Settings

Security
Depending on your needs, Robot Monitor offers two different kinds of security: IBM i security,
which requires a user profile and password to establish a connection between the GUI and the IBM i,
and Robot Monitor Security.

IBM i Security
IBM i security is Robot Monitor's default security option.

If you attempt to run a command in the GUI, for example, you will be prompted to log on to the IBM
i with a valid user profile and password before it will execute.

Robot Monitor Security
If you have more stringent security requirements, you may want to use Robot Monitor Security. This
security option allows you to limit access to Robot Monitor features and system information for
individual IBM i profiles and user groups.

To enable Security for Robot Monitor:

1. In the GUI, click File, then click Tools.

2. Under Security, click Log In. The Authority Logon dialog box displays.

3. Enter the user name and password for the QSECOFR profile. Select Stay Logged On if you
want to keep your session active.

4. Click OK. You should see this message in the bottom right corner of the screen, showing that
you are connected to the host system with Robot Monitor Security enabled.

You are now able to define authorized users, manage user groups, create authority lists, and
view a list of authorized systems.

NOTE:Always remember to add your own user profile as an authorized user immediately
after initiating Robot Monitor Security. QSECOFR should only be used to initiate security.

Once Robot Monitor Security is enabled and authorities are set, users must authenticate themselves
using the authority logon dialog box before they can (depending on the level of authority they have)
run a command from, add, change, view, or maintain the following:
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General Information / Robot Monitor Settings

l Data Definitions

l Thresholds

l PTF Listings

l Calendars

l SST Configuration

When you are finished managing your security options, log out to limit access to authorities and
authority lists for connected systems.

Authority Logon
The Authority Logon dialog box allows users to log on and access areas of Robot Monitor that have
security enabled.

Logging on will only be successful if the following criteria are met:

l Robot Monitor Security has been enabled.

l An authorized user has been created for the user profile.

To acess this dialog box, click Click to Logon in the lower right corner of the GUI or select Log In
from the Tools tab in the File menu.

To log on as an authorized user:

1. In the GUI, click Click to Logon in the lower right corner. The Authority Logon dialog box
displays.

2. Enter the user name and password for your profile.

3. Select Stay Logged On if you want to keep your session active when you log out.

4. Click OK. You should see this message in the bottom right corner of the screen, showing that
you are connected to the host system.

To enable Robot Monitor Security:

See Security for more information on how to enable Robot Monitor Security.
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General Information / Robot Monitor Settings

Authorized Users
The Authorized User List displays a list of defined users in Robot Monitor. From this window, you
can add a new user, copy or delete an existing user, and change user preferences.

Use the search bar to quickly filter the list by a specific user or system.

Adding a User

Follow the steps below to add a new authorized user to the Authorized Users List.

NOTE: To add a user, you must be logged on to the host system with a SECOFR user profile.

1. If you are not on the Authorized User List window, click the File menu, then Security, then
Authorized Users.

2. Click Add.

3. On the Authorized User Details panel, type a system into the System field or choose one from
the drop-down.

4. Type an existing user into the User Profile field or choose one from the drop-down. You can
click Refresh List if you do not see the user profile you want to add.

5. (Optional) Select a Default Authority List for the user. This authority list is assigned, by
default, to any objects the user creates.

6. Select which Special Authorities the user should have on the selected system. You have the
following choices:

Maint Add Change Visible Commands

Systems Allowed to open
a list of
authorized
systems.

Change
any
system he
can see.

All
systems
are visible.

Run
commands
on any
system.

Data
Definitions

Allowed to open
the Data
Definitions view
and make
changes to data
definitions.

Add new
data
definitions.

Change
any data
definition
he can
see.

All data
definitions
are visible.

Run
commands
against any
data
definition.

Thresholds Allowed to open
the Thresholds
view and make
changes to
thresholds.

Add new
thresholds.

Change
any
threshold
he can
see.

All
thresholds
are visible.
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General Information / Robot Monitor Settings

Maint Add Change Visible Commands

Users Allowed to open
the Authorized
Users view and
change users. As
this allows users
to assign any
rights to
themselves, this
right implies all
others and is
effectively a
SECOFR type of
right.

Calendars Allowed to open
the Calendars
view and
maintain
calendars.

SST Allowed to open
the
SST Configuratio
n view and define
access to system
service tools.

7. When you are finished, click OK to add the new user to the Authorized User List.

Copying an Existing User

Follow the steps below to create a new authorized user by copying an existing user's properties.

1. Right-click the user you want to copy and select Copy.

2. On the Authorized User Details panel, make any changes you need to the system, user profile,
default authority list, and special authorities.

3. When you are finished, click OK to add the copied user to the Authorized User List.

Editing a User's Properties

To edit an existing user's properties, right-click one and select Properties. The Authorized User
Details panel opens. From this panel, you can add the user to a default authority list or change their
special authorities.

Click OK to save your changes.
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Deleting a User

To delete a user from the Authorized User List, right-click one and select Delete. Click Yes when
prompted to confirm the deletion.

To delete multiple users at a time, hold down Shift and click the users you want to remove, then
right-click one of the highlighted users and select Delete.

NOTE:A user cannot be deleted if it is in a user group. Remove the user from the group before
attempting these steps.

Authorized User Groups
The Authorized User Groups window displays a list of defined groups in Robot Monitor that are used
to connect users to authority lists. You can assign one or more users to a group then assign the group
to an authority list. Authority lists are assigned to systems, elements, and thresholds to control access
to those objects.

From the Authorized User Group window, you can add a new user group, copy or delete an existing
group, and change group preferences.

Use the search bar to quickly filter the list by a specific user group.

Adding a User Group

Follow the steps below to add a new authorized user group to the list.

NOTE: To create a user group, you must be logged on to the host system with a SECOFR user
profile.

1. If you are not on the Authorized User Groups window, click the File menu, then Security, then
Authorized User Groups.

2. Click Add.

3. On the Authorized User Group Details panel, enter a Group Name and Description.

4. Select which users you want to add to the user group. You can select as many as you want.

5. When you are finished, click OK. The new group will be added to the Authorized User Groups
list.

Repeat steps 1-5 to add other user groups as needed, or click Cancel to close the Authorized User
Group Details panel.

Copying an Existing User Group

Follow the steps below to create a new authorized user group by copying an existing user group's
properties.

1. Right-click the user group you want to copy and select Copy.

2. On the Authorized User Group Details panel, make any changes you need to the group name,
description, and users.

3. When you are finished, click OK to add the copied user group to the Authorized User Groups
list.
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Editing a User Group's Properties

To edit an existing user group's properties, right-click one and select Properties. The Authorized
User Group Details panel opens. From this panel, you can add new users to the group or change the
group's description.

Click OK to save your changes.

Deleting a User Group

To delete a user group from the Authorized User Groups list, right-click one and select Delete. Click
Yes when prompted to confirm the deletion.

To delete multiple user groups at a time, hold down Shift and click the users you want to remove,
then right-click one of the highlighted user groups and select Delete.

NOTE:A user group cannot be deleted if it is in an authority list. Remove the user group from the
list before attempting these steps.

Authority Lists
The Authority Lists window displays all currently defined authority lists in Robot Monitor. The list
shows all user groups and any authorities that are assigned to them.

From the Authority Lists window, you can add new list details, copy or delete existing lists, and
change list preferences.

Use the search bar to quickly filter by list name or description text.

Adding an Authority List
Follow the steps below to create a new authority list.

1. If you are not on the Authority Lists window, click the File menu, then Security, then
Authority Lists.

2. Click Add.

3. On the Authority List Details panel, enter a List Name and Description.

4. Select which user groups you want to add to the authority list. You can select as many as you
want.

5. When you are finished, click OK.

Repeat steps 1-5 to add other authority lists as needed, or click Cancel to close the Authority List
Details panel.

NOTE: To create an authority list, you must be logged on to the host system with a SECOFR user
profile.

Copying an Existing Authority List
Follow the steps below to create a new authority list by copying an existing list's properties.
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1. Right-click the authority list you want to copy and select Copy.

2. On the Authority List Details panel, make any changes you need to the list name, description,
and groups.

3. When you are finished, click OK.

NOTE: To copy an existing authority list, you must be logged on to the host system with a SECOFR
user profile.

Editing an Authority List
To edit an existing authority list:

1. Right-click an authority list and select Properties.

The Authority List Details panel opens. You can change the list's description from here if
needed.

2. To add or remove special authorities to a group within this authority list, double-click a group
to open the Authority List Edit panel.

3. Select the option you want for Add, Change, Visible, and Commands. You can choose from Yes,
No, and Inherit.

If you select Inherit, Robot Monitor uses the special authorities applied to each authorized
user.

4. Click OK.

5. Click OK again to save your changes.

NOTE: To edit an authority list, you must be logged on to the host system with a SECOFR user
profile.

Deleting an Authority List
To delete an authority list, right-click one and select Delete. Click Yes when prompted to confirm
the deletion.

User Guide www.helpsystems.com page: 21



General Information / Robot Monitor Settings

To delete multiple authority lists at a time, hold down Shift and click the lists you want to remove,
then right-click one of the highlighted authority lists and select Delete.

NOTE: To delete an authority list, you must be logged on to the host system with a SECOFR user
profile.

Authorized Systems
The Authorized Systems window displays a list of all systems the current user is authorized to see.

Double-click a system to change the description text or authority list. To find a system quickly, use
the search bar to filter by system name, authority, or description text.

Automated Reports
In Robot Monitor, you have the option to add different graphs to the automated reports. The graphs
you add become part of the automated reports list until a report is run.

From the automated reports window, you can choose to add, edit and delete graphs in a report list.
You can also load a set of saved reports and run the reports.

Adding, Deleting, and Editing Reports
To add a new graph to the automated reports list, do the following:
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1. If you are not on the Automated Reports window, click File, then Automated Reports.

2. Click Add and select which graph you want to add to the report list. The properties panel for
the graph displays.

3. Review the properties and make changes as needed.

4. On the Output Options tab, you have the following options:

l Select how you want to export the graph: Print, Export to Image, Export to CSV, or
Export to Tabbed Text.

l Select the orientation of the graph: Default Orientation, Landscape, or Portrait.

l Choose a printer from the Select Printer panel, if other than the default.

NOTE: For an Image, CSV, or Tabbed Text export, you can add the date of the report to the
export file name by adding the following variables within the file name:
%y = Two digit year
%m = Two digit month
%d = Two digit day
For example, defining an export file name of 'DetailedGraph%y%m%d.csv' within the
Filename to Export text box would render a file in your chosen location named
'DetailedGraph012318.csv' (assuming the report date was January 23, 2018). For a
Detailed History report, the variables will pull the From Date rather than the To Date.

5. When you are finished, click OK.

Repeat steps 1-5 as many times as needed until all the graphs you want to run are in the automated
reports list.

To delete an existing graph from the automated reports list, highlight the graph you want to remove,
then click Delete.

To edit an existing graph, highlight it and click Properties. This opens the properties panel for the
graph.

Copying and Pasting Reports
You can copy and paste reports. You can also duplicate reports across different systems using the
Paste for Multiple Systems command.

1. Select the automated report you want to copy.

2. Click the Copy button in the lower left hand corner.

3. Click the Paste button to paste the copy in the Automated Reports list.

4. Select the copied report and click the Properties button to edit as desired.

To duplicate reports across different systems using the Paste for Multiple Systems command:

1. Select the automated report you want to copy for other systems.

2. Click the Copy button in the lower left hand corner.

3. Click the arrow icon next to the Paste button and then select Paste for Multiple Systems....

4. In the Paste for Multiple Systems window, select the report that you copied, then check all
systems that you would like to duplicate that report for.
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5. Click OK. The report or reports will be duplicated for all selected systems.

Managing Reports
From the Manage Reports sidebar, you can save, load, or clear a set of reports.

To save a new report, add graphs to the automated reports list (see add instructions above), then
click Save. The Save As window opens. Type in a name and location for the file, then click Save
again to create the report on your system.

To load an existing report into Robot Monitor, click Load. Choose the save file you want from your
system, then click Open to display the set of reports in your automated reports list.

To clear the automated reports list, click Clear. The list will be removed immediately, so make sure
it is saved on your system beforehand.

Scheduling Reports
You can schedule reports to run using Task Scheduler (a program that automatically comes with
Windows) or another application that allows tasks to be scheduled.

Running Reports
When you are ready to run a report, you have two options:
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1. Create a new reports set or open a saved set from your PC.

2. Choose how you want to run your report.

l Click Run to run the report. This make take a few moments.

l Click Run and Email to run the report and send the results to an email. Under Run and
Email Options, you can determine the email recipient and email subject. When the
report is done, the results will be send to the email specified.

NOTE:Before running the report, make sure the graphs have the output option you want.
The default output is Print, so they will be sent the printer when the report is done.

Dashboard Slideshow Settings
In Robot Monitor, you have the option to a create a slideshow that cycles through your dashboards.

From the Slideshow Settings screen you can define which dashboards are show, in what order, and
for how long.
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Adding a Slideshow Entry
1. To add a dashboard to the slideshow, from the Dashboard Slideshow Settings screen, select the

Add button.

2. Select the dashboard you would like to add to the slideshow (this dashboard must be created
prior to adding it to the slideshow).

3. Select the duration you would like the dashboard to appear for before moving on to the next
slide.

4. When you are finished, press OK.

Editing a Slideshow Entry
1. To edit an existing slideshow entry, from the Dashboard Slideshow Settings screen, either

double-click the entry or click the entry and select Properties.

2. Make the necessary changes to the Slideshow Entry window.

3. When you are finished, press OK.

Deleting a Slideshow Entry
To delete a dashboard from the slideshow, from the Dashboard Slideshow Setting screen, simply
click the entry and select Delete. This will not delete the dashboard from Robot Monitor. It will only
remove the entry from the slideshow.

Viewing a Slideshow
There are two ways to view the Dashboard Slideshow after you create it.
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1. From the Dashboard Slideshow Settings screen, select Run Dashboard Slideshow.

2. From the View bar, under Dashboards, select Start Dashboard Slideshow.

Export
You can export your current view in Robot Monitor to an image, csv file, or text file.

To get to your Export options, click the File menu, then Export.

There are three ways to export your current view. The following sections contain steps on how to do
this.

NOTE: Some export options may be unavailable, depending on the type of data you want to save.
For example, a dashboard can only be saved as an image. Data definitions can only be saved as
csv or text files.
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Export to Image

You can export your current view as an image with a variety of different file extensions.

To export a view as an image, follow these steps:

1. Enter the name of the file and the place you want to save it to. Note: You can change .jpg to a
preferred extension.

2. Choose the width and height of the image. If you want the image to balanced proportions, click
Maintain Aspect Ratio.

3. Click Export Image.

Export to Csv
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You can export your current view as a csv file, which can then be loaded by most spreadsheet
applications.

To export a view as a csv file, follow these steps:

1. Enter the name of the file and the place you want to save it to.

2. Click Export Data.

Export to Text

You can export your current view as a text file. This is useful if you want to import the data into
other applications.

To export a view as a text file, follow these steps:

1. Enter the name of the file and the place you want to save it to.

2. Click Export Data.

Robot Monitor Options
There are several options you can set in Robot Monitor. These cover general settings (such as start-
up behavior), email settings, and speech settings.

To open this page, click the File menu, then Options.
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Miscellaneous Options
Use the Miscellaneous options to change general settings for Robot Monitor.

To change these settings:

1. If you are not on the Options menu, click the File menu, then Options.

2. Click Miscellaneous.
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3. Select Automatically connect on startup to have Robot Monitor connect to the previously
defined host system when you start the program, instead of displaying the Getting Started
screen.

4. Select Resize groups with frame to allow groups that are docked to the view's edge to be
resized when the view changes.

5. Select Force US Decimal Point if you want to use a period for decimal points (US version)
instead of a comma for decimal points.

6. Select Show legacy user bars to display user bars in the QSystem Monitor style.

NOTE: The Show legacy user bars option relates to the original User Defined elements
added to the CCSS product QSystem Monitor. This option is only relevant for a few CCSS
customers who used the old version of this product. If you are a new user, you can safely
ignore this option.

7. Select Visually enhance charts if you want to add more visual appeal to your charts.

8. Click Reset Object Cache if you want to force a download from the host systems cache.
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9. The entries underWeb site templates for PTF searches define the websites that are accessed
from the PTF Comparison view to show the details of a selected PTF.

Email Options
Use the Email options to configure the outgoing mail server so that Robot Monitor can contact the
email server when sending an email. Note: Only an administrator with knowledge of email servers
should change these settings.

To open this page, click the File menu, then Options. Then, click Email.

Speech Options
When Robot Monitor was installed, you were given the option of installing the text-to-speech engine
on the PC. If you accepted this option, text-to-speech will be used to highlight certain alarm
conditions.

This function is driven by options on the threshold records. When a threshold that has speech
enabled is selected, and the speech option is also enabled, the long description from the threshold is
passed to the text-to-speech engine. The engine then reads out the text, alerting you to a problem
without interrupting your work flow.

The default voices supplied with text-to-speech engine in Robot Monitor are fairly basic. If you find
the speech option useful, you can buy some better voices for it. We recommend the AT&T natural
voices, which you can download from the web for a small fee.

To change the Speech Options settings:
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1. If you are not on the Options menu, click the File menu, then Options.

2. Click Speech.

3. Under Announce Options:

a. Select Play Threshold Sounds if you want to be alerted every time a set threshold is
triggered.

NOTE:You can set a threshold sound for each threshold using the Threshold Detail
Record panel.

b. Select Enable Speech to allow speech within Robot Monitor. Clear the check mark to
disable speech.

The following two options are available only when speech is enabled.

c. Select Use full system description to use the long description from the system record to
identify the system when speaking. Otherwise, the eight character system name is used.

d. Enter a value for Speak when severity >= to control which threshold records are
passed to the speech engine. The records at the specified severity or greater are
selected for speech.

4. Under Speech Engine:

a. Select either SAP14 or SAP15. Then, select an engine from the drop-down list.

b. Adjust the Rate at which alarm conditions are highlighted by using the slider. The range
is from slow on the left to fast on the right.

c. Adjust the Volume for the text-to-speech engine by using the slider. The range is from
quiet on the left to loud on the right.
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The Views Menu
The following menu is displayed on the left side of the Robot Monitor GUI. Use this menu to
navigate Robot Monitor's dashboards, systems, thresholds, and more.
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From the Views Menu, you can access the following sections of Robot Monitor:
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Dashboards
Option Description

Home Dashboard Displays the default dashboard that you see after logging on to Robot
Monitor.

Show Dashboards
List

Allows you to view and edit all available dashboards in Robot
Monitor.

NOTE:Depending on the amount of dashboards you have created, you may see an option for
More... in the Views Menu. Click this to expand the list of dashboards.

Systems, Groups
The most recently used systems and groups show up here.

You can also click Show Systems List to view the Systems and Groups screen. This allows you to sort
through and access all the systems and groups you have configured in Robot Monitor.

NOTE:Depending on the amount of systems and groups you have, you may see an option for
More... in the Views Menu. Click this to expand the Systems and Groups list.

Threshold Activity
Option Description

Current
Thresholds

Displays all currently active thresholds and allows you to acknowledge
them or print them right from the list.

Threshold
Log

Displays a history of triggered thresholds. You can print the history log or
save it to a file.

Configuration
Option Description

Data
Definitions

Allows you to see the data elements that are currently being collected
within the Robot Monitor environment.

Thresholds Displays the threshold view, which shows the thresholds that have been
globally defined, as well as those that have been defined locally.

Calendars Allows you to maintain the calendars that are to be used when creating
threshold selectors.
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Option Description

Configure
SST

Allows you to configure SST Access for Robot Monitor.

Reports
From the Reports section, you can access the PTF Listings, which allows you to compare PTFs you
have applied to different systems.

Data
The following pages describe the online and offline data, configurable elements, and environmental
data found in Robot Monitor.

Online and Offline Data
Online data

Online data is collected and displayed in real time. The types of data collected are divided into two
main categories: Built-in Elements and Configurable Elements.

Offline data

Offline data is collected daily and can only be viewed historically. Robot Monitor collects
information on disk usage and job accounting information, then stores a summary of the data in the
central machine's database for display and analysis using different system views.

Configurable Elements
In addition to the built-in elements that come with Robot Monitor, you can configure and monitor
dozens of data types for a single system, for multiple systems, or for all systems.

Configurable data types include communications performance and status, job performance and
status, system performance, and memory performance, among others.

See the section on Data Types for a full list of the configurable elements available in Robot Monitor.

Exceptional Jobs
Each time Robot Monitor collect a detailed sample, it also collect a list of exceptional jobs.
Exceptional jobs are jobs that a) use the most of a particular resource or b) experience the worst
performance.

The types of exceptional jobs collected are as follows:
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Response Time

The high response time list shows interactive jobs experiencing the worst performance on the
system. This can be useful in determining whether high average response time is due to a single job
performing unusual activity, or whether a large number of users is experiencing high response time.

CPU Usage

The high CPU usage list shows the jobs using the most CPU in the system. This can be useful in
pinpointing jobs using excessive in the amounts of CPU and having a system-wide effect on
performance.

Database CPU Usage

The high database CPU usage list shows the jobs using the most database CPU in the system. On
systems with limited database CPU capability, this can be useful in pinpointing jobs that consume
more than their fair share of database CPU or have an adverse effect on other jobs in the system.

Disk I/O

The high disk I/O usage list shows jobs performing the most disk I/O in the system. There are two
principal uses for this list: first, if unusually high disk activity has an adverse effect on system
performance, this list can help you determine which job is causing the problem. Second, a runaway
jobs that is consuming all auxiliary storage on the system can be very difficult to track down. This list
can be used to identify likely candidates when this happens, particularly in conjunction with the high
database CPU usage list. A combination of high disk I/O and high database CPU usage usually
indicates a job that is writing a large number of records to the database.

Environmental Data
Robot Monitor collects a significant amount of environmental data and brings it together in a single
convenient location in the Robot Monitor GUI.

Instead of checking the output for a number of commands, the following views provide a useful
summary of vital system information.

The Monitor View

The Box View

The ASP Information View

The PTF Comparison View

General Principles
The following sections discuss some concepts that apply to various aspects of Robot Monitor.

Label Templates

In many places throughout Robot Monitor, you can specify a label template. Label templates are used
to determine what text displays to distinguish a particular element or group from other elements or
groups.
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A template is made up of a combination of text and variables. To indicate the desired data, variables
are denoted using an ampersand followed by a letter or a number. For instance, you can specify the
label template string &s &d to display the system name and element description for each item in a
group.

The variables that can be specified for label templates are listed in the section for the panel on
which they appear. Templates are hierarchical; if an item does not have a template specified, it
inherits one from its parent item.

Scaling

By default, scaling in Robot Monitor adjusts automatically.

The scale is normally stored as part of the element definition and is shared across all systems and
groups. However, you can override the scale for a system or enter scale values manually.

Data Types

There are four data types supported by Robot Monitor. The first three—text, integer and floating
point—are self explanatory.

Composite data types, however, requires some explanation. They are used for many of the averages
in Robot Monitor. Instead of carrying a calculated average figure, they carry the two values used to
calculate the average. For Auxiliary Storage, the figure is carried as megabytes used and megabytes
available.

When composite data types are displayed, the average calculation is performed. It displays as an
ordinary floating point item.

Where the difference becomes significant, however, is when composite figures are combined to
produce averages across systems. For instance, suppose we are monitoring CPW percentage used on
systems WA and KING. WA is using 150 out of 300 (50%) and KING is using 50 out of 200 (25%). If
a multiple system view is used to give the overall CPW usage figure for both systems, the average
will be calculated as (150 + 50) / (300 + 200), which gives an average of 40%.

Composite data types are indicated in the detailed descriptions of user defined element types.

Navigation
You have the option of moving forward and backward through previously viewed Robot Monitor
screens.

Actions you can take:

l Click the back button to move backward one screen from the currently viewed screen.

l Click the forward button to move forward one screen form the currently viewed screen.
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l Click the small down arrow next to the back and forward buttons to open a panel listing
the last ten screens you have viewed. Select the name of the screen from the list you would
like to navigate to.
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Dashboards Overview
The dashboards display information from the systems that Robot Monitor monitors. Use the
dashboards for viewing and analyzing data from across your network all on one screen. You can
quickly view your short-term history, your CPU usage, your disk summary, your accounting
summary, and more.

You can create more than one dashboard that will show up on the left hand sidebar on your screen.
You can use any combination of widgets in the same dashboard and adjust them to whatever length
and width you want, including overlapping them as needed.

When you are finished, you can lock your dashboard to keep your widgets from moving.

The Dashboard View
The Dashboard View opens when you select a dashboard from the Dashboards list in the Views
sidebar. It displays created widgets, images, and system icons, and allows you to see an overall view
of your systems or elements.

A dashboard can be set to default, and the default dashboard will be the first panel to open when the
GUI launches.

You can set a dashboard to default when adding a new dashboard or change the default to an existing
dashboard by customizing it.
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Working with Dashboards
The following sections contain general information about creating and using the Robot Monitor
dashboards.

Adding a Dashboard
You can create as many dashboards as you need to. Also, you can change a dashboard's layout and
settings any time after adding it.

Use the following steps to add a new dashboard to Robot Monitor:

1. Click Show Dashboards List under the Dashboards section on the Robot Monitor sidebar.

2. Click the Add button in the upper right hand corner on the Dashboards page.

3. Enter a unique Dashboard Name and brief Description.

If you want this to be the default dashboard (the one that opens when the GUI starts), check
Set as Default.

4. Click OK to save the dashboard.

After you create the dashboard, you need to add widgets to it.

Customizing a Dashboard
One easy way to customize your dashboard is to rearrange the widgets on it.

1. Click the dashboard you want to customize.

2. Click the Lock button in the upper right hand corner to unlock the widgets on the dashboard.

3. Click anywhere on the widget and drag it where you want it. Depending on the size of the
widget, you can overlap widgets on the dashboard or the widget will snap to the widget next to
it.

4. If you want to resize the widget, drag the edges of the widget until it is the size you want.
Depending on the size, some text may get cut off by other widgets.

For other customizations:

l To change the dashboard name or description, or to set the dashboard as default, click the
Settings button in the upper right hand corner and select Properties.

l Use the Auto Arrange button to reorganize and resize the widgets on your dashboard. Note:
You can undo auto arrange by pressing CTRL+Z on the keyboard.

l If you want to change the overlapping order of the widgets, right-click a widget and use the Z-
Order settings to move the widget to the front or back.

l To lock the dashboard (and ensure no accidental changes are made), click the Lock button
again.

l To delete widgets from a dashboard, see Deleting widgets.
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l To size and align widgets on a dashboard, see Sizing and aligning widgets.

l To copy and paste widgets on a dashboard, see Copying and pasting widgets.

Deleting a Dashboard
You can delete any dashboard you have created. However, in order to delete a dashboard, you must
ensure it is not set as default. You can do this by checking the Properties option under the
dashboard's Settings. If it is set as default, you will need to assign another dashboard as the default
before you can delete the current one.

Use the following steps to delete a dashboard.

1. Click the dashboard view you want to delete.

2. Click the Settings button in the upper right hand corner.

3. Select Delete This Dashboard. The dashboard is deleted immediately, so make sure you want
to delete the dashboard before completing this step.

Working with Widgets
After you create a dashboard, you need to add widgets to it.

Simple instructions for working with dashboard widgets are included in the following sections.

NOTE:Do you want to change the update interval for the data in your widgets? You can do this by
revising the monitoring interval specified in the System Summarization Options panel. See the
Robot Monitor 14 IBM i User Guide for more details.

Adding Widgets to a Dashboard
You can add as many widgets as you need to your dashboard. For many of the widgets, you can even
add more than one of each kind. But, be aware that number of widgets on the page does affect the
response time.

1. Click the dashboard view that you want to add widgets to.

2. Click the button in the upper right hand corner to unlock the dashboard.

3. Click the button.

4. Click the widget you want to add.

5. Customize the widget you added, then click OK.

NOTE:You can right-click a widget and select Properties to edit its settings at any time.

6. Adjust the widget to the size and location you would like.

7. When you are finished, click the button again to secure the dashboard view from further
changes.
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Deleting Widgets from a Dashboard
You can delete widgets from dashboards that you have created.

1. Click the dashboard view that you want to delete widgets from.

2. Click the Lock button in the upper right hand corner to unlock the dashboard.

3. Select the widget or widgets that you want to delete, then right-click and select Delete.

NOTE: The widget or widgets are deleted immediately, so make sure you want to delete the
widget before completing this step. If necessary, you can reverse the deletion by using the
keyboard shortcut (CNTL+Z) to undo.

4. When you are finished, click the button again to secure the dashboard view from further
changes.

Copying and pasting widgets from a Dashboard
You can copy and paste dashboard widgets. You can also duplicate widgets across different systems
using the Paste for Multiple Systems command.

1. Click the dashboard view that you want to copy widgets from.

2. Click the Lock button in the upper right hand corner to unlock the dashboard.

3. Select the widget or widgets that you want to copy, then right-click and select Edit > Copy.

4. Right-click the dashboard you want to copy to and select Edit > Paste.

5. When you are finished, click the button again to secure the dashboard view from further
changes.

To duplicate widgets across different systems using the Paste for Multiple Systems command:

1. Click the dashboard view that you want to copy widgets from.

2. Click the Lock button in the upper right hand corner to unlock the dashboard.

3. Select the widget or widgets that you want to copy, then right-click and select Edit > Copy.

4. Right-click the dashboard you want to copy to and select Edit > Paste for Multiple Systems....

5. In the Paste for Multiple Systems window, select the widget that you copied, then check all
systems that you would like to duplicate that widget for.
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6. Click OK. The widget or widgets will be duplicated for all selected systems.

7. When you are finished, click the button again to secure the dashboard view from further
changes.

Sizing and aligning widgets on a Dashboard
To size your dashboard widgets in comparison with one another:

1. Click the dashboard view.

2. Click the Lock button in the upper right hand corner to unlock the dashboard.

3. Select the widgets that you want to size together, then right-click and select Size. Your choices
are:

l Make same width

l Make same height

l Make same size

4. Select your desired sizing function. The selected widgets will resize.

5. When you are finished, click the button again to secure the dashboard view from further
changes.

To align your dashboard widgets in comparison with one another:

1. Click the dashboard view.

2. Click the Lock button in the upper right hand corner to unlock the dashboard.
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3. Select the widgets that you want to align together, then right-click and select Align. Your
choices are:

l Align Top

l Align Bottom

l Align Left

l Align Right

l Align Middles

l Align Centers

4. Select your desired alignment function. The selected widgets will realign.

5. When you are finished, click the button again to secure the dashboard view from further
changes.

Robot Monitor Dashboard Widget
Descriptions

The following are descriptions of each of the available Robot Monitor dashboard widgets.

NOTE: If the definition has been created across a number of partitions and the parameters do not
match all partitions, *NF (Not Found) might be displayed against some elements on that partition.
Review the purpose and contents of the widget you are creating.

Text Dashboard Widget
This widget displays any text you want to show up on your dashboard. You can use this widget to
organize portions of your dashboard by creating text labels, headings, reminders, and more.

Adding a Text Widget
On the dashboard you want to add the widget to, click the button in the upper right hand corner

to unlock for editing. Then click the button in the upper right hand corner and select Text from
the Static Elements drop-down list.

Things You Can Do
l You can customize the text to look however you want it to.

In the below example, a blue border and green background was added to bold text to make it
stand out amongst the other widgets. You can also change the text's font type and alignment.
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l Click and drag the corners of the widget to change its size and shape.

l Once the widget has been created, you can right-click it and select Properties to change its
settings any time. This only works if the dashboard is unlocked.

NOTE: To remove a widget from the dashboard, click to select it, then right-click and select
Delete.

Image Dashboard Widget
This widget displays any image you want to show up on your dashboard.

Adding an Image Widget
On the dashboard you want to add the widget to, click the button in the upper right hand corner

to unlock for editing. Then click the button in the upper right hand corner and select Image
from the Static Elements drop-down list.
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Things You Can Do
l You can choose which image you want to display on your dashboard.

l To keep the image proportional when resizing it on the dashboard, check Keep Aspect Ratio.
You can also change the image's alignment.

l Click and drag the corners of the widget to change its size and shape.

l Once the widget has been created, you can right-click it and select Properties to change its
settings any time.

NOTE: To remove a widget from the dashboard, click to select it, then right-click and select
Delete.

Threshold Summary Icon Dashboard Widget
This widget displays any icon you want to show up on your dashboard. The icon provides a summary
view of a system and can be arranged to show an overview of a network.

Adding a Threshold Summary Icon Widget
On the dashboard you want to add the widget to, click the button in the upper right hand corner

to unlock for editing. Then click the button in the upper right hand corner and select Threshold
Summary Icon from the Live Elements drop-down list.

Things You Can Do
l You can choose to display the status icon for a specific system on your dashboard.

The icon allows you to see, at a glance, the status of a particular system. Note: If you choose a
specific system, the system name will show below the status icon.
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l You can also choose a static icon by selecting the desired icon from the list of preexisting
icons.

To add personalized text to a static icon, type the text you want to display in the Label field.

An example of a customized icon

This icon is a customized, static icon. it is not tied to a specific system and will not change.
Though it does not give a system summary, the static icon is useful in showing where systems
are located on a world map. For example, you can impose a static icon over an image of the
United States and assign a short description to it.

l To add a customized icon to the icon list, click Add Icon and choose the icon file from your
computer.

l Once the widget has been created, you can right-click it and select Properties to change its
settings any time. This only works if the dashboard is unlocked.

l You can resize the icon by selecting the Resize Icon checkbox on the Icon Properties window
(right-click and select Properties) and dragging the icon selection handles to the desired size
on the dashboard.

l When the dashboard is locked, double-click the icon to display the Monitor view for the
selected system and data. Note: This does not work for static icons.

NOTE: To remove a widget from the dashboard, click to select it, then right-click and select
Delete.
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Monitor Graph Dashboard Widget
This widget displays real-time data for the systems you want to display on your dashboard.

Adding a Monitor Graph Widget
Use the following steps to set up a monitor graph for your dashboard:

1. On the dashboard you want to add the widget to, click the button in the upper right hand

corner to unlock for editing. Then click the button in the upper right hand corner and
selectMonitor Graph from the Live Elements drop-down list.

On the Item Selection tab:
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2. Type a short name for the widget in the Description field.

3. Choose whether you want the graph to be for a Single System, a System Group, or All
Systems.

4. Add data items to the graph from the Available Items list. You can filter the list by type using
the Filter drop-down list.

NOTE: The more items you add to the graph, the longer it takes to load. We recommend
using multiple monitor graph widgets on your dashboard to break up the items you wish to
view.

On the Graph Options tab:
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5. Choose whether you want the data to display in a Bar View or a Text View.

Text View Only: If you choose the Text View, you have the following options:
l Presentation: Choose whether you want text to show up in a block, bar, histogram, or
line.

l Rows/Columns: Choose how many rows and columns you want in your graph. The
maximum for each is 20.

l Exterior Label: Select which template string combination you want displayed to the left
of the monitored data. An exterior label is used to determine what text will be displayed
to distinguish a particular element or group. You can choose any of the following
template string combinations:

Template
String

Description

&d A short description of the element or group
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Template
String

Description

&d &t A short description of element or group and short description
from the threshold

&d &v A short description of element or group and value (raw data)

&p All the parameters from the data collection definition

&s A short system name

&s &d &v A short system name, short description of element or group,
and value (raw data)

&t A short description from the threshold

6. Choose Only display items with severity >= if you want items on the graph to only display
when they are greater than or equal to a particular severity level. You can type the severity
level in the field or choose a predefined level from the drop-down list.

7. Select which label template combination you want displayed in the bar view or text view data.
A label template is used to determine what text will display to distinguish a particular element
or group. You can choose any of the following template string combinations:

Template
String

Description

&d Short description of element or group

&d &t Short description of element or group and short description from
threshold

&d &v Short description of element or group and value (raw data)

&p All parameters from the data collection definition

&s Short system name

&s &d &v Short system name, short description of element or group, and
value (raw data)

&t Short description from threshold

8. Indicate what type of Sort organization you would like displayed in the graph.

9. Check the boxes of the settings you would like to apply to the graph. You can choose to
display the system icon, place the icon on the right (the default placement is on the left), shade
the background, and stagger the labels.

10. When you are finished, click OK. The completed graph will now appear on your dashboard.
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Things You Can Do
l Click and drag the corners of the widget to change its size and shape.

If you are monitoring several items at once, you may need to make the widget bigger to see
the descriptions.

l Once the widget has been created, you can right-click it and select Properties to change its
settings any time. This only works if the dashboard is unlocked.

l When the dashboard is locked, you can drill down into the monitor data by double-clicking
within the widget. For example, you can display the Memory allocated to Partition short-term
history view for the selected system and data by double-clicking on a Current Memory
monitor graph widget on your dashboard.

l When the dashboard is locked, you can run selected IBM i commands for applicable elements
from the widget. See Running IBM i commands from Monitor widgets for more information.

NOTE: To remove a widget from the dashboard, click to select it, then right-click and select
Delete.

Running IBM i Commands from Monitor Widgets
The following section discuss some basic information about which elements support running IBM i
commands from Monitor Graph dashboard widgets and describes some of the ways you can run
those commands to get a better picture of your data.

Currently, IBM i commands are available from the following elements:

Element Available Commands

Avg wait time for job queue Release Job Queue, Hold Job
Queue

Channel Status Start Channel, Ping Channel,
End Channel, Reset Channel,
Resolve Channel

Controller Status Vary On, Vary Off, Resume
Recovery, End Recovery

Device Status Vary On, Vary Off, Resume
Recovery, End Recovery, Hold
Device, Release Device

Line Status Vary On, Vary Off, Resume
Recovery, End Recovery

IP Interface Status Start TCP Interface, End TCP
Interface

Job Queue Active Jobs Release Job Queue, Hold Job
Queue
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Element Available Commands

Job Queue Status Release Job Queue, Hold Job
Queue

Listener Status Start Listener, End Listener

Max wait time for job queue Release Job Queue, Hold Job
Queue

Network Interface Status Vary On, Vary Off, Resume
Recovery, End Recovery

Number of jobs on queue Release Job Queue, Hold Job
Queue

Output Queue Files Release Output Queue, Hold
Output Queue, Clear Output
Queue

Output Queue Status Release Output Queue, Hold
Output Queue, Clear Output
Queue

Queue Manager Command
Server Status

Start Queue Manager
Command Server, End Queue
Manager Command Server

Queue Manager Status Start Queue Manager, End
Queue Manager

Server Status Vary On, Vary Off, Resume
Recovery, End Recovery

Subsystem Status Start Subsystem, End
Subsystem (Controlled), End
Subsystem (Immediate), End
Subsystem (Immediate, no
logs)

Using IBM i Commands from a Monitor Widget
You can run IBM i commands from any of the elements listed above. As an example, you can run the
Vary On and Vary Off command from a Monitor Widget that is displaying a Controller Status
element.

1. On the dashboard of your IBM i partition, create a new Monitor Graph widget that includes a
Controller Status element. See Monitor Graph Dashboard Widget for instructions.

2. Lock your dashboard and right-click the graph.
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3. Choose Vary On or Vary Off. A Signon window will open requesting that you enter your IBM i
credentials.

4. Enter your user name and password.

5. Click OK. If authorized, the command is performed and the controller is varied on (or off).

Short-Term History Graph Dashboard Widget
This widget displays short-term history for the systems you want to display on your dashboard.

A range of history is shown depending on the time frame you choose (30 minutes to nine hours), and
the graph updates in real time as it receives samples from the selected systems.

Adding a Short-Term History Graph Widget
Use the following steps to set up a short-term history graph for your dashboard:

1. On the dashboard you want to add the widget to, click the button in the upper right hand

corner to unlock for editing. Then click the button in the upper right hand corner and
select Short-Term History Graph from the Historical Elements drop-down list.
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2. Type a short name for the widget in the Description field.

3. Choose whether you want the graph to be for a Single System, a System Group, or All
Systems.

4. Add data items to the graph from the Available Items list. You can filter the list by type using
the Filter drop-down list.

NOTE: The more items you add to the graph, the longer it takes to load. We recommend
using multiple short-term history widgets on your dashboard to break up the items you
wish to view.

5. Select the Time Period of the history you want to monitor from the drop-down list. You can
choose anywhere between 30 minutes and 9 hours. The default is 30 minutes.

On the Graph Options tab:

User Guide www.helpsystems.com page: 57



Dashboards Overview / Robot Monitor DashboardWidget Descriptions

6. Enter graph titles for the Main Title (Upper), Y Axis Title, andMain Title (Lower), if other
than the default.

7. Select a Graph Type.

8. Select a level of Smoothing from the drop-down list. The smoothing controls the level of detail
in the graph. The more smoothing is selected, the gentler the curve that is drawn. You can
choose anywhere between no smoothing and high smoothing.

9. Check the boxes of the settings you would like to apply to the graph. You can choose to fill the
graph, have the graph be transparent so you can see the grid (Glass Mode), toggle the
thresholds on and off, and auto adjust the graph's scaling.

10. Choose the Color Set, which will determine the color of the graph data. The default color is
blue. You can also choose to differentiate the graph color by item or system.

11. When you are finished, click OK. The completed graph will now appear on your dashboard.
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Things You Can Do
l Click and drag the corners of the widget to change its size and shape.

If you are monitoring several items at once, you may need to make the widget bigger to see
the descriptions.

l Once the widget has been created, you can right-click it and select Properties to change its
settings any time. This only works if the dashboard is unlocked.

l When the dashboard is locked, you can drill-down into the short-term history data by double-
clicking within the widget. For example, you can display the Highest CPU Jobs view for the
selected system and data by double-clicking on a CPU Usage short-term history graph widget
on your dashboard.

NOTE: To remove a widget from the dashboard, click to select it, then right-click and select
Delete.

Detailed History Graph Dashboard Widget
This widget displays line graphs of historical data for the systems you want to display on your
dashboard.

Adding a Detailed History Graph Widget
Use the following steps to set up a detailed history graph for your dashboard:
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1. On the dashboard you want to add the widget to, click the button in the upper right hand

corner to unlock for editing. Then click the button in the upper right hand corner and
select Detailed History Graph from the Historical Elements drop-down list.

On the Item Selection tab:

2. Type a short name for the widget in the Description field.

3. Choose whether you want the graph to be for a Single System, a System Group, or All
Systems.

4. Add data items to the graph from the Available Items list. You can filter the list by type using
the Filter drop-down list.

NOTE: The more items you add to the graph, the longer the graph takes to load. We
recommend using multiple detailed history widgets on your dashboard to break up the
items you wish to view.
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On the Date/Time tab:

5. Use the calendars to select the date and time range in which detailed history data should
appear in the widget.

6. Select the relationship of the From Date and the To Date to the current date.

On the Graph Options tab:
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7. Enter graph titles for the Main Title (Upper), Y Axis Title, andMain Title (Lower), if other
than the default.

8. Select a Graph Type.

9. Select a level of Smoothing from the drop-down list. The smoothing controls the level of detail
in the graph. The more smoothing is selected, the gentler the curve that is drawn. You can
choose anywhere between no smoothing and high smoothing.

10. Check the boxes of the settings you would like to apply to the graph. You can choose to fill the
graph, have the graph be transparent so you can see the grid (Glass Mode), toggle the
thresholds on and off, and auto adjust the graph's scaling.

11. Choose the Color Set, which will determine the color of the graph data. The default color is
blue. You can also choose to differentiate the graph color by item or system.

12. When you are finished, click OK. The completed graph will now appear on your dashboard.
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Things You Can Do
l Click and drag the corners of the widget to change its size and shape.

If you are monitoring several items at once, you may need to make the widget bigger to see
the descriptions.

l Once the widget has been created, you can right-click it and select Properties to change its
settings any time. This only works if the dashboard is unlocked.

l When the dashboard is locked, double-click the widget to display the Detailed History view
for the selected system and data.

NOTE: To remove a widget from the dashboard, click to select it, then right-click and select
Delete.

History Summary Graph Dashboard Widget
This widget provides a summarized view of performance data for the systems you want to display on
your dashboard.

Adding a History Summary Graph Widget
Use the following steps to set up a history summary graph for your dashboard:

1. On the dashboard you want to add the widget to, click the button in the upper right hand

corner to unlock for editing. Then click the button in the upper right hand corner and
select History Summary Graph from the Historical Elements drop-down list.

On the Item Selection tab:
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2. Type a short name for the widget in the Description field.

3. Choose a Single System to display in the graph.

4. Add data items to the graph from the Available Items list. You can filter the list by type using
the Filter drop-down list.

NOTE: The more items you add to the graph, the longer it takes to load. We recommend
using multiple history summary widgets on your dashboard to break up the items you wish
to view.

On the Date/Time tab:
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5. Select the date you want a summarized view of performance data for, then indicate what type
of summary you want displayed in the graph.

You can choose one of the following options in the Summary Type drop-down list:

Summary
Type

Description

One Year This summary type shows your system's performance data for the
previous 12 months. Optionally, if you check Forecast, it will also
show you a forecast of your system's performance data for up to 24
months.
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Summary
Type

Description

OneMonth This summary type shows your system's performance data for the next
month. You can choose to include only certain days of the week in the
data summary.

One Month
by Hour

This is similar to the One Month summary type, only it shows your
system's performance data for the next month by hour instead of day.
You can choose to include only certain hours of the day in the data
summary, or you can have it include all hours. For example, you could
choose for monthly data to be recorded only between the hours of 9
a.m. and 5 p.m.

Month by
Element

This summary type shows your system's performance data for the next
month by element. If you have more than one element monitored in
the widget, all of them will show up on the graph.

One Day This summary type shows your system's performance data for the next
24 hours. You can choose to include only certain hours of the day in
the data summary, or you can have it include all hours. For example,
you could choose for the day's data to be recorded only between the
hours of 9 a.m. and 5 p.m.

Day by
Element

This summary type shows your system's performance data for the next
day by element. If you have more than one element monitored in the
widget, all of them will show up on the graph.

6. Select the relationship of the date you indicated to the current date.

On the Graph Options tab:
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7. Enter graph titles for the Main Title (Upper), Y Axis Title, andMain Title (Lower), if other
than the default.

8. Select a Graph Type. You can choose Values or Translated Values.

9. If you choose Translated Values, you can also choose your sort type. You can sort by severity
or values. Note: Severity is the default for the Values graph type.

10. Choose whether or not you want the graph's scaling to auto adjust.

11. When you are finished, click OK. The completed graph will now appear on your dashboard.

Things You Can Do
l Click and drag the corners of the widget to change its size and shape.

If you are monitoring several items at once, you may need to make the widget bigger to see
the descriptions.
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l Once the widget has been created, you can right-click it and select Properties to change its
settings any time. This only works if the dashboard is unlocked.

l When the dashboard is locked, double-click the widget to display the History Summary view
for the selected system and data.

NOTE: To remove a widget from the dashboard, click to select it, then right-click and select
Delete.

Disk Summary Graph Dashboard Widget
This widget displays summarized disk data for the systems you want to display on your dashboard.
Disk data is collected daily and runs according to a schedule set on the central system.

Adding a Disk Summary Graph Widget
Use the following steps to set up a disk summary graph for your dashboard:

1. On the dashboard you want to add the widget to, click the button in the upper right hand

corner to unlock for editing. Then click the button in the upper right hand corner and
select Disk Summary Graph from the Historical Elements drop-down list.

On the Item Selection tab:
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2. Type a short name for the widget in the Description field.

3. Choose a Single System to display in the graph.

4. Choose a Graph Type for the disk summary.

5. Add data items to the graph from the Item Selection list.

6. Check Automatically Select Largest if you want Robot Monitor to display the largest data
classes.

7. In the Maximum Items to Select field, specify how many items Robot Monitor should
autoselect or select a number from the spinner.

8. Type a Generic Selection in the field to select objects. This is a complex version of generics
(or wildcards). You can use generics like ABC* (to select all items beginning with ABC) or
*CDE* (to select all items that include CDE).

9. Select Ignore Case if you want the case of an element name to be ignored when searching. For
example, if selected, abC will be considered the same as Abc.

10. Choose an ASP from the drop-down list if you want to limit the data displayed to a particular
ASP. Note: This is only available for the Daily View summary type when Single Item is not
selected.

On the Date/Time tab:
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11. Select the date you want a summarized view of disk data for, then choose whether you want
daily, monthly, or yearly data in your graph.

12. Select the relationship of the date you indicated to the current date.

On the Graph Options tab:
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13. Enter graph titles for the Main Title (Upper), Y Axis Title, andMain Title (Lower), if other
than the default.

14. Select which of the general options you want included in your graph. You can choose to show
sizes, sort by size, show other, interpolate, and change the Chart Type. You can also choose
the Color Set, which will determine the color of the graph data. The default color is blue.

15. When you are finished, click OK. The completed graph will now appear on your dashboard.

Things You Can Do
l Click and drag the corners of the widget to change its size and shape.

If you are monitoring several items at once, you may need to make the widget bigger to see
the descriptions.

l Once the widget has been created, you can right-click it and select Properties to change its
settings any time. This only works if the dashboard is unlocked.
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l When the dashboard is locked, double-click the widget to display the Disk Summary view for
the selected system and data.

NOTE: To remove a widget from the dashboard, click to select it, then right-click and select
Delete.

Accounting Summary Graph Dashboard Widget
This widget displays data collected from the host's job accounting system.

Data is collected from remote systems during the disk data collection when job accounting is enabled
and the collection function is selected on the central system. For more information, see the
Accounting Summary view.

Adding an Accounting Summary Graph Widget
Use the following steps to set up an accounting summary graph for your dashboard:

1. On the dashboard you want to add the widget to, click the button in the upper right hand

corner to unlock for editing. Then click the button in the upper right hand corner and
Historical Elements from the resulting list, and select Accounting Summary Graph from the
drop-down list.

On the Item Selection tab:
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2. Type a short name for the widget in the Description field.

3. Choose a Single System to display in the graph.

4. Choose a Graph Type for the disk summary.

5. Choose aMetric for the disk summary.

6. Add data items to the graph from the Item Selection list.

On the Date/Time tab:
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7. Select the date you want a summarized view of accounting data for, then choose whether you
want daily or monthly data in your graph.

8. Select the relationship of the date you indicated to the current date.

On the Graph Options tab:
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9. Enter graph titles for the Main Title (Upper), Y Axis Title, andMain Title (Lower), if other
than the default.

10. Select which of the general options you want included in your graph. You can choose to show
sizes, sort by size, show other, and change the Chart Type. You can also choose the Color Set,
which will determine the color of the graph data. The default color is blue.

11. When you are finished, click OK. The completed graph will now appear on your dashboard.

Things You Can Do
l Click and drag the corners of the widget to change its size and shape.

If you are monitoring several items at once, you may need to make the widget bigger to see
the descriptions.

l Once the widget has been created, you can right-click it and select Properties to change its
settings any time. This only works if the dashboard is unlocked.
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l When the dashboard is locked, double-click the widget to display the Accounting Summary
view for the selected system and data.

NOTE: To remove a widget from the dashboard, click to select it, then right-click and select
Delete.

Key Statistic Dashboard Widget
This widget displays data definitions or built-in elements on your dashboard. You can add an element
for a single system, system group, or all systems.

Adding a Key Statistic Widget
Use the following steps to set up a key statistic widget for your dashboard:

1. On the dashboard you want to add the widget to, click the button in the upper right hand

corner to unlock for editing. Then click the button in the upper right hand corner and
select Key Statistic from the Live Elements drop-down list.
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2. Choose a Single System or System Group that you want to monitor a specific element for. If
you want to monitor the element across all systems, select All Systems.

3. Select one or more elements from the Available Items list, then click Add to move them to the
Selected Items list. These are the elements the widget will monitor.

4. If you have chosen more than one element, you can deselect the Show Summary of Elements
checkbox to view the key statistics for all of your selected elements. Otherwise, keep Show
Summary of Elements checked to view the single element within your selections that satisfies
the chosen Value Calculation for Summary (see below).

5. Choose a Label Template and Value Template from the drop-downs. These templates
determine how text is displayed for each data definition or built-in element selected. Label
templates are used to change the description formatting and include the value and threshold
translation for elements.
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Label and Value Templates
Label and value templates are entered as template strings. The following variables can be used
in any order:

Variable Value

&d Short description of element or group

&t Short description from threshold

&v Value

&p All parameters from the data collection definition

&s Short system name

6. Choose a Value Calculation for Summary. You can display the maximum severity, maximum or
minimum value, sum, or average.

For example, if monitoring CPU Usage, the sum would show the total CPU usage across a
single system, system group, or all systems, depending on your choices.

7. When you are finished, click OK. The key statistic widget will now appear on your dashboard.

Things You Can Do
l Click and drag the corners of the widget to change its size and shape.

If you are monitoring an element with a long name, you may need to make the widget bigger
to see the full description.

NOTE:When using multiple item selection, ignore the Label Template and only use the
Value Template to display the partition, element description and value information.

l Once the widget has been created, you can right-click it and select Properties to change its
settings any time.

l When the dashboard is locked, you can drill down into the key statistic data by double-clicking
within the widget. For example, you can display the Auxiliary Storage short-term history view
for the selected system and data by double-clicking on a Auxiliary Storage key statistic widget
on your dashboard

NOTE: To remove a widget from the dashboard, click to select it, then right-click and select
Delete.

Show Dashboards List
The Show Dashboards List gives you an overall view of the dashboards you have set up in Robot
Monitor.
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From this screen, you can add a dashboard or double-click an existing dashboard on the list to access
it directly. Depending on how many dashboards you have set up in Robot Monitor, you can use the
Search bar to find a specific dashboard.

You can also right-click a dashboard in the list to open a context menu that will allow you to Open,
see Properties, Add, or Delete the dashboard.

The Home icon indicates the current default dashboard. You can change the default dashboard when
adding or customizing a dashboard.
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Systems, Groups
These topics describe general information about system and group views in Robot Monitor.

Click one of the following links to learn more about the topic.

l About Elements

l About Groups

l About System Views

l The Item Selection Sidebar

l The Views

l Using the Auto Export Panel

System Views
For each system you configure in Robot Monitor, a view is created. This view contains ten other
views made up of graphs, line charts, and detailed information you can use to see the available
functions on your system and track system data.

A system view can contain a single system, a group of systems, or all systems.

Single system views are set up when you configure the system in Robot Monitor.

System groups, on the other hand, are set up in two different ways. Some are predefined; others are
created manually.

Predefined system groups: Predefined system groups are created by Robot Monitor during start-up.
They are created when Robot Monitor sees more than one partition from the same physical system
and groups them in the physical box. These group names always begin with PH_ followed by the
system serial number. The name and systems included in these groups cannot be changed, but they
can be copied or deleted (if deleted, however, it may reappear the next time you start Robot
Monitor).

Manually created groups: See Creating and Maintaining System Groups for more information.

Show Systems and Groups
Select Show Systems and Groups from the Views Menu to display the System and Groups screen.
This lists all the systems, and system groups, you have connected to Robot Monitor. Double-click a
system in the list to go to the Monitor view for that system or group.

If you have several systems connected to Robot Monitor, you can search for a specific system by
using the Search bar. Or, you can view data for all systems.

You can also create or maintain system groups from the Show Systems Lists window. See Creating or
Maintaining System Groups for more information.
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All Systems
The All Systems view displays selected data definitions for every system configured in Robot
Monitor. You can review the data for all systems in two different ways: from the Monitor view or the
Short-Term History view. To switch views, choose one from the drop-down list.

To add a new data definition to a view for all systems, see the Item Selection sidebar.

Creating or Maintaining System Groups
You can have system groups in Robot Monitor, but they need to be created manually.

Once created, you can maintain them via the Show Systems and Groups window.

Creating a System Group
Follow these steps to create a system group.

1. Click the File menu, then select Security and Log In.

2. When prompted, enter your User Name and Password, then click OK.

3. Click Show Systems and Groups in the Views sidebar.

4. Click the Maintain System Groups icon in the top right corner.

5. On the System Groups panel, click Create New Group.

6. Enter a Group Name for the system group, then click OK.

7. Add a Description to the system group.

8. Select which systems you want to add to the group.

9. When you are finished, click OK.

You can view your new system group by double-clicking it. Only the Monitor view, Detailed History
view, and the Short-Term History view are available for system groups.

Copying a System Group
Follow these steps to copy a system group.

1. Click the File menu, then select Security and Log In.

2. When prompted, enter your User Name and Password, then click OK.

3. Click Show Systems and Groups in the Views sidebar.

4. Click the Maintain System Groups icon in the top right corner.

5. Right-click an existing system group and select Copy.

6. Enter a new Group Name and click OK.

The copied system group will appear in the list. From there, you can edit the system group using the
directions below.
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Editing a System Group
NOTE:You must log on with a user profile that has SECOFR authorities before you can edit a
system group. To do this, click the File menu, then select Security and Log In.

To edit a system group, click the Maintain System Groups icon in the top right corner.

Then, choose a system group from the list. You can change the group description, add systems to a
group, and remove systems from a group.

Deleting a System Group
NOTE:You must log on with a user profile that has SECOFR authorities before you can delete a
system group. To do this, click the File menu, then select Security and Log In.

To delete a system group, right-click a system group and select Delete, then click OK to proceed.
The system group will be removed from the list.

About Groups
The following sections discuss some basic information on groups and what they can have, contain, or
do.

Currently, only the following views can have groups. See these sections for additional information on
the views themselves:

l The Monitor View

l The Short-Term History View

Groups combine elements and groups

When Robot Monitor is fully configured, it is not unusual to have hundreds of elements defined. This
can make it difficult to organize and summarize the information that is collected and reported by
Robot Monitor. In order to address this problem, Robot Monitor supports the use of groups.

A group brings together a number of related elements and presents a summary of the part of the
system represented by that group. A group can be configured to present its values as bars or as text
items.

Bar Groups show numeric values as a bar graph.

Text items show translated values. The source value can be an element with discrete values such as
controller status, or it can be a numeric value such as disk space used (which is typically translated
into a summary using a threshold list). Text items can also present numeric items as numbers.

Groups can contain groups

Groups can contain other groups, creating a hierarchical structure for the elements being monitored.
For instance, you might create a group of communications monitors. This group could then contain
groups for line descriptions, controllers, throughput, and so on.
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There is no limit to the number of elements in a group, nor is there a limit to the depth of the
hierarchy created.

Groups can have values

There are various ways a group can summarize its members. Each of these ends up assigning a value
to a group. If a group has a value, it will behave in the same way as an element and can have various
attributes assigned to it.

The default value for a group is the item with the maximum severity. This means that at each level in
the hierarchy, Robot Monitor selects the element with the threshold that says it has the most serious
problem and assigns this value to the group.

Groups can also take the sum, average, maximum, or minimum value from its members. You can
exclude members from these calculations if required.

Groups can have thresholds

A group with a calculated value (sum, average, maximum or minimum) can have a threshold assigned
to it, as with a simple element.

Groups can be automatically updated

If you want a group to contain all elements of a particular type, you can add a selector to the group.
A selector is an element that causes all elements of a particular type to be shown in the group, even
if they are created by other users. Elements are added to or removed from the group as they are
created and deleted by you or other users.

Group Terminology
The following terms are commonly used to describe groups in Robot Monitor.

Group

A text group or bar group, depending on how the elements are displayed.

Child Group

A group or element within another group.

Parent Group

A group containing an element or group.

Ancestors

The collective of parent, grandparent, and great-grandparent groups.

Root

A top-level group.

Creating Groups
You can create groups in the Monitor view and the Short-Term History view.

Follow these steps to create a new group for your view.
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1. Open the view you want to create a new group for.

2. Right-click the group in which the new group is to be created, then select Group and Create
New Group.

3. On the Create New Group panel, select a Group Type. You can choose bar group or text
group.

4. Enter a Group Name and Short Description.

5. Select Create in System Only if you want to create this group for your current system only.
Otherwise, the default is Create for All Systems. You can check any or all of the Native, Aix,
Linux, Vios, and System Groups checkboxes to include this group just within those selected
systems.

6. Choose where you want the new group to be created. You can select an existing group to
make it a subgroup, or you can select Root to make it a parent group.

7. Click OK. The new group will be automatically added to the view.

Once you have created a new group, you can right-click it and select Properties for Group X in the
Group drop-down to add items and thresholds to monitor.

Create New Group Panel
You can use the Create New Group panel to add a new group to your current view. To get there,
open the Monitor view or the Short-Term History view, then open the right-click menu and select
Create New Group under the Group drop-down.

For more information on how to use the panel, see Creating Groups.
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Group Types
The following is a little more information on the different group types:

Text Groups are typically used for items with discrete values, such as Subsystem Status. Each item is
displayed as a rectangle containing a textual representation of the value and threshold. The
background color is taken from the threshold record.

Bar Groups are typically used for numeric values, where the value is the important aspect of the
data. Values are shown as a bar graph, and their color is taken from the current threshold record.

Editing Groups
You can edit groups in the Monitor view and the Short-Term History view.

Follow these steps to edit an existing group:

1. Open the view that contains the group you want to edit.

2. Right-click the group and select Properties for Group X in the Group drop-down.

This displays the Group Properties panel. See the aforementioned topic for more information on
what you can change in the group.

Deleting Groups
You can delete a group from your current view in Robot Monitor. To do this, right-click any group
and select Delete a Group.

This displays the Delete Group for System X panel.
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Select the group you want to delete and click OK. If the group was inherited from the default view,
you will be asked whether you want to delete it from the system or just the default view.

Group Properties Panel
The Group Properties panel displays when you right-click a group and select Group Properties for X
from the Group drop-down. Note: X being the name of the group you want to open.
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There are several tabs in this panel that can be used to change the group properties. Click any entry
to display the settings for that tab.

The following table describes the tabs you may see in the Group Properties panel, depending on the
view and type of group currently selected.

Tab Description

Description
for All Groups

Displays the View Options screen, allowing you to set the default options
for this group. Changes here will affect all views inheriting this groups
definition from the default view.

Description
for this System

Displays the View Options screen, allowing you to set options that affect
only the currently selected system. Changes here will override options set
in the default view.

Default
Presentation

Displays the Presentation in this Group screen, allowing you to set
options determining how this group is displayed for all systems. Changes
here will affect all views inheriting this groups definition from the default
view.

Presentation
for this System

Displays the Presentation in this Group screen, allowing you to set
options determining how this group is displayed for the currently selected
system. Changes here will override settings made in the default view.

Item Selection
for All Systems

Displays the Item Select screen, allowing you to select elements and
groups and create new elements to be added to this group. Changes made
here will affect all views inheriting groups from the default view.

Additional
Items for this
System

Displays the Item Select screen, allowing you to select elements and
groups and create new elements to be added to this group. Changes made
here will only affect the currently selected view. Items added will become
part of this group in addition to those inherited from the default view.

Default
Threshold

Displays the Threshold screen, allowing you to select, replace, or edit the
threshold attached to this group. Changes on this panel affect all this
group on all systems.

System
Threshold

Displays the Threshold screen, allowing you to select, replace, or edit the
threshold attached to this group. Changes on this panel affect only the
selected system, overriding any threshold selected at the default level.

View Options Screen
This screen, located in the Group Properties panel, allows you to change the settings for the group's
description and label template. You can access this screen for all systems under Description for All
Groups, or for your current system under Description for This System.
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Fields and Descriptions
The following lists the fields in this screen and their descriptions.

Description, Short Description

Enter a description for the group. The short description is typically used as a label in the groups, and
the long description is used when selecting items from lists.

Only display elements with severity >=

Enter a severity filter if required. When a filter is specified, the group only displays items whose
threshold has assigned them a severity equal to or greater than this value.

The drop down list can be used as a shortcut to entering common values.

View Type

Choose how you want your group to be presented. Text groups are used for items with discrete
values, and items are displayed as rectangles containing textual representation of the value and
threshold. Bar groups are used for numeric values and are displayed as bars.

Label Template

This field determines how text is displayed for the elements in the group. Label templates are often
used in text groups to change the description and include the value and threshold translation for
elements.

If the label template field is left blank, it inherits a template from the closest ancestor that has one
specified. If no template is found, a bar group will use the default value of &d for a single system
view or &s for a multiple system view. A text view will use &d &t for a single system view or &s &d
for a multiple system view.

See the section on Label Templates below for a list of variables you can use or click Variables to
display the descriptions in the GUI.
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Label Templates
Label templates are entered as template strings. The variables that can be used are as follows:

Variable Value

&d Short description of element or group

&D Long description of element or group

&t Short description from threshold

&T Long description from threshold

&u Unit Description

&U Long Unit Description

&v Value

&S System name

&s Short system name

&1...&99 Parameters 1-99 from the data collection definition

&p All parameters from the data collection definition

&y Type of check, abbreviated (built in, output queue status, and so on)

&Y Type of check, full

Rows, Columns (Text groups only)

You can specify a number of rows or a number of columns to be used when arranging elements for
display.

Presentation in this Group Screen
This screen, located in the Group Properties panel, allows you to specify how elements should be
displayed within the group. You can access this screen for all systems under Default Presentation, or
for your current system under Presentation for This System.
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Fields and Descriptions
The following lists the fields in this screen and their descriptions.

Decimals

Type the number of decimals that should be used when displaying a numeric value, or choose an
option from the drop-down.

If the value Automatic is selected, Robot Monitor will make a decision for you based on the
magnitude of the number shown.

Scaling

Enter the maximum value that should be allowed when scaling this group as a numeric value.

Automatically Adjust: Select this option to increase the maximum scaling value when the
group value exceeds the current scale value.

Default: Select this option to share the scale value between all instances of this group.

Force Numeric

Select this option to always display a numeric value as part of the label. This is different from the
usual behavior in text groups, where the translated value is generally displayed.

Include Value

Select this option to have the item contribute to its parent value. Otherwise, the item value will be
ignored in any sum, average, minimum, maximum, or maximum severity calculations.
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Presentation (Text groups only)

Choose the presentation for your text group. This only applies to numeric values.

Block: This is the default value. When chosen, the item is displayed as a single area of color
with a label determined by the selected label template.

Bar:When chosen, items are displayed with a horizontal bar behind the text, showing the
magnitude of the current value.

Histogram:When chosen, items are displayed with a histogram behind the text, showing the
current value and a certain amount of history.

Line:When chosen, items are displayed with a line graph behind the text, showing the current
value and a certain amount of history.

Value Calculation

Choose an option to determine how the value for the group should be calculated.

Label Template

This field determines how text is displayed for the elements in the group. Label templates are often
used in text groups to change the description and include the value and threshold translation for
elements.

If the label template field is left blank, it inherits a template from the closest ancestor that has one
specified. If no template is found, a bar group will use the default value of &d for a single system
view or &s for a multiple system view. A text view will use &d &t for a single system view or &s &d
for a multiple system view.

See the section on Label Templates below for a list of variables you can use or click Variables to
display the descriptions in the GUI.

Label Templates

Label templates are entered as template strings. The variables that can be used are as follows:

Variable Value

&d Short description of element or group

&D Long description of element or group

&t Short description from threshold

&T Long description from threshold

&u Unit Description

&U Long Unit Description

&v Value

&S System name

&s Short system name
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Variable Value

&1...&99 Parameters 1-99 from the data collection definition

&p All parameters from the data collection definition

&y Type of check, abbreviated (built in, output queue status, and so on)

&Y Type of check, full

Item Select Screen
This screen, located in the Group Properties panel, allows you to select which elements and groups
should be children of this group. You can access this screen for all systems under Item Selection for All
Systems, or for your current system under Additional Items for This System.

Things You Can Do
You can take the following actions on this screen:

Select items

You can select one or more items to monitor from the available list. To select multiple items, use
Shift (to select many at once) or Ctrl (to select one at a time).

When you have the items you want to add, click Add to move them to the Selected Items list.

If there are items already in the Selected Items list, new items will be added to the bottom of the list.

Change item order

You can change the order of selected items.
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Select one or more items from the Selected Items list, then click Move Up orMove Down to move
them.

Remove items

If you do not want a certain item to be monitored, you can remove it from the list.

Select one or more items from the Selected Items list, then click Remove. The items will be removed
from the group and returned to the Available items list.

Fields and Descriptions
The following lists the fields in this screen and their descriptions.

Available items

The Available panel lists all groups and elements that can be added to the group. Items that have
already been added to the group will not appear in this list.

Selected Items

The Selected Items panel shows all items currently selected as part of this group. On the graph, they
are displayed in the order shown here. However, if a group takes items from the default view and
the system view, items from the default view are displayed first and items specific to the system are
displayed second.

Right-click one or more items to display a menu with the following options:

Option Description

Properties Displays the Data Definition panel for the selected item.

Copy Creates a copy of the selected item, from which you can create a new item.
Choosing this option will display the Data Definition panel.

Include in
Value

Tells Robot Monitor to include this item when calculating the value of a
group.

Exclude
from Value

Tells Robot Monitor to ignore this item when calculating the value of a
group.

Print Allows you to open and print a file on your PC.

Filter

Use the filter drop-down list to quickly find the item you want to monitor. You can filter by type,
such as ASP Status and CPU Usage.

Selector

You can create a new selector. A selector is used to automatically add all elements of a selected type
to a group.

Click Selector to open the Data Definition panel and define a new selector.

Add

You can add a new element to the Available list.
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Click Add to open the Data Definition panel and define the element, which will then be added to the
group.

Adding Selectors
You can add a select to a group to cause it to contain all data elements of a desired type.

Follow these steps to add a new selector to a group.

1. Right-click a group and select Properties for X Group under the Group drop-down.

NOTE: X being the name of the specific group.

2. Click Item Selection for All Systems or Additional Items for this System to open the Item
Select screen.

3. Click Selector to open the Data Definition panel.

4. On the Data Definition panel, you have a couple options:

l If the view is a multiple system view, choose the system or system group that elements
should be added to. You can also choose all systems.

l If the view is a single system view, the only valid option is Default from View, which
takes the system selection from the view.

5. Select a monitor type from the drop-down. The group will contain all of that type for the
entire system.

NOTE: Selectors update dynamically. If you or someone else create a new element with the
monitor type you chose, it will be immediately added to the group with this selector.

6. When you are finished, click OK to create the selector and add it to the Selected Items list.
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NOTE:A group can contain more than one selector. You might, for instance, choose to have all
controller and device status monitors in a group. To do this, add two selectors to the group: one
for controller status and one for device status.

Threshold Screen
This screen, located in the Group Properties panel, allows you to add thresholds to your elements
and groups. You can access this screen for all systems under Default Threshold, or for your current
system under System Threshold.

About Elements
The following sections discuss some basic information on elements and what they can do.

Currently, only the following views can have elements. See these sections for additional information
on the views themselves:

l The Monitor View

l The Short-Term History View

An element is a single item being monitored. There are three different types of elements:

l Built-in elements, such as CPU usage and response time, reflect the performance of the
partition as a whole.

l User defined elements display data provided by the user.

l Built-in user defined elementsmonitor a single object or class of objects. You can create these
as needed. There are some built-in user defined elements that always monitor the whole
system and others that monitor the whole system only if they are configured to do so.
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An element always has a single value. For some element types, this value is derived from multiple
underlying items. These can be displayed by right-clicking an element and selecting Show Details.

If the current value for an element or group is blank, it is shown as (b). If there is no value present, it
is shown as NA.

Creating an Element
Use these steps to create a single item (built-in element, user-defined element, or configurable
element) to monitor in a group.

How to Get There

There are three ways to reach the Data Definition panel and create an element:

In the Item Selection sidebar on the Monitor view, click Monitor something new.

OR

In the Data Definitions view, click Monitor something new.

OR

From the Monitor view:

1. Right-click the group you want the new element to be a child of.

2. Select Properties for X Group under the Group drop-down, where X is the name of the
specific group.
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3. On the Group Properties panel, open the Item Selection for All Systems tab if the element
should be defined for multiple systems or the Additional Items for this System tab if the
element should be defined for a single system.

4. On the Item Select screen, click Add to display the Data Definition panel.

Creating an Element

Follow these steps on the Data Collection screen to create a new element:

1. Select aMonitor Type from the drop-down list to display which parameters are available. You
can use the Filter list to narrow down your monitor types by class.

2. Select which systems you want to add the parameters to. If you want them added to all
systems in Robot Monitor, click All Systems.

3. Choose which system should be used for prompting values from the Prompt drop-down. When
you prompt for values that exist on the host system, Robot Monitor will fetch the list from the
prompt system specified.

4. Right-click the parameters and select a value from the object list. You can also press the Insert
key to enter a value manually.

For some parameters, you can choose to define multiple elements. See Creating Multiple
Elements for more information.

NOTE:Certain parameters may require a value before you can continue.

5. Click OK.

Robot Monitor will make sure the definition does not already exist. If it does not, it will create the
element on the IBM i and add it to either the Item Selection sidebar (if you accessed the Data
Collection screen by clicking "Monitor something new") or to the Selected Items list for the group (if
you accessed the Data Collection screen through a group).

The element you defined is available on all PCs immediately after you create it, but it is only added
to the group (if applicable) on your local machine. The only exception to this is if there are groups
defined with threshold selectors for the selected data type. The new element will be added to those
groups immediately.

Each new element is given a description and the default threshold for its type. These attributes may
be overridden by either right-clicking the element in the Item Selection sidebar and choosing
Properties (if you accessed the Data Collection screen by clicking "Monitor something new") or by
right-clicking the element in the Selected Items list and choosing Properties (if you accessed the Data
Collection screen through a group).

Creating Multiple Elements
You can also create a set of elements of the same type in Robot Monitor.

To create multiple elements:

1. Right-click the group that you want the new element to be a child of.

2. Select Properties for X Group under the Group drop-down, where X is the name of the
specific group.
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3. On the Group Properties panel, open the Item Selection for All Systems tab if the element
should be defined for multiple systems or the Additional Items for this System tab if the
element should be defined for a single system.

4. On the Item Select screen, click Add to display the Data Definition panel.

5. Open the Data Collection tab.

6. Select aMonitor Type from the drop-down list to display which parameters are available. You
can use the Filter list to narrow down your monitor types.

7. Select which systems you want to add the parameters to. If you want them added to all
systems in Robot Monitor, select All Systems.

8. Select which system should be used for prompting values from the Prompt drop-down. When
you prompt for values that exist on the host system, Robot Monitor will fetch the list from the
prompt system specified.

9. Right-click the parameter you want to vary across a series of new element definitions and
selectMultiple.

On the Multiple Values for Parameter panel, select the objects you want to create elements
for. Use the Search bar to find an object quickly.

10. Click OK. Robot Monitor will check that all selected objects exist for all selected systems. If
objects are missing from some systems, Robot Monitor will change the system selection list to
exclude those systems.

11. Click OK again to close the Group Properties panel.

Multiple Values for Parameter Panel
The Multiple Values for Parameter panel allows you to define multiple elements in a single
operation. You can display this panel by right-clicking a parameter on the Data Collection screen and
selectingMultiple from the drop-down.
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On this panel, the list shows all valid selections taken from the prompt system. One element is
created for each selected object.

Fields and Descriptions
The following lists the fields in this screen and their descriptions.

Object

Select the objects you want to create elements for. You can right-click the list and choose to select
all objects, clear all objects, or invert the current selection.

Attribute

Use the Attribute drop-down to filter the list by a single object attribute. Any selections made are
kept even if they are not displayed, so when an attribute is selected, not all selected items may be
visible.

Search

To find a specific object or group of objects, use the Search field to filter by object, attribute, and
text.

Repeat Last

Use Repeat Last when you want to use a series of different element types for the same list of
objects. Create the first set of multiple elements as normal. When you create subsequent entries,
click Repeat Last to repeat the selections you made for the first set.
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Adding and Deleting Elements
You can add an existing element to a group or delete an element.

NOTE:You must be logged on with a user profile that has special authorities in order to add or
delete elements.

Adding Elements to a Group
An element can be added to more than one group.

To add an element to a group, right-click the group and select Properties for X Group under the
Group drop-down, where X is the specific name of the group.

On the Group Properties panel, click the Item Select tab and find the element you want from the list
of available items. Double-click it to add it to the Selected Items list.

Deleting Elements
You can also delete elements from a group. There are two ways to do this.

Permanently delete elements

Do the following to delete elements directly from the Data Definitions view.

1. Open the Data Definitions view under Configuration in the Views Menu.

2. Select the elements you want to remove, then right-click and select Delete.

3. When prompted, click OK to confirm the deletion.

NOTE:Detailed and historical data will be marked for removal from the database during the
next purge (MONPURGE).

Disable elements

Do the following to disable elements in the group but keep them for later use.

1. Right-click the group you want to remove an element from and select Properties for X Group
under the Group drop-down, where X is the specific name of the group.

2. On the Group Properties panel, click the Item Select tab and find the element you want from
the list of Selected Items.

3. Right-click it and select Properties, then click the Data Collection tab.
4. Clear the boxes to disable the element for all systems.

5. Click OK.

Disabling the element stops Robot Monitor from collecting data, but the historical data will still be
available and the element can be reactivated if needed.
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Working with Elements
You can see a list of all defined elements by choosing Data Definitions under Configuration in the
Views Menu. From the Data Definitions view, you can edit element definitions, filter definitions by
type and description, and find out which groups elements are being used in.

For more information about working with elements, see the topic on the Data Definition view.

Show Details
The following sections discuss some basic information about which elements support the Show
Details functionality and some of the ways you can use Show Details to get a better picture of your
data.

Currently, Show Details is available in the following elements:

List of Elements
l Active Batch Jobs

l Active Interactive Jobs

l Batch Job Count

l Cache Battery Life

l CFInt Overhead

l Check Job CPU and Hinder

l CPU Seconds per Transaction

l CPU Usage

l Database CPU Usage

l Disk I/O

l Error Report Count

l Faults per Second

l File Count

l File Size

l Interactive CPU Usage

l Interactive Job Count

l Job Count

l Job Status

l Largest Library

l Largest Object

l Lock Wait Time

l Maximum Job Run Time

l Maximum Process Run Time

l Microcode Overhead

l Process Count

l Process I/O Rate
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l Process Thread Count Total

l Process Total CPU Usage

l Process Virtual Memory

l QTemp Count

l QTemp Size

l Response Time

l System Overhead

l Temporary Storage per Job

l Temporary Storage Total

l Thread Count per Job

l Thread Count per Process

l Thread Count Total

l Total Job CPU

l Total Process CPU

Using Show Details to Export Data
You can use the Show Details feature on an element to export a listing of underlying data in either a
CSV or text format. For example, you can export a list using the File Count element.

1. Add one of the elements listed above to either the Monitor view or the Short-Term History
view using the Item Selection sidebar.

2. Right-click the element and choose Show Details. A detail panel opens within the view.

3. Right-click the detail data within the view to see the export menu.

4. Select either Export to CSV or Export to Text.

5. Select a location to save the file. Click Save.
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Using Show Details for Error Logging
If you are monitoring data on a, AIX, Linux or VIOS partition, you can use the Show Details feature
on the Error Report Count element to list and gather details of underlying errors.

1. Within a, AIX, Linux, or VIOS partition, add the Error Report Count element to either the
Monitor view, Short-Term History view, or a user-defined group (see Creating Groups for
more information) added to one of those views using the Item Selection sidebar.

2. Right-click the element and choose Show Details. An error detail panel opens within the view.

3. Right-click the detail data within the view to see the menu.

4. Select either Export to CSV or Export to Text OR select Details to bring up an Error Log
Details window that displays specific information related to the error.

Element Groups
One of the principle functions of views is to record the presentation of elements.

Elements are normally collected into groups, and groups can also be collected into groups. A group is
a collection of items displayed in Robot Monitor as a set.

Every group has a value and in many instances can be used in the same way as an element. The
value of a group is usually the item with the greatest severity from the group; however, it can be the
sum, average, maximum, or minimum value from the items in the group.

Groups allow you to organize elements into a logical framework. They create a simple, uncluttered
display that summarizes hundreds of individual items in your network.
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Element Groups on Multiple Systems
When you create a group, you are given the option to create it on your current system or on all
systems. A group that exists for all systems is defined for all single system views. This allows you to
keep the same structure for all systems, making it simple to find your way around the groups.

When adding items to a group that exists in the default view, you can add them to your current
system or to all systems.

EXAMPLE: Example #1
Suppose you are setting up monitors for subsystems on a network of two systems, Artemis and
Apollo. Artemis processes order entry and stock control while Apollo does accounting and
payroll. Each has special subsystems for critical online work, and we want to monitor these as
well as the basic supplied subsystems. The elements to perform the monitoring have already
been created.
We create a group in the default view called Subsystems. On the Item Select tab in the
Subsystems Group Properties panel, we add elements for subsystems QBATCH, QINTER, and
QCTL.
In the view for Artemis, we find this group and add the elements for ORDERS and STOCK. In
the view for Apollo, we add the monitors for BACKOFFICE and PAYROLL.
The result is a group in Artemis, showing the status of QBATCH, QINTER, QCTL, ORDERS, and
STOCK, and a group in Apollo, showing the status of QBATCH, QINTER, QCTL, BACKOFFICE,
and PAYROLL.

EXAMPLE: Example #2
You can also add monitors to the default view that cover a subset of systems, rather than adding
them to each system individually.
Suppose we have a network of four systems: Artemis, Apollo, Herakles, and Hermes. Herakles
and Hermes are similar systems, running data mining applications for different parts of the
company. They each have a subsystem called MINER, which we want to monitor.
We create a subsystem monitor for MINER and select systems Herakles and Hermes for the
element definition. Then, we then add this monitor to the defaults group. Because the element
definition specifies only these two systems, the monitor will only appear in the SUBSYSTEMS
groups on these two systems.

About Robot Monitor Views
There are eleven views in the Robot Monitor GUI that you can use to see the available functions on
your host system and track system data. At a glance, you can check CPU usage and auxiliary storage
percentages for a system, drill down to view short-term history for specific data, view a list of high
CPU users, and more.
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NOTE: There is a difference in the views available to you if you have a single system selected or a
system group. Certain views are system specific (Disk Summary, History Summary, Accounting
Summary, Highest CPU Jobs, System Data and ASP Information views) and cannot be used when
a system group is selected. So, when a system group is selected in the Systems, Groups area of
the Views panel, the data is not stored in a manner that allows the system specific views to be
displayed and therefore only the Monitor, Detailed History and Short-Term History views are
available.

Click any of the following links to view more information about these views.

l The Monitor View

l The Short-Term History View

l The Detailed History View

l The History Summary View

l The Disk Summary View*

l The Accounting Summary View*

l The System Data View

l The ASP Information View*

l The Storage Information View**

l The Box View*

l The Highest CPU Jobs View

NOTE:
* These views are only available on IBM i systems.
** These views are only available on AIX, Linux, and VIOS systems.

The Monitor View
The Monitor view is where most of the current data for the selected system is displayed. This view
brings together all the groups and elements on your system and displays information, including
current thresholds, in real time.

Monitor View Options
The following sections contain general information about the settings you can use to customize your
Monitor view.

The Data View Options Ribbon

Actions you can take:
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l Select Copy to copy the view to the clipboard to be pasted to a dashboard.

l Select Overlay High CPU to add a marker to the CPU bar. This marker shows the amount of
CPU being used by the highest CPU user on the system.

l Select Display Icon to display the status icon for the current system. The icon changes
depending on the system status and thresholds.

l Select Icon Right to move the status icon to the upper right-hand corner of the window (the
icon defaults to the left).

l Select Staggered Labels if you want the labels beneath the graph bars to display on alternate
lines. This is particularly useful for long labels.

l Select Fill Back of Frame to change the background of the frame to a slightly darker color.

l Select Never Stack if you want the graph bars to always display in a single line.

l Select Always Stack if you want the graph bars to always appear stacked (half on the bottom
row, half on the top).

l Select Stack if Portrait if you only want the graph bars to appear stacked when the window
length is adjusted to a portrait, rather than landscape, view.

Minimizing and Restoring the Data View Options
Ribbon
Use the following steps to minimize and restore the ribbon.

1. Click in the upper-left corner to open the Customize Quick Access Toolbar.

2. From the drop-down, selectMinimize the Ribbon to hide the ribbon. Select it again to show
the ribbon.

NOTE:You can also double-click the View Options tab to minimize and restore the ribbon
quickly.

If you want to use the ribbon when it is minimized, you can open it by clicking the View Options tab.
When you are done, click anywhere in the Monitor view to hide the ribbon again.

System Views Bar

The System Views bar allows you to jump from view to view for the selected system (in this case,
WAN) using the drop-down views list.

Actions you can take:

l Click Item Selection to open the Item Selection sidebar.

l Click New Window to open the Monitor view in a separate GUI window.
l Click the Monitor view, then select a new view from the drop-down list to visit that window.

Printing View Details
Use the following steps to print detailed related to the Monitor view.
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1. Click File in the upper left corner, then select Print from the File menu.

2. Select a printer from the list of printers configured on your PC.

3. Select any Settings you want to apply to the printed pages.

4. Enter how many copies you want made in the Copies field, then click Print.

The CPU Percentages Bar

An informational bar displays at the bottom of the view window. It shows data about the job that
used the most CPU during the last sample capture.

For more information about the highest CPU jobs for the selected system, double-click the CPU
percentages bar to view the Highest CPU Jobs view.

The Summary Icon
The summary icon is selected by the monitor to show the current status of each system. This is
normally displayed in the top left corner of the main bar group, but it can be moved using the
Monitor view options.

The summary icon changes depending on the system status and is associated with the threshold
record with the greatest severity. For example, if the CPU usage for a job is higher than the allotted
threshold, the icon changes and alerts you of this severity.

At certain times, it is possible that there are multiple severities for the selected system. To view the
system status, right-click the summary icon and selectWhat's This?. This displays a text-based
summary of all problems currently known for the Monitor view.

The Right-Click Menu
When you right-click the Monitor View, a context menu displays. This menu provides a list of options
you can select or configure for the current view.

NOTE: If you have more than one group open in the Monitor view, right-click the specific group
you want to see options for.

NOTE: The options available in the list may change depending on where you click in the window.
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What's This?
SelectingWhat's this? from the right-click menu gives you helpful information about the selected
item. Depending on the item type, the information could be help text or extended status information.

For example, selecting What's this? for Auxiliary Storage could give you the following dialog:

Change Properties
Selecting Change X Properties opens the Data Definition panel. From here, you can change the data
description, scaling level, authority list, and more.

NOTE: x being the name of the data you selected to change properties for.

Group
Selecting Group from the right-click menu gives you a list of things you can do with groups, such as
create a new group, print the current group, or open another group.
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Actions you can take:

l Click Properties for "xyz" to open the Group Properties panel. Note: xyz being the name of
the current group open in your monitor view.

l Click Open any Group to change the current group displayed on the screen. If you choose a
text group and the current group is a bar group, the text group with display below the bar
group instead of replacing it.

l Click Close all Subgroups to close all open subgroups within the group you right-clicked on.

l Click Print "xyz" to open the Print panel and send the group to the printer. Note: xyz being the
name of the current group open in your monitor view.

l Click Create New Group to configure the settings for a new group. The new group will be
created within the group you right-clicked on.

l Click Delete a Group to delete a group.

Scale CPU Percentages
Select Scale CPU Percentages to scale CPU to the number of configured processors. The range
when scaled is normally 0-100%, but it may be exceeded if capacity on demand is used for the
partition.

Auto-Export
For information on this option, see Using the Auto-Export Panel.

Select Multiple
In the Select Multiple drop-down list, you can choose to highlight certain elements with the same
types.

For example, if your CPU usage is at 15% and you choose to select those elements that are Less or
Equal to 15%, all other elements that have a percentage of 15% or less will be highlighted for easy
viewing.
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Window
SelectingWindow from the right-click menu shows you your display options for the Monitor view.

Actions you can take:

l Select Display Icon to display the status icon for the current system. The icon changes
depending on the system status and thresholds.

l Select Icon Right to move the status icon to the upper right-hand corner of the window (the
icon defaults to the left).

l Select Display Tool Tips if you want a screen tip to appear when you hover over data (bar or
text groups) on the graph.

l In Stack Bars, you can choose the following options:

l Select Never Stack if you want the graph bars to always display in a single line.

l Select Always Stack if you want the graph bars to always appear stacked (half on the
bottom row, half on the top).

l Select Stack if Portrait if you only want the graph bars to appear stacked when the
window length is adjusted to a portrait, rather than landscape, view.

l Select Staggered Labels if you want the labels beneath the graph bars to display on alternate
lines. This is particularly useful for long labels.

l Select Fill Back of Frame to change the background of the frame to a slightly darker color.

Sort
Selecting Sort from the right-click menu allows you to sort your elements by system, parameter,
severity, and so on.
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For more information on sort options, see Sorting Elements.

Sorting Elements
You can change the order of displayed elements using the sort functions in the right-click menu.

Sorting does not permanently change the order of elements in the view. They return to their
configured order when you re-open the Monitor View or change the sort sequence to None.

The Monitor View defaults to an ascending or descending sort sequence depending on the sort type.
To reverse the sort sequence, select the sort option from the right-click menu again or use the sort
option keyboard shortcut.

There are two ways to choose a sort order. You can select the sort option you want from the right-
click menu, or you can press the matching function key.

Name Keyboard
Shortcut

Description

None F4 Returns the elements to the default sequence

Repeat F5 Opens the last sort option selected or refreshes the current
sort option with updated system data

System F6 Sorts by system name

Value F7 Sorts by current value

Severity F8 Sorts by severity (from the threshold records)

Short
Description

F9 Sorts by a short description from the element definition

Long
Description

F10 Sorts by a long description from the element definition

Monitor
Type

F11 Sorts by the element type (for example: subsystem status
and controller status)

Parameters F12 Combines the parameters into a single string and uses this
to sort, so that elements referring to the same objects are
brought together
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Groups
There are two types of groups you can set up in the Monitor View: bar groups and text groups.

l Bar groups are used for numeric data, such as CPU usage and response time. The Monitor
View always has at least one bar group displayed.

l Text groups are used for items with discrete value, such as subsystem statuses or subsystem
job counts, and display useful information in a small space. They rely on the threshold to assign
a description and color the item in the list.

Groups, no matter the type selected, are derived from their children. The children can be other
groups or simple elements. Normally, a group takes the value of the descendant with the highest
severity, but it can also be used to calculate other values, such as averages and sums.

Arranging Groups
When using groups, we recommend you arrange them in a hierarchy. This allows you to keep the
main text group open during normal operations while keeping the clutter of data to a minimum.
Then, when a problem arises and a threshold brings something to the top level, you will see it
immediately and be able to investigate.

You can arrange groups (if there is more than one open) around the window and change their size
and position.

l To change the size, drag the edge of the group window in the direction you want it to go. It can
move left, right, up, and down depending on the group's current position.

l To change the position, click the group's title bar and drag it to a new location. The available
locations are shown through icons on the screen and area highlights (see image below).
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l If you want the group to be separate from the Monitor View window, right-click the title bar
and select Floating. To reattach the group to the Monitor View window, right-click the title bar
and select Docking. You can also click the button to select either of these options.

l If you want to auto hide the group from the Monitor View window, right-click the title bar and
select Auto Hide or click the button.

l To remove the group from the screen, click the Close button. You can reopen a group at

any time by selectingOpen any Group from the right-click menu.

Opening a Group
The following sections cover a few ways you can open a group from the Monitor View.

Opening a random group

You can open a random group by selectingOpen any Group from the right-click menu. When the
Open Group for system panel appears, select a group from the displayed hierarchy, then click OK.

Opening a group in another group

You can open a group by double clicking on a group shown within another group, as long as it is not a
calculated result. If it is a calculated result (sum or average), the group will be treated as an element
and open in the Short-Term History view.
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Finding the element that triggered the threshold

If a high level group is displayed and a group within that group shows a problem with an element,
you can open the group containing that element no matter where it is in the hierarchy.

To open a group and see the problematic element, right-click the high level group and select Open
Threshold Source. Otherwise, you can open the threshold source by holding down Ctrl and double
clicking on the item.

Filtering by Severity
You can filter items in a group by the severity of the current threshold for each group element.

To set up a severity filter:

1. Select Properties for X Group for the desired group from the right-click menu. This opens the
Group Properties panel.

2. On the View Options panel in the Description for All Groups tab, enter a severity level in the
Only display elements with severity >= field, or select a predefined level using the drop-
down list.

3. Click OK to save the new severity filter.

Once the severity filter is in place, only elements with the desired severity or greater will display in
the group. If no elements are selected, a message will display, indicating that all items have been
excluded by the filter.

Running Commands against Monitored Objects
Many elements, depending on the type of object being monitored, allow commands to be run. For
example, you can start or end the subsystem for a monitored subsystem status through the Monitor
view.
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Running Commands
To run a command, select an element in a table or graph and open the right-click menu.

Depending on which monitored object you want to view, certain commands may not be available.
See the table below for a list of elements and their commands.

Actions you can take:

l You can select multiple objects of the same type and run a command for all of them. To do
this, left-click the first element, then hold down Ctrl and select the others you want in the
batch.

l You can select multiple objects based on their value or type. To do this, right-click an element
and hover overMultiple Select. Choose an option from the drop-down list to select the items
you want in the group.

Things you should know:
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l You may be prompted for a user name and password before you can run a command.

NOTE: If you select Remember this password, your sign on information will be retained for
as long as Robot Monitor is running. Your sign on information is used across all systems
unless otherwise prompted.

l If the command name ends in three dots, it will be prompted using Operations Navigator
before running.

l When you run a command, an information window appears. This window allows you to follow
the command's progress and results.

Available Commands
The following element types and commands are available in Robot Monitor.

Element Type Commands Confirmation
Required

Line Status

Vary On

Vary Off Yes

Resume Recovery

End Recovery

Controller Status

Vary On

Vary Off

Resume Recovery Yes

End Recovery
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Element Type Commands Confirmation
Required

Vary On

Device Status

Vary On

Vary Off Yes

Resume Recovery

End Recovery

Hold Device

Release Device

Subsystem Status

Start Subsystem

End Subsystem (Controlled) Yes

End Subsystem (Immediate) Yes

End Subsystem (Immediate, no
logs)

Yes

Job Queue Count

Release Job Queue

Hold Job Queue Yes

Job Queue Status

Release Job Queue

Hold Job Queue Yes

Spooled File Count

Release Output Queue

Hold Output Queue Yes

Clear Output Queue Yes

Network Interface Status

Vary On

Vary Off Yes

Resume Recovery
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Element Type Commands Confirmation
Required

End Recovery

Network Server Status

Vary On

Vary Off Yes

Resume Recovery

End Recovery

Output Queue Status

Release Output Queue

Hold Output Queue Yes

Clear Output Queue Yes

Job Queue Active Job
Count

Release Job Queue

Hold Job Queue Yes

Job Queue Max Wait Time

Release Job Queue

Hold Job Queue Yes

Job Queue AvgWait Time

Release Job Queue

Hold Job Queue Yes

Collapsing Duplicate Items
You can collapse duplicate items in a multiple system view in order to produce a cross system
summarization of performance data. Choosing to collapse items by Using Default Summarization
will summarize the various data types in ways that make sense. However, you can also choose to
summarize by average value, maximum severity, sum of items, maximum value, and minimum value.

To summarize each performance element for the entire window, right-click the background and
select an option under Collapse All Items to Group. You can also collapse individual items by right-
clicking on them and selecting an option from the Collapse All Items to Group list.

When duplicate items are collapsed, an additional line of labels appears at the bottom of the bar
view. For a group summarized by maximum value, the short name for the system from which the
value has been taken is displayed. For other summarization types, and for maximum value when all
values of zero, this line displays the summarization type.
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The Short-Term History View
The Short-Term History view displays up to nine hours of history for one or more elements. History
is shown from a selected point in the past to the present, and the graph updates continuously as it
receives samples from the central system.

When the Short-Term History view is opened, Robot Monitor checks to see whether the required
history is available for viewing. If it is not, Robot Monitor will schedule a download of the missing
data. This download is performed in the background, and only one download is performed at a time.

Short-Term History View Options

The Item Selection Sidebar

Short-Term History View Options
The following sections contain general information about the settings you can use to customize your
Short-Term History view.

The Line View History Ribbon

Actions you can take:

l Select Copy to copy the view to the clipboard to be pasted to a dashboard.

l Select Limits to view the Short-Term History Properties panel. From here, you can choose the
date/time range you want downloaded and plotted on the graph.
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l Select the radio button that corresponds to the time period you want shown on the current
graph. For example, if you choose Two Hours, the graph will show you two hours of data. If
you choose Nine Hours, the graph will expand to show you nine hours of data.

l Click Translated to switch between translated and numeric data graphs. Translated graphs
show the threshold levels at a particular point in time.

l Click Smoothing to apply smoothing to the graph. This allows easier identification of trends.
For some examples of the differences between options, see Example: Smoothing.

l Select Fill Chart to fill the line graph with your selected color.

l Select Glass Mode to make the data fill color transparent.

l Select Show Thresholds to display the threshold ranges by adding colored bands to the
background of the graph.

l Select Auto Adjust Scaling to automatically adjust the scaling on the sides of the graph to fit
the current data.

l Choose a Color Set from the drop-down to apply to your graph. This changes the color of the
line graph data. The default color is blue.

l Select Color Set by Item to color differentiate the graph by item or Color Set by System to
color differentiate the graph by system.

Minimizing and Restoring the Line View History Ribbon
Use the following steps to minimize and restore the ribbon.

1. Click in the upper-left corner to open the Customize Quick Access Toolbar.

2. From the drop-down, selectMinimize the Ribbon to hide the ribbon. Select it again to show
the ribbon.

NOTE:You can also double-click the History tab to minimize and restore the ribbon
quickly.

If you want to use the ribbon when it is minimized, you can open it by clicking the History tab. When
you are done, click anywhere in the Short-Term History view to hide the ribbon again.

System Views Bar

The System Views bar allows you to jump from view to view for the selected system (in this case,
WAN) using the drop-down views list.

Actions you can take:

l Click the New Window to open the Short-Term History view in a separate GUI window.

l Click the Item Selection to select or deselect different items to display in the Short-Term
History view.

l Click the Short-Term History view, then select a new view from the drop-down list to visit
that window.

User Guide www.helpsystems.com page: 120



Systems, Groups / About Robot Monitor Views

l Click the navigation buttons to move back or forward from a Short-Term History
drill-down or other previously viewed screens.

Printing View Details
Use the following steps to print details related to the Short-Term History view.

1. Click File in the upper left corner, then select Print from the File menu.

2. Select a printer from the list of printers configured on your PC.

3. Select any Settings you want to apply to the printed pages.

4. Enter how many copies you want made in the Copies field, then click Print.

The Short-Term History Window
Actions you can take:

l When the Short-Term History view displays multiple elements, you can add or subtract them
by using the Item Selection bar.

l You can copy the view to a dashboard by clicking the Copy button in the Line View menu and
pasting into the dashboard of your choosing.

l Double-click a time slot on the graph to open the Highest CPU Jobs view for that time.

Short-Term History Properties Panel
This panel opens when you click the Limits button in the Short-Term History Options ribbon on the
Short-Term History view. There are two tabs you can use on this panel.

Graph Options
This tab allows you to change the graph settings and the look/feel of the data shown.
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Actions you can take:

l Enter graph titles for the Main Title (Upper), Y Axis Title, and Main Title (Lower), if other than
the default.

l Enter a Time Period to display in the graph.

l Select a Graph Type. You can choose values or translated values.

l Select a level of Smoothing from the drop-down list. The smoothing controls the level of detail
in the graph, so the higher the level of smoothing selected, the gentler the curve that is drawn.

l Check the boxes of the look/feel settings to apply to the graph. You can choose to fill the
graph, have the graph be transparent so you can see the grid (Glass Mode), toggle the
thresholds on and off, and auto adjust the graph scaling.

Item Selection
This tab allows you to select the items you want to graph. You can choose to plot one item or several
items.

Items that show in bold contain thresholds that have detail records. These items can be plotted in
translated graphs.
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If there are any defined elements that are not in a group, they will appear at the bottom of the list as
(Not in a group). These items are grouped by collector type and are shown in alphabetical order.

Actions you can take:

l Click an item to select it. If you want multiple items, hold down Ctrl and click the items to
highlight them. Note: You can also use Ctrl-click to clear previously selected options.

Short-Term History View Options

Example: Smoothing

The Short-Term History View

The Detailed History View
With the Detailed History view, you can create line graphs of historical data and investigate previous
high-impact jobs.
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To view the jobs using the most CPU during a specific time, double-click a time slot on the graph to
open the Highest CPU Jobs view.

Detailed History View Options
The following sections contain general information about the settings you can use to customize your
Detailed History view.

The Detailed History Options Ribbon

Actions you can take:

l Click Previous Period to roll back to the previously monitored time range for the graph.

l Select Copy to copy the view to the clipboard to be pasted to a dashboard.

l Select Limits to view the Detailed History Properties panel. From here, you can choose the
date/time range you want downloaded and plotted on the graph.

l Click Next Period to roll forward to the next monitored time range for the graph.

l Click Translated to switch between translated and numeric data graphs. Translated graphs
show the threshold levels at a particular point in time.

l Click Smoothing to apply smoothing to the graph. This allows easier identification of trends.
For some examples of the differences between options, see Example: Smoothing.

l Select Fill Chart to fill the line graph with your selected color.

l Select Glass Mode to make the data fill color transparent.
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l Select Show Thresholds to display the threshold ranges by adding colored bands to the
background of the graph.

l Select Auto Adjust Scaling to automatically adjust the scaling on the sides of the graph to fit
the current data.

l Choose a Color Set from the drop-down to apply to your graph. This changes the color of the
line graph data. The default color is blue.

l Select Color Set by Item to color differentiate the graph by item or Color Set by System to
color differentiate the graph by system.

Minimizing and Restoring the Detailed History Options Ribbon
Use the following steps to minimize and restore the ribbon.

1. Click in the upper-left corner to open the Customize Quick Access Toolbar.

2. From the drop-down, selectMinimize the Ribbon to hide the ribbon. Select it again to show
the ribbon.

NOTE:You can also double-click the Options tab to minimize and restore the ribbon
quickly.

If you want to use the ribbon when it is minimized, you can open it by clicking the Options tab.
When you are done, click anywhere in the Detailed History view to hide the ribbon again.

System Views Bar

The System Views bar allows you to jump from view to view for the selected system (in this case,
WAN) using the drop-down views list.

Actions you can take:

l Click Item Selection to open the Item Selection sidebar.

l Click New Window to open the Detailed History view in a separate GUI window.
l Click the Detailed History view, then select a new view from the drop-down list to visit that
window.

Printing View Details
Use the following steps to print details related to the Detailed History view.

1. Click File in the upper left corner, then select Print from the File menu.

2. Select a printer from the list of printers configured on your PC.

3. Select any Settings you want to apply to the printed pages.

4. Enter how many copies you want made in the Copies field, then click Print.

Detailed History Properties Panel
This panel opens when you click the Limits button in the Detailed History Options ribbon on the
Detailed History view. There are three tabs you can use on this panel.
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Date/Time Range
This tab allows you to determine the date/time range you want downloaded and plotted on the
graph.

Actions you can take:

l On the calendars, select a From Date and To Date that you want drawn on the graph. Note:
Use the arrows to change the calendar month.

l Enter a time in the numeric field below each calendar to plot the view of your graph. As an
example: for a detailed look at your data, you could graph a date/time range from June 20th at
10 a.m. to June 20th at 11 a.m. For a wider scope of data, you could graph a date/time range
from June 20th at 10 a.m. to June 21st at 10 a.m.

l Select the relationship of the From Date and the To Date to the current date. Note: This
section is primarily useful for running report output.

Graph Options
This tab allows you to change the graph settings and the look/feel of the data shown.
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Actions you can take:

l Enter graph titles for the Main Title (Upper), Y Axis Title, and Main Title (Lower), if other than
the default.

l Select a Graph Type. You can choose values or translated values.

l Select a level of Smoothing from the drop-down list. The smoothing controls the level of detail
in the graph, so the higher the level of smoothing selected, the gentler the curve that is drawn.

l Check the boxes of the look/feel settings to apply to the graph. You can choose to fill the
graph, have the graph be transparent so you can see the grid (Glass Mode), toggle the
thresholds on and off, and auto adjust the graph's scaling.

Item Selection
This tab allows you to select the items you want to graph. You can choose to plot one item or several
items.

Items that show in bold contain thresholds that have detail records. These items can be plotted in
translated graphs.

If there are any defined elements that are not in a group, they will appear at the bottom of the list as
(Not in a group). These items are grouped by collector type and are shown in alphabetical order.
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Actions you can take:

l Click an item to select it. If you want multiple items, hold down Ctrl and click the items to
highlight them. Note: You can also use Ctrl-click to clear previously selected options.

Example: Smoothing
Smoothing controls the level of detail in the graph. The higher level of smoothing you select, the
gentler the curve that is drawn.

Under the Detailed History options ribbon in the Detailed History view and the Short-Term History
options ribbon, you can choose No Smoothing, Low Smoothing, Medium Smoothing, or High
Smoothing.

The following examples offer a visual representation of two choices: No Smoothing and High
Smoothing. The data used for both choices is exactly the same.
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Example 1: No Smoothing

Example 2: High Smoothing
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The Detailed History View

The History Summary View
The History Summary view provides a summarized view of your system's performance data. You can
summarize numeric data by hour, day, and month, and other detailed options are available, too.
Status and alphabetic information is summarized by threshold record, and numeric data may also be
summarized using thresholds.

Data is summarized on the host system. Detailed data is summarized each day at a time configured
using the MONCFG command in the green screen. Data can also be manually summarized using the
MONSUM command, and detail data can be completely summarized using the MONRESUM
command.

NOTE: The MONRESUM command is intended for use after changing summarization parameters
or thresholds.

As with the other summary modules, data can be stored locally (or on a PC server) to improve
performance when the same information is requested again. When data is loaded from a local file,
the program checks the database on the host system and warns you if additional data is available.
Then, you are given the option of downloading the new data. If you use the saved data, the text
(Saved Data) will be added to the title of the window. (This only happens on the display; it is not
printed.)

History Summary View Options
The following sections contain general information about the settings you can use to customize your
History Summary view.
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The History Summary Options Ribbon

Actions you can take:

l Click Previous Period to roll back to the previously monitored time range for the graph.

l Click Limits to view the History Summary Properties panel. From there, you can choose a
summary type and forecast period for the data on your graph.

l Select Copy to copy the view to the clipboard to be pasted to a dashboard.

l Click Next Period to roll forward to the next monitored time range for the graph.

l Click One Year to view a forecast of your system's performance data for the next 12 months.

l Click One Month to view a forecast of your system's performance data for the next month.
You can view your month by hour or element, as well, by choosing an option from the drop-
down.

l Click One Day and to view a forecast of your system's performance data for the next 24
hours. You can view your day by element instead of hour by choosing the option from the
drop-down.

l Click Translated to switch between translated and numeric data graphs. Translated graphs
show the threshold levels at a particular point in time.

l Select Show Values to show value numbers below each data bar.

l Select Show Max Values to show the maximum value for each data bar above the current
value.

l Select Sort by Value to sort bars representing translated values by their percentages. Note:
This option only applies to translated graphs.

l Select Interpolate to allow Robot Monitor to make a guess at any missing data points on the
graph. Note: Some data points must be available on the graph for this to work.

l Select Forecast to allow Robot Monitor to project future values for the average numeric data
graphs.

l Select Auto Adjust Scaling to automatically adjust the scaling on the sides of the graph to fit
the current data.

l Choose a Color Set from the drop-down to apply to your graph. This changes the color of the
line graph data. The default color is blue.

Minimizing and Restoring the History Summary Options Ribbon
Use the following steps to minimize and restore the ribbon.

1. Click in the upper-left corner to open the Customize Quick Access Toolbar.

2. From the drop-down, selectMinimize the Ribbon to hide the ribbon. Select it again to show
the ribbon.

NOTE:You can also double-click the Options tab to minimize and restore the ribbon
quickly.

If you want to use the ribbon when it is minimized, you can open it by clicking the Options tab.
When you are done, click anywhere in the History Summary view to hide the ribbon again.
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System Views Bar

The System Views bar allows you to jump from view to view for the selected system (in this case,
WAN) using the drop-down views list.

Actions you can take:

l Click the Item Selection button to open the Item Selection sidebar.

l Click the New Window button to open the History Summary view in a separate GUI
window.

l Click the History Summary view, then select a new view from the drop-down list to visit that
window.

Printing View Details
Use the following steps to print details related to the History Summary view.

1. Click File in the upper left corner, then select Print from the File menu.

2. Select a printer from the list of printers configured on your PC.

3. Select any Settings you want to apply to the printed pages.

4. Enter how many copies you want made in the Copies field, then click Print.

History Summary Properties Panel
This panel opens when you click the Limits button in the History Summary Options ribbon on the
History Summary view. There are three tabs you can use on this panel.

Date/Time Range
This tab allows you to determine the date/time range you want downloaded and plotted on the
graph.
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Actions you can take:

l On the calendar, choose the Date Selection that you want drawn on the graph. Use the arrows
to change the calendar month.

l Select what type of summary you want displayed in the graph. You can choose one of the
following options in the Summary Type drop-down list:

Summary
Type

Description

One Year This summary type shows you a forecast of your system's performance
data for the next 12 months. You can choose to display a forecast
period between 0 and 24 months.

One Month This summary type shows you a forecast of your system's performance
data for the next month. You can choose to include only certain days
of the week in the data summary.
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Summary
Type

Description

OneMonth
by Hour

This is similar to the One Month summary type, only it shows your
system's performance data for the next month by hour instead of day.
You can choose to include only certain hours of the day in the data
summary, or you can have it include all hours. For example, you could
choose for monthly data to be recorded only between the hours of 9
a.m. and 5 p.m.

Month by
Element

This summary type shows you a forecast of your system's performance
data for the next month by element. If you have more than one
element monitored in the widget, all of them will show up on the
graph.

One Day This summary type shows you a forecast of your system's performance
data for the next 24 hours. You can choose to include only certain
hours of the day in the data summary, or you can have it include all
hours. For example, you could choose for the day's data to be recorded
only between the hours of 9 a.m. and 5 p.m.

Day by
Element

This summary type shows you a forecast of your system's performance
data for the next day by element. If you have more than one element
monitored in the widget, all of them will show up on the graph.

l Select the relationship of the Selection Date to the current date. This section is primarily
useful for running report output.

Graph Options
This tab allows you to change the graph settings and the look/feel of the data shown.

User Guide www.helpsystems.com page: 134



Systems, Groups / About Robot Monitor Views

Actions you can take:

l Enter graph titles for the Main Title (Upper), Y Axis Title, andMain Title (Lower), if other
than the default.

l Select a Graph Type. You can choose Values or Translated Values.

l If you choose Translated Values, you can also choose your sort type. You can sort by severity
or values.

NOTE: Severity is the default for the Values graph type.

l Choose whether or not you want the graph scaling to auto adjust.

Item Selection
This tab allows you to select the items you want to graph. You can choose to plot one item at a time
or multiple elements at a time.
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Items that show in bold contain thresholds that have detail records. These items can be plotted in
translated graphs.

If there are any defined elements that are not in a group, they will appear at the bottom of the list as
(Not in a group). These items are grouped by collector type and are shown in alphabetical order.

Presenting Summarized Data
When you set up your summarized graph, you can present the data in two ways: by numeric data and
by threshold record.

Numeric data: Numeric data provides the average value for each time period presented as a bar in
the graph. Threshold information can be displayed on the axis. Since most status information is not
numeric, presenting the data as numeric data is generally only used in specific situations.

Threshold record: Data can be summarized by threshold record. This approach to summarizing is
particularly suited to data types that are fixed values, such as subsystem status, job queue status, and
line status. You can also use threshold records to summarize ordinary numeric data when you want
to show the amount of time certain values within particular ranges will take.
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Averaged Numeric Data
The averaged numeric data graph (the default graph) displays summarized data as simple averages of
numeric values over your selected time period. In the image below, this summarized data is
displayed by day.

Numeric data graphs are useful for showing and demonstrating trends. Robot Monitor can also
interpolate missing data and make forecasts whenever simple trends in the data are apparent.

Data Summarized by Threshold
Many types of data can be displayed in a translated graph, so long as there is a global threshold for
the data to be translated against. Translation occurs as part of summarization. Only global thresholds
are used; local thresholds are not stored on the host system.
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Robot Monitor counts the number of samples matching each threshold record and produces a graph
that shows the percentage of samples over the select period (day, month, or year depending on the
summary type you chose for your graph).

Translated graphs are also particularly useful for status monitors and other element types that return
fixed values.

Interpolating Data
Robot Monitor can interpolate missing data and forecast future values. Interpolated values appear on
the graph as semi-transparent bars.
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If you are summarizing by One Year, you can choose to forecast a period of up to 24 months. This is
done in the History Summary Properties panel.

Interpolated values are not absolute. An accurate portrayal of the trends on your system depends on
how stable the system data is.

NOTE:Meaningful interpolation and forecasting is only possible for a graph that already has two
or more data points.

Multiple Element Graphs
In the History Summary view, you can select multiple elements to display on a single graph using the
Month by Element summary or Day by Element summary found within the History Summary
Options Ribbon, or you can simply click the Item Selection button to open the Item Selection
sidebar and select multiple elements to add to the History Summary view.

In order to bring together data with very different scaling requirements on a single graph, Robot
Monitor will adjust the scale where necessary.

The above image shows a Month by Element summary for June 2016. There are 13 elements
selected for the view. You can have as many or as few elements on your graph as you want.

The Disk Summary View
The Disk Summary view presents summarized disk data collected daily (or less frequently,
depending on the collection schedule you set) from the host system. Detailed historical reports
regarding changes to individual objects over time can be printed on the host system using the
MONDSKADT command. You can also use the MONDSKINQ command on the host system to
conduct detailed searches of the information gathered during the last collection.
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You can collect data for the native file system and the hierarchial file systems (IFS). For native file
systems, data is summarized by library. For the IFS, the user sets the depth for the summarization.

Disk summaries and inquiry programs only work on ordinary objects. Robot Monitor does not report
on LIC data, processes and tasks, or other similar items.

Disk Summary View Options
The following sections contain general information about the settings you can use to customize your
Disk Summary view.

The Disk Summary Options Ribbon

Actions you can take:

l Click Previous Period to roll back to the previously monitored time range for the graph.

l Click Limits to view the Disk Summary Properties panel. From there, you can choose a
summary type and configure your graph settings.

l Click Next Period to roll forward to the next monitored time range for the graph.

l Select Copy to copy the view to the clipboard to be pasted to a dashboard.

l Select Yearly View to view your system's performance data for the last 12 months. You can
view the year by any of the selection types (libraries, attributes, types, and so on).

l SelectMonthly View to view your system's performance data for the current month. You can
view the month by any of the selection types (libraries, attributes, types, and so on).
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l Select Daily View to view your system's performance data for the current day. You can view
the day by any of the selection types (libraries, attributes, types, and so on).

l Check Show Sizes to display the values of each data element below their corresponding bar.

l Check Show Other to add an (Other) bar that show the total size of all objects not otherwise
selected for the graph.

l Check Sort by Size to arrange the bars by size in descending order. If this option is not
checked, the bars are presented in alphabetical order.

l Check Interpolate to allow Robot Monitor to make a guess at any missing data points on the
graph. Note: Some data points must be available on the graph for this to work.

l Check Forecast to allow Robot Monitor to project future values for the average numeric data
graphs.

l Select either Show as GB (default) or Show as MB to change the displayed size value of the
Disk Summary View.

l Select Libraries to summarize data in the graph by library size.

l Select Attributes to summarize data in the graph by object attribute.

l Select Types to summarize data in the graph by object type.

l Select Owners to summarize data in the graph by the iSeries object owner.

l Select Days Used to summarize data by the number of days since each object was last used.
Objects are grouped into units of 1-7, 8-14, 15-28, and so on.

l Select Applications to summarize data by groups of libraries or IFS directories in the native
file system.

l Select Directories to summarize data by IFS directories.

l Choose a Color Set from the drop-down to apply to your graph. This changes the color of the
graph data. The default color is blue.

Minimizing and Restoring the Disk Summary Options Ribbon
Use the following steps to minimize and restore the ribbon.

1. Click in the upper-left corner to open the Customize Quick Access Toolbar.

2. From the drop-down, selectMinimize the Ribbon to hide the ribbon. Select it again to show
the ribbon.

NOTE:You can also double-click the Options tab to minimize and restore the ribbon
quickly.

If you want to use the ribbon when it is minimized, you can open it by clicking the Options tab.
When you are done, click anywhere in the Disk Summary view to hide the ribbon again.

System Views Bar

The System Views bar allows you to jump from view to view for the selected system (in this case,
WAN) using the drop-down views list.

Actions you can take:
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l Click Item Selection to open the Item Selection sidebar.

l Click New Window to open the Disk Summary view in a separate GUI window.
l Click the Disk Summary view, then select a new view from the drop-down list to visit that
window.

Printing View Details
Use the following steps to print detailed related to the Disk Summary view.

1. Click File in the upper left corner, then select Print from the File menu.

2. Select a printer from the list of printers configured on your PC.

3. Select any Settings you want to apply to the printed pages.

4. Enter how many copies you want made in the Copies field, then click Print.

Disk Summary Properties Panel
This panel opens when you click the Limits button in the Disk Summary Options ribbon on the Disk
Summary view. There are three tabs you can use on this panel.

Date/Time Range
This tab allows you to determine the date/time range you want downloaded and plotted on the
graph.
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Actions you can take:

l On the calendar, choose the Date Selection that you want drawn on the graph. Note: Use the
arrows to change the calendar month.

l Select what type of summary you want displayed in the graph. You can choose one of the
following options in the Summary Type drop-down list:

Summary
Type

Description

Daily This summary type displays your system's performance data for the
current day. You can choose to include only certain days of the week in
your data collection.

Monthly This summary type displays your system's performance data for the
current month.
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Summary
Type

Description

Yearly This summary type displays your system's performance data for the
past year. You can choose to display a forecast period between 0 and
24 months. In order to see the forecast in the graph, check the
Forecast box next to the Forecast Period field.Note: The forecast
period appears on the graph in a different color than your regular data.

l Select the relationship of the Selection Date to the current date. Note: This section is
primarily useful for running report output.

Graph Options
This tab allows you to change the graph settings and the look/feel of the data shown.

Actions you can take:
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l Enter graph titles for the Main Title (Upper), Y Axis Title, andMain Title (Lower), if other
than the default.

l Check the boxes of the look/feel settings to apply to the graph. Note: You can also apply these
directly from the Disk Summary Options ribbon.

Item Selection
This tab allows you to select the items you want to graph.

Actions you can take:

l Select a Graph Type from the drop-down list.

l Choose an item to graph from the Item Selection list. The items you see will depend on the
graph type you selected.

l Check Automatically Select Largest if you want Robot Monitor to display the largest data
classes.

l In the Maximum Items to Select drop-down, choose how many items Robot Monitor should
auto-select.
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l Type a Generic Selection in the field to select objects. This is a complex version of generics
(or wildcards). You can use generics like ABC* (to select all items beginning with ABC) or
*CDE* (to select all items that include CDE).

l Select Ignore Case if you want the case of an element name to be ignored when searching. For
example, if selected, abC will be considered the same as Abc.

l Choose an ASP from the drop-down list if you want to limit the data displayed to a particular
ASP. Note: This is only available for the Daily View summary type when Single Item is not
selected.

Disk Summary Drill Down
You can drill down into your disk summary data in a couple of different ways in order to see disk
usage by directories, libraries, or other graph types.

Drill Down in the Disk Summary View
To drill down into disk usage from the Disk Summary view:

1. Click Item Selection to open the Item Selection sidebar.

2. Select a library or directory within the Item Selection sidebar. The Disk Summary graph will
update to show the disk usage for the selected library or directory.

3. Expand the directory or select a different library to drill down to different levels of disk usage
data.

4. To go back to the main Disk Summary view, reselect Disk Summary from the View drop-down
in the System Views bar.
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Drill Down using the Properties Panel
To drill down into disk usage from the properties panel:

1. Click the Limits button in the Disk Summary Options ribbon.

2. Select the Item Selection tab.

3. Select a way to view the disk usage data using the Graph Type drop-down. Your choices are:

l Directories

l Libraries

l Attributes

l Types

l Owners

l Days Used

l Applications

4. Click OK. The Disk Summary view will update to display the updated data.

5. Select a item within the Item Selection sidebar. The Disk Summary graph will update to show
the disk usage for the selected item.

6. To go back to the main Disk Summary view, reselect Disk Summary from the View drop-down
in the System Views bar.

The Accounting Summary View
The Accounting Summary view displays data collected from the host system's job accounting system.
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Data is collected from the remote systems whenever disk data is collected as long as job accounting
is enabled and the collection function is selected on the host system using MONCFG.

The Job Accounting view differs from other views shown in Robot Monitor. It displays numbers
instead of rates. CPU, for instance, is displayed as a total number of CPU seconds used rather than a
percentage. TRN is displayed as a total number of transactions processed rather than an average rate
per hour.

Job accounting information can be displayed by job accounting codes or user IDs. Job accounting
codes are used to summarize data and are typically set in the user profile, where they are inherited
by jobs that are started by the user. Accounting codes can be changed during the course of a job by
using the CHGACGCDE command in the green screen. This command allows you to (for instance)
report on response time and CPU used by application.

Accounting Summary View Options
The following sections contain general information about the settings you can use to customize your
Accounting Summary view.

Accounting Summary Options Ribbon

Actions you can take:

l Select Copy to copy the view to the clipboard to be pasted to a dashboard.

l Click Previous Period to roll back to the previously monitored time range for the graph.
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l Click Limits to view the Accounting Summary Properties panel. From there, you can choose a
summary type and configure your graph settings.

l Click Next Period to roll forward to the next monitored time range for the graph.

l Select whether you want to summarize by Accounting Code or User ID. You can choose one of
the following options in the drop-down lists for these two summary types:

Summary Type Description

Month by Accounting
Code

This summary type shows you a single month of
information with a bar for each accounting code.

Day by Accounting Code This summary type shows you a single day of
information with a bar for each accounting code.

Accounting Code by
Month

This summary type shows you information on a single
accounting code, with a bar for each month of the year.

Accounting Code by Day This summary type shows you information on a single
accounting code, with a bar for each day of the month.

Month by User ID This summary type shows you a single month of
information with a bar for each user ID.

Day by User ID This summary type shows you a single day of
information with a bar for each user ID.

User ID by Month This summary type shows you information on a single
user ID, with a bar for each month of the year.

User ID by Day This summary type shows you information on a single
user ID, with a bar for each day of the month.

l Choose whether you want the summary type to display All Jobs, Batch jobs, or Interactive
jobs.

l Check Show Sizes to display the values of each data element below their corresponding bar.

l Check Show Other to add an (Other) bar that show the total size of all objects not otherwise
selected for the graph.

l Check Sort by Size to arrange the bars by size in descending order. If this option is not
checked, the bars are presented in alphabetical order.

l Select CPU Seconds to summarize data in the graph by total number of CPU seconds used.

l Select Transaction Count to summarize data in the graph by total number of transactions
processed.

l Select Response Time to summarize data in the graph by the average response time for each
job in the selected class.

l Select Auxiliary I/O to summarize data in the graph by the total number of disk operations
running.

l Select DBase Reads to summarize data in the graph by the number of reads from files (other
than stream files).

User Guide www.helpsystems.com page: 149



Systems, Groups / About Robot Monitor Views

l Select DBase Writes to summarize data in the graph by the number of writes to files (other
than stream files).

l Select DBase Updates to summarize data in the graph by the number of updates to records in
files (other than stream files).

l Select DBase Total to summarize data in the graph by the total number of database puts, gets,
and updates.

l Select Comms Reads to summarize data in the graph by the number of reads from
communications files (not TCP).

l Select CommsWrites to summarize data in the graph by the number of writes to
communication files (not TCP).

l Select Comms Totals to summarize data in the graph by the total number of communications
puts and gets.

l Choose a Color Set from the drop-down to apply to your graph. This changes the color of the
graph data. The default color is blue.

Minimizing and Restoring the Accounting Summary Options Ribbon
Use the following steps to minimize and restore the ribbon.

1. Click in the upper-left corner to open the Customize Quick Access Toolbar.

2. From the drop-down, selectMinimize the Ribbon to hide the ribbon. Select it again to show
the ribbon.

NOTE:You can also double-click the Options tab to minimize and restore the ribbon
quickly.

If you want to use the ribbon when it is minimized, you can open it by clicking the Options tab.
When you are done, click anywhere in the Accounting Summary view to hide the ribbon again.

System Views Bar

The System Views bar allows you to jump from view to view for the selected system (in this case,
WAN) using the drop-down views list.

Actions you can take:

l Click Item Selection to open the Item Selection sidebar.

l Click New Window to open the Accounting Summary view in a separate GUI window.
l Click the Accounting Summary view, then select a new view from the drop-down list to visit
that window.

Printing View Details
Use the following steps to print detailed related to the Accounting Summary view.

1. Click File in the upper left corner, then select Print from the File menu.

2. Select a printer from the list of printers configured on your PC.

User Guide www.helpsystems.com page: 150



Systems, Groups / About Robot Monitor Views

3. Select any Settings you want to apply to the printed pages.

4. Enter how many copies you want made in the Copies field, then click Print.

Accounting Summary Properties Panel
This panel opens when you click the Limits button in the Accounting Summary Options ribbon on
the Accounting Summary view. There are three tabs you can use on this panel.

Date/Time Range
This tab allows you to determine the date/time range you want downloaded and plotted on the
graph.

Actions you can take:

l On the calendar, choose the Date Selection that you want drawn on the graph. Use the arrows
to change the calendar month.

l Select what type of summary you want displayed in the graph. You can choose one of the
following options in the Summary Type drop-down list:
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Summary
Type

Description

Daily This summary type displays your system's performance data for the
current day. You can choose to include only certain days of the week in
your data collection.

Monthly This summary type displays your system's performance data for the
current month.

l Select the relationship of the Selection Date to the current date. This section is primarily
useful for running report output.

Graph Options
This tab allows you to change the graph settings and the look/feel of the data shown.

Actions you can take:
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l Enter graph titles for the Main Title (Upper), Y Axis Title, andMain Title (Lower), if other
than the default.

l Check the boxes of the look/feel settings to apply to the graph. Note: You can also apply these
directly from the Accounting Summary Options ribbon.

Item Selection
This tab allows you to select the items you want to graph.

Actions you can take:

l Select a Graph Type from the drop-down list, then check By Date if you want to filter it by
date rather than by code or user.

l Select aMetric from the drop-down list.

l Choose an item to graph from the Item Selection list. The items you see will depend on the
graph type you selected.

l Check Automatically Select Largest if you have a graph that contains numerous user IDs or
accounting codes and want Robot Monitor to display the largest entries automatically.
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l In the Maximum Items to Select drop-down, choose how many user IDs or accounting codes
Robot Monitor should select. Note: This option is only available when Automatically Select
Largest is checked.

The System Data View
The System Data view is comprised of a series of groups that show a range of technical information
about the system.

Click any of the following links to view general information about these groups.

l System Information

l PTF Information*

l IPL Information*

l Power Status*

l Communication Settings**

l Partition Information

l Disk Status

l Installed Fixes**

NOTE:
* These groups are only available on IBM i systems.
** These groups are only available on AIX/Linux/VIOS systems.

System Information
The System Information group displays information for your host system. It is available for IBM i,
AIX, Linux, and VIOS systems.
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IBM i Systems

The following table lists the system information group's fields and descriptions:

Field Description

Serial
Number

This is the system serial number. it is the same across all partitions.

System Type
and Model

This is the hardware type and system model. The code in brackets, if
present, is the processor group used for software pricing. Dedicated
Servers are designed for particular workloads, such as Domino.

Processor
Feature

This is the feature number of the processor. The second number, if present,
is the interactive feature. This sets any limits on interactive processing
power that can be used.

OS/400
Release

This is the feature code and release of the operating system for this
partition.

Main Storage
Available

This is the amount of memory that is operational for the whole machine.

Main Storage
Units not
Operating

This is the number of failed memory cards detected during the last IPL of
the primary partition. These cards are marked as unusable, and the system
operates with only the functional cards.
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Field Description

Processors
Installed

This is the number of physical processors in the whole machine.

Processors
OK

This is the number of physical processors in the whole machine that are
functioning normally. The maximum number that can be detected is 16.
This is scheduled to be fixed in a future release.

Processors
Partly
Functional

This is the number of processors that had failures detected, but are still
able to operate with reduced performance. This problem can currently only
be detected on the first 16 processors.

Processors
Not
Functioning

This is the number of processors that were not operating at all during the
last IPL of the primary partition. This problem can currently only be
detected on the first 16 processors.

Activated
Processors
on Demand

This is the number of processors on demand that have been activated.

Activated
On/Off
Processors

This is the number of metered processors that have been activated.

Activated
Trial
Processors

This is the number of trial processors that have been activated.

System CPW
Rating

This is the total CPW rating for the system.
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AIX/Linux/VIOS Systems

PTF Information
The PTF Information group displays PTF package and group information. Robot Monitor collects this
information when it is started. It is available for IBM i systems.

IPL Information
The IPL Information group displays IPL information for your host system. It is available for IBM i
systems.
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The following sections list the IPL information group fields and descriptions.

OS/400 Started At

This is the date and time that the partition was IPLed.

IPL Cause

This is the reason why the partition started. You may see one of the following:

Cause Description

PRWDWNSYS
RESTART(*YES)

This means the system was restarted using this command.

Powered on
from Front
Panel

This means the user started the system by pressing the Power On
button or by starting the partition from the console.

Timed Power
On

This means the system started because the time set in the QIPLDATTIM
system value was reached.

Remote Power
On by Phone

This means a phone call was made to the ECS line, and remote restart
was enabled.Note: This function requires a special cable on the ECS
modem.

Auto Restart
after Power
Failure

This means the utility power failed and was then restored, and the
system value QPWRRSTIPL was set to enable an automatic IPL when
this happens.

IPL'ed from Side

This indicates the microcode version being used for this IPL.

Side A only has permanently applied microcode fixes.

Side B has temporarily and permanently applied fixes.

Side D is from removable media.
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This field can also show the legend Service Proc. I/F error (IPL may clear). This indicates a possible
hardware failure in the service processor, which is the processor that controls the IPL process. If this
persists after the next IPL, a support call should be logged.

Next IPL from Side

This shows the current front-panel setting for which microcode version will be used on the next IPL.

Last Termination Type

This shows how the partition last ended. You may see one of the following:

Cause Description

Normal (PWRDWNSYS) This means the user issued the PWRDWNSYS command.

Abnormal, but Objects
Ensured

This means the system failed, but all pending operations were
written to disk.

Abnormal This means the system failed completely.

Front Panel Battery Status

This shows the status of the front panel battery for the primary position. The front panel battery
keeps the system clock going if there is a power failure. This can shows OK, low, or failed.

Last Termination Cause

This shows why the partition last ended. You may see one of the following:

Cause Description

Normal (PWRDWNSYS) This means the user issued the PWRDWNSYS command.

Power Failed This means the power failed, and there was no UPS available.

Battery Failed while
Running on UPS

This means the power failed and had not been restored by the
time the UPS also ran out of power.

System Powered Down
from Front Panel

This means the user forced an immediate termination of the
system.

Key Position

This shows the mode the partition is operating in. This is set differently on different models and
types of partition, but for historical reasons, it is known as the key position. It may be set by a key,
by buttons, by buttons and a key stick, from the console, or by using the CHGIPLA command.

Possible values for the key position are Auto, Manual, Normal and Secure.

Front Panel Status

This shows whether the front panel passed all its self checks during the last IPL.
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Hardware Checks

This shows whether hardware tests are performed during IPLs. To speed up IPLs, you can skip the
tests using the front panel or the CHGIPLA command.

Power Status
The Power Status group shows information for a UPS that is connected to the iSeries and is
connected to by the host system. It is available for IBM i systems.

The following table lists the power status group's fields and descriptions:

Field Description

UPS
Present

This shows whether there is a UPS connected to the interface.

UPS Type This shows the type of UPS. A full UPS is able to power the entire system,
whereas a partial UPS is able to keep memory alive for a time, in hope that
power will be restored in time to use the contents of the memory to perform a
controlled shutdown of the system.

UPS
Battery
Status

This can be OK or Low. In theory, it could also show dead (but not for long).

UPS
Bypass
Active

If the UPS bypass is active, this means that the UPS will not be used if power
fails. This function is usually enabled when maintenance is being done on the
UPS.

System
Running
on UPS

This can be Yes or No.

Communication Settings
The Communication Settings group displays the current system's host name, IP address, domain
name, and more. It is available for AIX, Linux, and VIOS systems.

Example of a Possible Communication Settings Group:

Host Name system.yourcompany.com

IP Address 192.169.10.3

Subnet Mask 255.255.255.0
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Gateway 192.168.10.1

Name Server 192.168.50.10

Domain Name yourcompany.com

Partition Information
The Partition Information group displays partition information for the current system. It is available
for IBM i, AIX, Linux, and VIOS systems.

IBM i Systems

The following table lists the partition information panel's fields and descriptions:

Field Description

Number of Partitions The number of partitions on the box on which this
partition resides.

Partition ID The number of this partition.

Primary Partition ID The number of the primary partition. The primary partition
is the host, or controlling partition, for all the other
partitions.
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Field Description

Shared Processors in Pool Shared processors are processors that can be allocated to
partitions in fractional amounts. They are first allocated to
a system wide pool, called the Shared Processor Pool, and
then allocated to the partitions.

Logical Serial Number The unique serial number for the partition.

Shared Processors Available The amount of shared processing power (in the shared
processing pool) which has not been allocated to any
partition.

Processor Limits Many processors have hardware features that limit the
amount of interactive or database CPU that is available to
the machine. On some models, this limitation is enforced
using a microcode process called CFINT, which starts to
use processing power that would otherwise be available to
user jobs when limited CPU types are being used. At a
certain point, the impact of the CFINT tasks starts to affect
the system as a whole. This point is known as the knee of
the curve, or the threshold, and is shown here along with
the maximum amount of processing power that can be
used for interactive and database work.

These limits only apply when more than one job of the
specified type is running. For instance, if a machine is
limited to 8% interactive CPU, and there is only one
interactive job active, then it will be able to use 100% of
the processor. As soon as a second job starts to use CPU,
however, the total usage of the two jobs will be throttled
back to 8%.

External High Speed Link Indicates whether OptiConnect is installed for this
partition. OptiConnect is the iSeries system area network
that provides high-speed inter-connectivity between
multiple iSeries systems in a local environment. Along with
WAN and LAN technologies, OptiConnect provides the
high-speed connectivity between cluster nodes in iSeries
cluster environments.

Internal High Speed Link Indicates whether simulated OptiConnect is configured for
this partition. This uses memory-to-memory
communication to simulate an optical fibre LAN connecting
the partitions on the box.
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Field Description

Processors The current number of processors allocated to the
partition, along with the configured minimum and
maximum values that can be allocated without having to
IPL the partition. This figure still has meaning when a
partition uses shared processors. For example, on a system
with four processors, all four are allocated to the shared
processor pool. The administrator allocates 2.0 processors
to a partition. This can be done by allocating 2.0 processors
or 0.5 of four processors. The decision is based on the type
of workload and can make a big difference to throughput
on the partition.

Memory The current amount of memory allocated to the partition,
along with the configured minimum and maximum values
that can be allocated without having to IPL the partition.
The minimum and maximum values are part of the
configuration because large ranges in the possible values
incur a processing overhead. If the amount allocated to the
partition remains constant, then it is recommended that
these values should be equal. This value is also presented
as the CRM element in the performance data.

Interactive Percent The current proportion of the maximum interactive
processing allocation, along with the configured maximum
and minimum values that the be allocated without having
to IPL the partition. This affects systems with limits on
processing capabilities and is expressed as a percentage of
the total available. For instance, if the machine is limited to
8% interactive, then a figure of 40% would mean that the
partition could use 3.2% of the total processing power of
the machine for interactive work. The minimum and
maximum values are part of the configuration because
large ranges in the possible values incur a processing
overhead. If the amount allocated to the partition remains
constant, then it is recommended that these values should
be equal. This value is also presented as the CRI element in
the performance data.
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Field Description

Shared Processors The current number of shared processors allocated to the
partition, along with the minimum and maximum values
that can be allocated without having to IPL the partition.
The minimum and maximum values are part of the
configuration because large ranges in the possible values
incur a processing overhead. If the amount allocated to the
partition remains constant, then it is recommended that
these values should be equal. This value is also presented
as the CRP element in the performance data.

AIX/Linux/VIOS Systems

Field Description

Node Name The name of the node. It can be the same as the system
name.

Partition Name The name of the partition.

Partition Number The number of the partition.

Type The type of partition.

Mode The mode of the partition.

Entitled Capacity The entitled capacity.

Partition Group ID The partition group ID.

Online Virtual CPUs How many virtual CPUs are online.

User Guide www.helpsystems.com page: 164



Systems, Groups / About Robot Monitor Views

Field Description

Maximum Virtual CPUs The maximum number of virtual CPUs possible.

Minimum Virtual CPUs The minimum number of virtual CPUs possible.

Online Memory How much memory is currently in use.

MaximumMemory The maximum amount of memory allowed for the partition.

MinimumMemory The minimum amount of memory allowed for the partition.

Maximum Physical CPUs The maximum number of physical CPUs possible.

Active Physical CPUs How many physical CPUs are active.

Operating System The current operating system for AIX, Linux, or VIOS.

Disk Status
The Disk Status group displays summary information for the partition and for each ASP. It is
available for IBM i, AIX, Linux, and VIOS systems.

NOTE:
You can launch the ASP Information View for an ASP by double-clicking it in the table.

IBM i Systems

The following table lists the disk status group fields and descriptions:

Field Description

Disk Capacity This is the total disk capacity of the partition in Megabytes. One
Megabyte is 1024 Kilobytes, and one Kilobyte is 1024 bytes.
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Field Description

Disk Drives Not
Allocates to
ASPs

This is the number of drives configured for this partition that are not
being used.

Number of ASPs This shows the total number of configured ASPs.

ASP Status This shows a line for each configured ASP.

ASP This shows an icon and the ASP number.Note: ASP numbers are 1-32
for user ASPs and 33-255 for independent ASPs.

Status This is the current status of the ASP. You may see one of the following:
OK, Suspended, Re-sync, Overflow, Varied Off, and Available.

Used This is the percentage of space in the ASP which has been used to store
data.

Capacity This is the amount of disk storage configured for the ASP.

Busy % This is the average disk busy figure for the ASP. The busy figure for an
ASP can also be displayed as an element using the user defined data
bars.

Busiest Units This is the unit number of the busiest disk in the ASP.

Busiest Unit % This is the disk busy figure for the busiest disk in the ASP.

AIX/Linux/VIOS Systems

The following table lists the disk status group fields and descriptions:
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Field Description

Disk Capacity This is the total disk capacity of the partition in Megabytes. One Megabyte
is 1024 Kilobytes, and one Kilobyte is 1024 bytes.

Disk Drives
Not Allocates
to VGs

This is the number of drives configured for this partition that are not being
used.

Number of
Volume
Groups

This shows the total number of configured volume groups.

Status This is the current status of the volume group. You may see one of the
following: OK, Suspended, Re-sync, Overflow, Varied Off, and Available.

Used % This is the percentage of space in the volume group which has been used
to store data.

Capacity (MB) This is the amount of disk storage configured for the volume group.

Busy % This is the average disk busy figure for the volume group. The busy figure
for an volume group can also be displayed as an element using the user
defined data bars.

Busiest PV This is the unit number of the busiest physical volumes in the volume
group.

Busiest PV % This is the disk busy figure for the busiest physical volume in the volume
group.

Installed Fixes
The Installed Fixes group displays a list of all applied fixes and their descriptions. This is available for
AIX, Linux, and VIOS systems.
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The ASP Information View
The ASP Information view is comprised of a series of groups that show a range of ASP information
for the system.

Click any of the following links to view general information about these groups.

l Auxiliary Storage Pool

l Disk Capacity

l Overflow Recovery Options

l System Overheads

l Independent ASP Information

l ASP Balancing

l Physical Disks

Disk Capacity
Disk Capacity displays the total capacity and space used for the selected ASP.

Protected storage is disk space that is mirrored, RAID protected, or checksummed. The threshold is
set for the ASP using service tools.

When the amount of storage exceeds the Threshold number, the system will send panic messages to
the system operator queue.
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Overflow Recovery Options
Overflow Recovery Options displays the actions taken by the system when an ASP fills up.

Last Recover was Successful shows whether the last recovery of the ASP was successful (whether
the system was able to fit all the excess data back into the ASP).

Continue running with ASP full only applies to the system ASP. When the system ASP fills up, the
system can be terminated if this option is set. The system can also be configured to continue running,
rejecting further requests for new storage.

The compression recovery policy displays if the ASP has compressed drives as part of its
configuration (in the above image, it does not). If the ASP has compressed drives, the value shown
controls how overflow situations are handled for this ASP:

l Post SRC and wait before overflowing: The system displays code A6xx 0277 on the front
panel and waits to see whether storage becomes available. If it does not, it overflows into the
system ASP.

l Overflow Immediately: The ASP overflows into the System ASP immediately.

l Wait Indefinitely: The system displays code A6xx 0277 on the front panel and waits until
storage becomes available. Otherwise, the user can change the compression recovery policy
to a value that allows it to overflow.

System Overheads
System Overheads displays the amount of storage permanently reserved in this ASP for various
system function.
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Data Overflowed into System is the total amount of storage that the System ASP holds, which has
overflowed from user ASPs.

Independent ASP Information
Independent ASP Information displays information on independent ASPs. The selected ASP, listed
under Auxiliary Storage Pool, must be independent before any data will appear.

The following table defines the fields found under Independent ASP Information:

Field Description

Device Name This is the name of the device description that is used to
vary the ASP on and off in this partition.

Resource Name This is the name of the ASP as it is known to the system
service tools.

Text This is a description of the ASP. it is taken by the monitor
from the device description.

Object Version This is the format in which objects are stored in this ASP.
An ASP configured to store objects in V7R2M0 format, for
instance, cannot be varied on in a partition running
V7R1M0.

ASP Status This is the current status of the ASP. The current status can
include varied off, available, failed, and so on.
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ASP Balancing
ASP Balancing displays the current status of trace and balance for the ASP.

Trace and balance are performance tools used to optimize the layout of data in an ASP. You can start
the trace function, which collects information about which objects are used the most and how those
objects are used. This information can then be used to drive a balancing of the ASP, which moves
data around to make access to that data more efficient.

The operations are performed concurrently with normal work.

Physical Disks
The Physical Disks group displays information about the physical composition of the ASP.

You can right-click a disk unit to override error information. When non-IBM disks are used, errors
are sometimes reported by the microcode when a disk is functioning normally. This function can be
used to suppress these pseudo-errors. You can override errors for a single disk, for all disks on the
selected system, or for all disks on all systems.

NOTE:
You can sort the data in the Physical Disks table by clicking on the column header.

The following table defines the fields found under Physical Disks:

Field Description

Number of Disks in ASP This is the number of logical disks in the ASP.

Number of Compressed
Disks

This is the number of disks which store information in a
compressed format.
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Field Description

Busiest Unit This is the unit number of the busiest disk during the last
sample that was taken, as well as the disk busy percentage
for that unit.

The fields displayed for Physical Disks group reflect what is in the WRKDSKSTS on your IBM i. They
are displayed within Robot Monitor for ease of use.

Override Status
This override feature should be used with caution. If you are unsure whether to use this, check with
your hardware supplier.

Select the Unit
Select the required disk unit and then right click to be presented with a context menu which will
allow you to override the status for a Selected Disk, All Disks on This System or All Disks on All
Systems:

Select the Alerts
After selecting what to override, select the alerts you would like to receive. By default, all alerts are
selected. Deselect the alerts that are no longer required.

MON3019 Status Descriptions
This section provides descriptions for the fourteen current statuses.
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The MON3019 message highlights possible problems with a disk unit in an ASP and provides the
Internal Status Code returned by the API

The current Internal Status Codes for a disk unit are:

l 0 There is no unit control value.

l 1 The disk unit is active.

l 2 The disk unit has failed.

l 3 Some other disk unit in the disk subsystem has failed.

l 4 There is a hardware failure within the disk subsystem that affects performance, but does not
affect the function of the disk unit.

l 5 There is a hardware failure within the disk subsystem that does not affect the function or
performance of the disk unit.

l 6 The disk unit's parity protection is being rebuilt.

l 7 The disk unit is not ready.

l 8 The disk unit is write protected.

l 9 The disk unit is busy.

l 10 The disk unit is not operational.

l 11 The disk unit has returned a status that is not recognizable by the system.

l 12 The disk unit cannot be accessed.

l 13 The disk unit is read/write protected.

The Storage Information View
The Storage Information view is comprised of technical information for AIX, Linux and VIOS volume
groups on a system.
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The navigation panel on the left organizes your volume groups by physical and logical volumes.

Use this panel to do the following:

l Click a physical or logical volume to see a range of technical information for that specific
volume.

l Click Physical Volumes or Logical Volumes to see an overview of all the physical and logical
volumes in the volume group.
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l Click a root volume group to see an overview of group, volume, and physical partition
information for the system.

l Click a block device to see a range of technical information for that specific block device.

Notes:

l This is available on Linux systems only.

l For Size parameter, units are measured in G for Gigabytes or M for Megabytes.
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The Box View
The Box View displays a summary of the partitions on a single box. It shows the shared processor,
dedicated processor, memory, and interactive capacity allocations for each partition in the list. The
Not Monitored or Not Assigned entry shows values that are not accounted for. This could be
because of unallocated resources or unmonitored partitions.

The amounts shown in the Box View are configured allocations. For a partitioned system, the system
takes some memory from this allocation for internal work.

Example of a Possible Box View:

Partition Shared Dedicated Memory Interactive

WA - WA - Host System 0.10 2,048 0

MO - MO - Remote
System

0.10 2,048 0

Not Monitored or Not
Assigned

15.80 0 520,192 100

Total 16.00 0 524,288 100

The Highest CPU Users View
The High CPU Users view displays a list of the jobs/processes using the most CPU. This view can be
used for IBM i, AIX, Linux, and VIOS systems.

For IBM i systems, you can double-click a job to see the Job Details. Each time Robot Monitor
fetches a detailed sample, it updates this view to display four different types of job:

l Jobs using the most CPU

l Job with the highest response times

l Jobs using the most Database CPU

l Jobs using the most CPU that are using SQL

You can configure the number of jobs collected for each category by using the MONCFG command
on the host system.

Navigating the Highest CPU Jobs/Processes Window
The Highest CPU Jobs/Processes window contains many different elements. The elements are
different depending on the operating system that is being monitored.
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The heading displays the system you are on (not included in the image above) and the date and time
of the last detailed sample. As samples are taken, the date and time automatically update.

NOTE: The date and time is set according to the clock of the system being monitored, which may
be in a different time zone.

The chart shows the division of CPU being used in various categories. Click a specific job in the list
to see the percentage of processors allocated to the partition at the time of the sample. The chart
displays this percentage in red. You can check multiple jobs at once by selecting them while holding
down Ctrl.

The arrows at the bottom of the window allow you to see previous high CPU users.

The right-click menu allows you to control what you see and do in the window. See The Right-Click
Menu for more information.

Fields for High CPU Jobs on IBM i systems:

Field Description

Rank This is the order of the job listed.

CPU This is the percentage of CPU used by the job during the
interval.

DCP This is the percentage of database CPU used by the job
during the interval.

Disk I/O This is the average number of disk operations per second
during the interval.
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Field Description

Rsp This is the response time in seconds.

Txns This is the number of transactions processed by the job
during the interval.

Nmbr, User, Job Name These are the system job identifiers.

Crnt User This is the current user of the job. When a job has switched
user profiles, the profile taken at sample time is displayed
in this column.

Function This is the function that the job performed at the time the
sample was taken.

Type This is the job type.

Prty This is the run priority of the job at the time the sample
was taken.

Started This provides the job's starting date and time data.

Total CPU This is the total number of CPU seconds used by the job
over its lifetime.

Overall CPU % This is the CPU% used by the job over its lifetime.

Fields for High CPU Processes on AIX/Linux/VIOS systems

Field Description

Rank This is the order of the process listed.

CPU This is the percentage of CPU used by the process during
the interval.

Mem This is the percentage of memory being utilized.

I/O This is the number of I/O characters written, in kb/second,
for the selected process.

RSS This is the amount of non-swapped physical memory used
by the processes during the interval.

VSS This is the amount of virtual memory used by the process
during the interval.

Threads This is the thread count for the selected process.

User This is the user running the process.

Group This is the user group that the user is a part of.

User Guide www.helpsystems.com page: 178



Systems, Groups / About Robot Monitor Views

Field Description

Crnt User This is the current user of the process.

Process ID This is the PID number.

Command This is the command that the process is executing.

State This is the process status.

• R is running,

• S is sleeping in an interruptible wait,

• D is waiting in uninterruptible disk sleep,

• Z is zombie,

• T is traced or stopped (on a signal),

• W is paging,

• X is dead,

• *NF is not found.

Pty This is the run priority of the job at the time the sample
was taken.

Started This provides the process's starting date and time data.

Total CPU This is the total number of CPU seconds used by the
process over its lifetime.

Overall CPU % This is the CPU% used by the process over its lifetime.

Job Details
Here, you can view job details, including General information, Library List, Call Stack, Open Files,
SQL Information and Spooled Files, or you can download the job log. You can also perform actions on
jobs. See Job Actions below for more information.

General Tab
The General tab displays general job details for the selected job.
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Library List Tab
The Library List tab displays the library list of a job when that job is active. If the selected job is not
active, the library list tab will not be shown.

Call Stack Tab
The Call Stack tab displays the call stack of a job when that job is active. If the job is not active, the
call stack tab will not be shown.
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Open Files Tab
The Open Files tab displays the list of open files for the job.

SQL Information Tab
The SQL Information tab displays the last run sql statement of a job. If the last run sql statement is
not available (e.g. if a job hasn’t run an SQL statement), the sql tab will not be shown. This can help
troubleshoot possible SQL performance issues.
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Spooled Files Tab
The Spooled Files tab displays the list of spooled files available for the selected job.

To view and print or export the spooled files:

1. Double-click the spool file you would like to open. The spool file will display on the screen.

2. To print the file, select File -> Print from the Robot Monitor main menu.

3. To export to a .csv or .txt file, select File -> Export from the Robot Monitor main menu. You
can then choose between exporting to CSV or exporting to Text.

Downloading the Job Log
To download the job log:

1. Click the job log icon in the upper-right corner of the screen.

2. Use the Search text box to search for a specific log item, or refresh to see newer job log items.

Job Actions
The following actions are available for the selected job.

NOTE:You must be logged in and have the necessary authorities on your login to run these
actions.

User Guide www.helpsystems.com page: 182



Systems, Groups / About Robot Monitor Views

l Selecting an action will bring up the standard command prompt, allowing the you to modify
and confirm the command.

l The Send Reply option will only appear if the selected job is waiting for a message reply.

Send Reply
You can reply to a message using the send reply (sndrpy) command.

1. Click Send Reply in the Actions menu.

2. Change the values in the displayed editable command parameters as desired.

NOTE: Select Keywords to see all the command keywords and select All Parameters to
view all available command parameters.

3. Click OK.

Change
You can update the job attributes using the change job (chgjob) command.
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1. Click Change in the Actions menu.

2. Change the values in the displayed editable command parameters as desired.

NOTE: Select Keywords to see all the command keywords and select All Parameters to
view all available command parameters.

3. Click OK.

Hold
You can hold a job using the hold job (hldjob) command.
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1. Click Hold in the Actions menu.

2. Change the values in the displayed editable command parameters as desired.

NOTE: Select Keywords to see all the command keywords and select All Parameters to
view all available command parameters.

3. Click OK.

Release
You can release a job using the release job (rlsjob) command.
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1. Click Release in the Actions menu.

2. Change the values in the displayed editable command parameters as desired.

NOTE: Select Keywords to see all the command keywords and select All Parameters to
view all available command parameters.

3. Click OK.

End
You can end a job using the end job (endjob) command.
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1. Click End in the Actions menu.

2. Change the values in the displayed editable command parameters as desired.

NOTE: Select Keywords to see all the command keywords and select All Parameters to
view all available command parameters.

3. Click OK.

The Right-Click Menu
When you right-click the Highest CPU Jobs/Processes view, a context menu displays. This menu
provides a list of options you can select or configure for the current view. The menu differs
depending on the operating system that is being monitored.

For IBM i Systems
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Scale CPU Percentage

Scales CPU to the number of configured processors. The range when scaled is normally 0-100%, but
it may be exceeded if capacity on demand is used for the partition.

Show Worst Response Times

Changes the Highest CPU Jobs view to show the jobs with the highest response times for the current
system.

Show Highest I/O Jobs

Changes the Highest CPU Jobs view to show the highest Disk I/O jobs for the current system.

Show High CPU Users using SQL

Changes the Highest CPU Jobs view to show the jobs running SQL that are using the most CPU for
the current system.

Work with Job

Opens the Job Details screen for the selected job.

WrkJob for User

Opens the List of Jobs for User screen for the selected job. Here, you can view the list of jobs with
the same user as that of the selected job.

WrkJob for Name

Opens the List of Jobs Named screen for the selected job. Here, you can view the list of jobs with
the same name as that of the selected job.
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Who's This?

Displays the profile of the user of the selected job.

For AIX/Linux/VIOS Processes

Scale CPU Percentage

Scales CPU to the number of configured processors. The range when scaled is normally 0-100%, but
it may be exceeded if capacity on demand is used for the partition.

Show Highest I/O Processes

Changes the Highest CPU Jobs view to show the highest disk I/O processes for the current system.

Show Highest Memory Processes

Changes the Highest CPU Processes view to show the highest memory processes for the current
system.

Who's This?

Displays the profile of the user of the selected job.
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The Highest CPU Users View

Using the Auto-Export Panel
The Auto-Export function creates an image of a specified group each time it receives an update from
the host system.

In order to use this feature, Robot Monitor must be running, and the selected group must be open to
capture the image. Auto-Export settings are retained from one run of Robot Monitor to the next, so
the Auto-Export function will resume whenever you restart.

Setting up Auto-Export
Follow these steps to set up Auto-Export for a group.

1. Right-click the group you want to set up and select Auto-Export.

2. On the Auto-Export panel, enter a File Name.

3. Click Browse to choose a save location for the Auto-Export. If no path is specified, the file
will be created in the MSM data directory.

4. Select Active if you want to activate Auto-Export for the selected group. This will ensure the
group image updates automatically.

5. Enter a title to include in the exported image. Note: This is not required.

6. Choose how you want to size your image:

l Enter a width and height for the image. Note: The measurements are specified in pixels.

l Alternatively, click Current Size to set the width and height fields to the current size of
the selected group.

7. Select whether the image should be saved as a bitmap or JPEG.

8. Click OK to export the group to your PC.
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The Item Selection Sidebar
The item selection sidebar allows you to add an item to your current view. You can access the
sidebar by clicking Item Selection in the upper right corner.

The sidebar is only available for the following views: The Monitor View, The Detailed History View,
The Short-Term History View, The History Summary View, The Disk Summary View, and The
Accounting Summary View.

To add a new item to your current view, click and drag it from the sidebar onto the open window.
You can choose to add an entire group or a single item from the group to your view.

You can also create new items to monitor on your system. Click Monitor something new to define a
new select to monitor on the IBM i. Note: To do this, you must be logged in and have the authority
to add new data definitions.
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Threshold Activity
These topics describe general information about threshold activity in Robot Monitor.

Click one of the following links to learn more about the topic.

l Current Thresholds

l The Threshold Log

Current Thresholds
The Current Thresholds view displays all currently active thresholds, their systems, and their
descriptions.

Click a column header to sort the list in ascending/descending order. You can also double-click a
threshold entry to open the group that the element with the threshold is in.

New thresholds descriptions are shown in red. Once they are acknowledged, the descriptions will
turn black.

l To acknowledge your current thresholds, right-click one and select Acknowledge All.

l If you want to reset an acknowledgment for a threshold, right-click it and select Reset
Acknowledgment. This will turn the description back to red.

If you want to print a threshold, right-click one and select Print.

The Threshold Log
The threshold log displays a list of all threshold events that triggered since Robot Monitor was
started.
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Each time a thresholds detailed record is selected for an element, an entry is written to the log.
Whenever the selection returns to the default entry on the threshold list, a threshold reset event is
also logged.

Right-click anywhere in the view to change the font of the log or save it as a text file to your PC.
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Configuration
These topics describe general information about the configuration settings and options in Robot
Monitor.

Click one of the following links to learn more about the topic.

l The Data Definitions View

l The Thresholds View

l The Calendar Configuration View

l The SST Configuration View

The Data Definitions View
NOTE: The Data Definitions View is accessible from the Configuration section of the Views menu.
If it is not visible, you can reach it by logging in to Security via the Authority Logon.

The Data Definitions view displays all defined elements for Robot Monitor, including the element's
description, element type, the systems on which the data is collected, and the parameters specified.

Use the Filter drop-down to limit the display to elements of a particular type, or use the Search field
to display elements by description.

Use the Group By drop-down to limit the display by System or Type.

Things You Can Do
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l Right-click an entry and select Properties to view the Data Description screen on the Data
Definition panel for that element. You can use this screen to edit the element's definition or
add thresholds.

l Right-click an entry and selectWhere Used to open the Groups Containing X panel, where X is
the name of the element selected.

l Right-click an entry and select Delete to remove an element from the list. This deletes the
definition, and detail and historical information will be marked for removal from Robot
Monitor the next time a purge is run.

l Right-click one or more entries and select Export to Preset Elements File to export your
selections to an elements file (.rmpreset).

l Click Import Preset Elements in the upper right corner to import a predefined set of
definitions or a custom set of element definitions (.rmpreset file). See Importing Preset
Elements for more information.

l Click Monitor something new in the upper right corner to create a new element. See Creating
an Element for more information.

l Go to File > Export to export the current view to a CSV file. See Export for more information.

Data Definition Panel
The Data Definition panel allows you to specify the attributes of a data element.

To access this panel, open the Data Definitions view, right-click a description, and select Properties.

There are several tabs in this panel that can be used to change element attributes.

The following table describes the tabs you may see in the Data Definition panel, depending on the
view and type of element currently selected.
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Tab Description

Data
Description

Displays the Data Description screen, allowing you to specify basic
attributes for the element such as the description and default scaling.

Data
Collection

Displays the Data Collection screen, allowing you to specify the element
type and any parameters required for the collection job.

User Data
Collection Job

Displays the User Data Collection Job screen, allowing you to specify a
job to collect data for user defined data and text items. A job specified
here will run on all systems.

Global
Threshold

Displays the Global Threshold (All Systems) tab on the Default Thresholds
screen, allowing you to select or edit the default threshold for this
element.

Local
Threshold

Displays the Local Threshold (All Systems) tab on the Default Thresholds
screen, allowing you to select or edit a threshold for this element that is
only used on the local PC.

Presentation
in this Group

Displays the Presentation in this Group screen, allowing you to determine
how this element is displayed when added to a group.

Data Description Screen
The Data Description screen, accessed through the Data Definition panel, allows you to specify basic
attributes for an element.
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Fields and Descriptions
The following lists the fields in this screen and their descriptions.

Description

Specify a short and long description for the element if required. Leaving this entry blank will cause
Robot Monitor to assign the element a default description.

Unit Description

Specify a short and long unit description for the element if required, such asMB, Seconds, or Percent.
Leaving this entry blank will cause Robot Monitor to assign the unit a default description.

Graph Title

Specify the title that should be used whenever this element is graphed. Leaving this entry blank will
cause Robot Monitor to assign the graph a default title.

Y Axis Description

Specify a description to be used for the Y axis whenever this element is graphed. Leaving this entry
blank will cause Robot Monitor to assign the Y axis a default description.

Default

Click Default to assign all description fields with a default description.

Decimals

Select the number of decimal places for this element from the drop-down.

If you want Robot Monitor to decide where the decimal place should go based on the magnitude of
the number, select Automatic.

Scaling

Enter the maximum expected that should be allowed when the element is displayed as a bar or line
graph.

Certain data types determine their own scale if this value is left at 0:

l Current Memory (CRM): Maximum memory for partition

l Current Processors (CRP): Maximum processors or maximum shared processors for this
partition

l ASP Free: Asp size

l ASP Used: Asp size

l Pool Size: Current Memory (CRM)

l Pool Reserved Size: Current Memory (CRM)

Automatically Adjust
Select this option to allow the maximum scaling value to increase when graphed elements exceed
the entered value.

Authority List

Select an Authority List for the element. This authority list is assigned, by default, to any objects
added to this element.
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Data Collection Screen
The Data Collection screen, accessed through the Data Definition panel, allows you to define
Configurable Elements. Each element has a type, a system selection, and one or more parameters.

Fields and Descriptions
The following lists the fields in this screen and their descriptions.

Monitor Type

Select the Monitor Type you want to create from the drop-down list. Each monitor type has
different parameters associated with it.

NOTE:Once an element is created, the monitor type cannot be changed.

Filter

Use the Filter to limit the entries in the Monitor Type drop-down by class.

System Name

Select the systems you want to define this element for, or click All Systems to define this element
for all systems.

Parameters and Values

Most element types require parameters to function. Those parameters are listed here. You can add
values to most parameters.
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Prompt

Select which system should be used for prompting values from the drop-down. When you prompt for
values that exist on the host system, Robot Monitor will fetch the list from the prompt system
specified.

Collection Frequency

This option only displays for some data types.

Enter a numerical value to control how often the collection is performed. For example, if you set the
collection frequency to 6 and the detail collection interval is set to 30 seconds, this item will be
measured every three minutes (or every six collections).

Adding Values to Parameters
There are two ways to add values to a parameter. You can enter them manually or select them from
a list of possible values generated by the prompt system.

Entering Values Manually
Although it is usually easier to prompt and select a value from the list, you can enter values directly
by highlighting the parameter you want and pressing Insert.

Type in a value, then press Enter to save your changes.

Prompting Values
Most parameter types support prompting. To prompt a value, right-click the parameter. Robot
Monitor will fetch the list from the prompt system (if required) and display a list of possible values.

For elements with library or type parameters, you must specify the library name and object type
before prompting the object name.
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To limit the list of values, you can specify a generic for the parameter using manual entry. For
example, enter A*, *A*, or *A as a value and then right-click, and the prompt system will only display
values that start with A, have an A in the middle, or end with A.

You can also enter a quick generic search. To do this, click a parameter and press the first letter of
the value you are looking for. The prompt system will quick display all values beginning with that
letter.

Special Parameter Values
There are special parameter values available, depending on the parameter. They appear at the top of
the list.

Refresh
Robot Monitor keeps all prompt lists cached in two places: the host system (which caches lists
fetched from remote systems) and your local PC (which keeps cached lists in a file on the disk).

If you prompt from the host system and someone else has prompted the same specification since the
last time Robot Monitor was started, the information is taken from its cached lists. If you prompt
something you have prompted before on your PC, the information is taken from the local cache.

Selecting Refresh forces Robot Monitor to bypass the caches and fetch the list from the prompt
system again. This ensures the data you are presented is valid and up-to-date.

*ALL
When *ALL is available for a parameter, you can create a single element that monitors all
occurrences of an object.
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In the image above, we set Job Queue for the monitor type Job Queue Count to *ALL. This creates
an element that returns the total number of jobs waiting on queues in QGPL. It will not, however,
create an element for each job queue in QGPL. To do this, you need to selectMultiple (see the
section below) and then select all values.

Multiple
WhenMultiple is available for a parameter, you can create multiple elements in a single operation.
You can only set Multiple as a value for one parameter.

When you create multiple elements, the short description is assigned from the varying parameter
rather than from the element type.

When you set Multiple as a value for a parameter, the Multiple Values for Parameters panel displays.

Previous Value (F2)
If you want to use the same value as last time for a parameter, right-click to prompt. The last value
chosen for that parameter will display at the top of the list.

In the image above, the last value selected for the particular parameter was MAINDW, so this value
is at the top of the list and can be quickly selected. You can also repeat the previous value by right-
clicking the parameter and pressing F2.
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User Data Collection Job Screen
The User Data Collection Job screen, accessed through the Data Definition panel, allows you to
specify jobs to run on select systems whenever Robot Monitor starts.

NOTE: This screen is only available for user supplied items.

The purpose of the User Data Collection Job screen is to run a job that collects data for a user text
or user data item and periodically updates the item using the MONAPUPD API. User text and user
data items can be used to include application data with performance data or collect types of data not
supposed by the automatic data collectors in Robot Monitor.

A collect job is required for each user supplied value.

Fields and Descriptions
NOTE:A 'Refresh' option is at the top of the list of all drop down fields on the User Data
Collection Job screen. If necessary, use 'Refresh' to update the drop down list from the system
to display any updated or added data.

The following lists the fields in this screen and their descriptions.

Job Queue

Enter the name of the job queue and library to which the job is submitted when Robot Monitor
starts.
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Job Description

Enter a name and library for the job description to be used when Robot Monitor submits the
collection job.

User Profile for Submitted Job

If the collection job needs to run under a special profile, enter the profile name here.

NOTE: If a value other than *CURRENT is specified, the user will need to be authorized to the
profile or the submit will fail.

Command Type

Select whether you want the command type to be CL or SQL.

Validate

Click Validate to ensure that the command that is in the Command field is valid.

Prompt

Click Prompt to prompt the command. For this to work, Operations Navigator must be installed with
the command option. You will be prompted to sign on to Operations Navigator if required, although
Robot Monitor will do its best to configure and sign on to the system automatically.

The server job for the prompt function only has the system default library list. If your command is
not in QSYS or QGPL, you will need to qualify it before clicking the command button.

If you are not sure which command you want, type a few letters and an asterisk (WRKA*, for
example), then click Prompt. The prompter will display a list of commands to choose from that start
with those letters.

Reset

Click Reset to clear the command and reset any other parameters to their default values. The default
values for these parameters are the values from the last added or updated record.

NOTE:Clearing the command removes the configuration for this job from the system.

Command

Type a command into the Command text box. This command is submitted to collect data. The
collection needs to know the number of the item to be updated; this can be passed as a parameter,
or the program can retrieve it from the first 3 bytes of the LDA.

Default Thresholds Screen
The Default Thresholds screen, accessed through the Data Definition panel, displays the thresholds
for the selected element. You can access this screen for all systems under Global Threshold, or for
your current system under Local Threshold.
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Things You Can Do
l Double-click a threshold entry to edit its threshold detail record.

l Right-click and select Add from the menu to create a new entry for the threshold list. This
opens the Threshold Detail Record panel.

l Right-click and select Copy from the menu to copy the threshold's existing settings and create
a new one.

l Right-click an entry and select Delete from the menu to remove the threshold from the list.

Options and Descriptions
The following lists the options on this screen and their descriptions.

Description

Enter a description for the threshold list. Useful descriptions for your own threshold lists might be
Communications Status Expecting to be Varied Off or Response Time for Production Systems.

Authority

Select an authority list that defines which users can alter the threshold definitions.

NOTE: Robot Monitor security must be activated.
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Number of samples

When a number is specified, Robot Monitor uses the calculation type to determine the average of a
value before testing it against the threshold. This is useful for smoothing out threshold checks on
values that can spike on single collections.

Calculation type

When the Number of Samples field (N) is greater than 1, the calculation type can be any of the
following:

Type Description

Average The average of the last N values.

Delta The difference between this sample and the one N samples ago.

Minimum The lowest value from the last N samples. For example, the value must have
been above the threshold level for at least N samples to trigger.

Maximum The highest value from the last N samples. For example, if any value in the
previous N samples were above the threshold level.

Enabled for speech

This is checked by default and allows Robot Monitor to speak when the threshold triggers.

Replace all values with defaults

Click Replace all values with defaults to replace the current threshold values with the default
threshold list values for the data type of the element being edited.

Import values from file

Click Import Values From File to select a file containing previously exported values. You can use this
file to replace the current threshold values.

Export values to file

Click Export Values To File to export the current threshold values to a file. You can save this file on
your PC and use it to replace existing values at a later date.

Add value

Click Add Value to create a new entry for the threshold list. This displays the Threshold
Detail Record panel.

Clear

Click Clear to completely remove a threshold at this level.

NOTE: This option is not available for global thresholds.

New global

Click New Global to create a new global threshold list and assign it to the current level.
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New local

Click New Local to create a new local threshold list and assign it to the current level.

NOTE: This option is not available for global thresholds.

Create a copy

Click Create a Copy to copy the current threshold list and create a new one using its settings. Copied
lists are assigned to the current level.

Select a list

Click Select a List to select an existing threshold list and use it to replace the current one.

Threshold Detail Record Panel
The Threshold Detail Record panel, accessed from the Default Thresholds screen, displays a
threshold and lets you change its properties.
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For more information on how thresholds work, see About Thresholds.

Options and Descriptions
The following lists the options on this screen and their descriptions.

Value

Enter a value for this entry to select the threshold record for an element.

The first record found with a value equal to or less than the current value of the element will be
triggered.

Preset

Select which preset you want to use for the threshold detail record. You can select Neutral, Warning,
Critical, Down, Positive, or User Defined.
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Severity

Assign a severity to the record. The higher the number, the worse the situation is. Robot Monitor
uses the severity to make decisions, such as which threshold to display when multiple thresholds are
selected in a group and which elements to display when filtering is being used.

Color: Select a color to be assigned to the element whenever this record is triggered.

Default Color: Select Default Color if you want Robot Monitor to ignore the selected color
and use the color from the default view instead.

Make the item flash

Choose whether or not you want the element to flash when this record is triggered. You can also
specify the speed of the flash.

Icon

NOTE: The icon option is only available if you specified User Defined as your preset above.

Select an icon to be used as the summary icon. This icon displays on the Monitor view whenever this
record is triggered.

Click Add Icon to add a user defined icon from your PC to the set of icons available.

User defined icons are stored on the iSeries and are available to all PCs automatically.

Sound Alarm

Select Sound Alarm if you want the default sound to go off whenever this record is triggered.

NOTE: For the sound to play, "Play Threshold Sounds" under Options in the File menu must be
enabled.

Repeat Alarm

Select Repeat Alarm if you want the default sound to repeat. Otherwise, the sound only plays when
this record is first triggered.

Send Message on iSeries

NOTE: This is only valid at global levels.

When Send Message on iSeries is selected, and this record is triggered, the monitor program on the
iSeries describes the problem by sending message MON0079 (Threshold Reached) from message
file MONMSGF to message queues MONTHR and MONTHRLC. This is then picked up by Robot
Monitor and used to escalate procedures, paging, or automated recovery.

When a different threshold is triggered that does not have this flag set, message MON0179
(Threshold Reset) is sent. When a different threshold record is triggered that does have this flag set,
MON0379 (Threshold Change) is sent.

The host system has two message queues: MONTHR and MONTHRLC. MONTHR receives messages
for all systems being monitored and can control centralized escalation and paging. MONTHRLC has
messages only for the local system. If a threshold message is sent to the host system, it is sent to
both MONTHR and MONTHRLC.
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Remote systems have only MONTHRLC. These queues receive threshold messages for the local
system only and are cleared when Robot Monitor starts up. If they become full, they are set to wrap.

Summary of threshold messages sent:

MON0079 - Threshold Reached: A threshold has been reached with the Send Message flag
set.

MON0179 - Threshold Reset: A threshold record has been selected that does not have the
message flag set, and a message had been issued.

MON0279 - Threshold Repeat: The same threshold record as last time was selected, which
had the repeat flag set.

MON0379 - Threshold Change: The threshold selection changed from one record with Send
Message set to another.

Repeat Message

Select Repeat Message to send MON0079 (Threshold Reached) the first time this record is triggered
and MON0279 (Threshold Repeat) each subsequent sample on which the same record is triggered.

Short/Long Translation

Enter a description that describes the condition this record is testing for.

The short description is used on element labels, and the long description is used in tip windows and
for speech.

Threshold descriptions can be entered as template strings. Click Variables to view a list of supported
variables in the GUI.

Sound

Select a sound file from the drop-down to be played whenever this record is triggered.

NOTE: For the sound to play, "Play Threshold Sounds" under Options in the File menu must be
enabled.

Add Sound

Click Add Sound to add a new sound file from your PC to the set of sounds available.

Sound files are stored on the iSeries and are available to all PCs automatically.

Send to Robot Alert Device

Select a configured Robot Alert device from the drop-down. If a device is specified, the user will
receive a message on their device every time this record is triggered.

Click Refresh List to refresh the list of configured Robot Alert devices.

NOTE:You cannot send an alert to a Robot Alert Device within local thresholds.

Set Robot Network Status

Select a Robot Network status from the drop-down. You can choose Informal, Warning, or Attention.
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NOTE: For threshold statuses to escalate to Robot Network, you must first create a user
application in Robot Network.

To receive Robot Monitor status escalation messages in Robot Network you will need to
create a User Application.

1. Connect to and expand the Host system in Robot Network.

2. Right click User Applications and select New.

3. Enter MONITOR for the Name and add a description. The Library you should use is
QGPL.

4. Click OK.

5. Next, expand the nodes.

6. Right click the node and select Properties.

7. Select the Product Statuses tab.

8. On the MONITOR row, check 'Attention', 'Warning', and 'Informational' depending on
what level you want to be notified of in the status center.
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9. Click OK.

Presentation in this Group Screen
The Presentation in this Group screen, accessed through the Data Definition panel, allows you to
specify how elements should be displayed within a group.
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Fields and Descriptions
The following lists the fields in this screen and their descriptions.

Decimals

Type the number of decimals that should be used when displaying a numeric value, or choose an
option from the drop-down.

If the value Automatic is selected, Robot Monitor will make a decision for you based on the
magnitude of the number shown.

Scaling

Enter the maximum value that should be allowed when scaling a group as a numeric value.

Automatically Adjust: Select this option to increase the maximum scaling value when a group
value exceeds the current scale value.

Default: Select this option to share the scale value between all instances of a group.

Force Numeric

Select this option to always display a numeric value as part of the label. This is different from the
usual behavior in text groups, where the translated value is generally displayed.

Include Value

Select this option to have the item contribute to its parent value. Otherwise, the item value will be
ignored in any sum, average, minimum, maximum, or maximum severity calculations.
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Presentation (Text groups only)

Choose the presentation for a text group. This only applies to numeric values.

Block: This is the default value. When chosen, the item is displayed as a single area of color
with a label determined by the selected label template.

Bar:When chosen, items are displayed with a horizontal bar behind the text, showing the
magnitude of the current value.

Histogram:When chosen, items are displayed with a histogram behind the text, showing the
current value and a certain amount of history.

Line:When chosen, items are displayed with a line graph behind the text, showing the current
value and a certain amount of history.

Label Template

This field determines how text is displayed for the elements in a group. Label templates are often
used in text groups to change the description and include the value and threshold translation for
elements.

If the label template field is left blank, it inherits a template from the closest ancestor that has one
specified. If no template is found, a bar group will use the default value of &d for a single system
view or &s for a multiple system view. A text view will use &d &t for a single system view or &s &d
for a multiple system view.

See the section on Label Templates below for a list of variables you can use or click Variables to
display the descriptions in the GUI.

Label Templates

Label templates are entered as template strings. The variables that can be used are as follows:

Variable Value

&d Short description of element or group

&D Long description of element or group

&t Short description from threshold

&T Long description from threshold

&u Unit Description

&U Long Unit Description

&v Value

&S System name

&s Short system name

&1...&99 Parameters 1-99 from the data collection definition

&p All parameters from the data collection definition
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Variable Value

&y Type of check, abbreviated (built in, output queue status, and so on)

&Y Type of check, full

Data Definitions: Where Used
From the Data Definitions view, you can right-click an element and selectWhere Used to see which
groups contain the element, and on which systems.

Importing Preset Elements
The import preset elements functionality allows you to import predefined element definitions (Robot
HA) or to import your own custom element definitions via a defined (.rmpreset) file. The imported
elements will then be available for you to monitor.

To add Robot HA elements to monitor
1. Click the Import Preset Elements button on the Data Definitions screen.

2. On the Import Preset window, ensure that 'Robot HA' is selected in the Preset drop-down.
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3. Select the Robot HA System or Systems.

4. Click Expand All to see all the available elements.

5. Select the elements you would like to monitor.

6. Click OK.

You can now add these Robot HA elements to your views and dashboards. See Views for more
information.

To add custom elements to monitor
1. Click the Import Preset Elements button on the Data Definitions screen.

2. On the Import Preset window, ensure that 'custom' is selected in the Preset drop-down.
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3. Select the System or Systems.

4. Click Expand All to see all the available elements.

5. Select the elements you would like to monitor.

6. Click OK.

You can now add these elements to your views and dashboards. See Views for more information.

The Thresholds View
NOTE: The Thresholds View is accessible from the Configuration section of the Views menu. If it
is not visible, you can reach it by logging in to Security via the Authority Logon.

The Thresholds view displays all thresholds available in Robot Monitor, including the threshold's
description, type, and settings.

Use the Filter drop-down to limit the display to thresholds of a particular type, or use the Search
field to display thresholds by description.
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Things You Can Do

l Right-click a threshold and select Change to open the Default Thresholds screen.

l Right-click a threshold and selectWhere Used to open the Where Used panel.

l Right-click a threshold and select Delete to delete it.

l Select Include Global or Include Local to include all global and all local thresholds in the view.
Clear either to remove those thresholds from the list.

About Thresholds
Correct use of thresholds is vital to the idea of grouping and summarizing monitored elements.
Although they are called thresholds for historical reasons, it may be better to think of a threshold as
a translator. For some data types that have discrete values (such as subsystem status), this is their
only function.

Every element has a threshold list attached. The threshold list is used to assign attributes such as
color, sound, and an icon to an element.

An important attribute assigned by thresholds is Severity. Each record on a threshold has a severity
field and is assigned a numerical value, typically 1-99 (although higher numbers can be used). When
a group of elements has a number of problems, the one with the greatest severity is usually
displayed at the summary level.
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Severities can also be used for sorting elements or limiting the number of elements shown in a
group.

Global and Local Thresholds
Thresholds can be assigned to elements at various levels. These levels can be any of the following:

l Threshold for this Group

l System Local

l System Global

l Default Local

l Default Global

There are two types of thresholds that can be assigned to elements: global thresholds and local
thresholds.

Global Thresholds are stored on the iSeries and are available to all systems across all PCs. Normally,
global thresholds attached to the element definition are the thresholds being used on all PCs.
Globally defined thresholds can also be attached to elements at the global or local level.

Local Thresholds are stored on a PC and are only available to that PC. They are used when you want
to change or remove a threshold from your own PC without affecting other users. Locally defined
thresholds can only be attached to elements at the local level.

EXAMPLE:
You might have an element monitoring Order Entry Response Time, which has a threshold
attached to it that rings alarms when the figure exceeds 2 seconds. This is the point when the
operators should start investigating, so you do not want to change the way this is processed for
them.
However, you are personally not interested until it reaches 4 seconds, which is the maximum
allowed by the SLA.
In this case, you would create a new threshold and assign it as the local threshold for Order
Entry Response Time.

Default Thresholds and System Overrides
The other two main differences in threshold assignments are the default and system levels.

A threshold assigned at the default level will affect an element on all systems for which it is defined.
This can be overridden for specific systems, however, using system overrides.

Suppose you have an element monitoring Order Entry Response Time, which sets off an alarm when
the value exceeds 2 seconds. This is fine for most of your systems, but on system ZEUS, the SLA
requires a response time of one second or better. In this case, you would create a global threshold
specifying one second as the upper limit and assign it to the Order Entry Response Time element at
the system level for system ZEUS.

Threshold Entries
The following sections discuss some concepts that apply to threshold entries.
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The Default Entry

Every threshold list has a default entry. This entry cannot be deleted. The attributes from the default
entry are used when no match is found in the detail entries.

The description for the default entry on the threshold detail panel is (No Threshold).

Detail Entries

Detail entries form a list of values. Together, they make up a list of ranges. They can be used to
assign color, sound, icons and movement to conditions.

Creating and Copying Thresholds
You can create a new threshold or copy an existing threshold to apply to an element.

Creating a New Threshold

Follow these steps to create a new threshold.

1. Open the Data Definitions view under Configuration in the Views Menu.

2. Right-click the element you want the threshold to apply to and select Properties.

3. On the Data Definition panel, click the tab for the type of threshold you want to create. You
can create a Global Threshold or a Local Threshold.

4. On the screen for the tab you selected, click New Global to create a global threshold or New
Local to create a local threshold. A new threshold with no entries is created and attached to
the selected element.

NOTE:Only global thresholds can be created at the Global Threshold level.

5. Enter the required attributes for the new threshold (see Default Thresholds Screen for more
information).

6. Add new threshold detail records, if necessary.

7. Click OK to save.

The new threshold can be found in the list in the Thresholds view.

Copying an Existing Threshold

Follow these steps to copy an existing threshold.

1. Open the Data Definitions view under Configuration in the Views Menu.

2. Right-click the element you want the threshold to apply to and select Properties.

3. On the Data Definition panel, click the tab for the type of threshold you want to create. You
can create a Global Threshold or a Local Threshold.

4. On the screen for the tab you selected, click Create a Copy to open the Threshold List panel.

5. Select the threshold you want to copy, then click OK. A new threshold, copied from the
selected one, is created and attached to the selected element.

NOTE:Only global thresholds can be copied and created at the Global Threshold level.
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6. Enter the required attributes for the new threshold (see Default Thresholds Screen for more
information).

7. Add new threshold detail records, if necessary.

8. Click OK to save.

The new threshold can be found in the list in the Thresholds view.

Editing Thresholds
Follow these steps to edit an existing threshold to apply to an element.

1. Open the Data Definitions view under Configuration in the Views Menu.

2. Right-click the element you want the threshold to apply to and select Properties.

3. On the Data Definition panel, click the tab for the type of threshold you want to edit: Global
Threshold or Local Threshold.

4. On the screen for the tab you selected, right-click an existing threshold and select Change
from the drop-down. You can change any of the values in the Threshold Detail Record panel.

5. When you are finished with your changes, click OK to save them.

Deleting Thresholds
You can delete thresholds from the Thresholds view.

To delete a threshold from the Thresholds list, right-click it and select Delete. You can select
multiple thresholds to delete by holding down Shift.

NOTE:Before deletion, Robot Monitor checks to make sure the threshold is not being used on the
local PC. Care should be taken when deleting global thresholds, as they may be in use on other
PCs. When you delete a global threshold, you delete it for everyone.

Assigning Threshold Lists to Elements
In order for thresholds to be useful, they need to be attached to one or more elements.

Assigning a Threshold to an Element or Group

Follow these steps to assign an existing threshold to an element or group.

1. Right-click the element or group to which the threshold applies and select Properties.
Depending on whether you have selected an element or group, the Data Definition or Group
Properties panel displays.

2. Select a tab to open the threshold level you want. You can choose Global Threshold or Local
Threshold.

3. Click Select a List. This opens the Threshold List panel, which displays a list of thresholds of
correct type for the selected element or group.

4. Select an entry, then click OK.

5. Click OK again to save.

User Guide www.helpsystems.com page: 220



Configuration / The Thresholds View

Assigning a Threshold to Many Items at Once

Follow these steps to assign a threshold to many items at once.

1. Select the elements you want to assign a threshold to by holding down Shift. You can Control-
click an element to remove it from the selection.

2. Right-click and select Properties.

3. Select a tab to open the threshold level you want. You can choose Global Threshold or Local
Threshold.

4. Click Select a List. This opens the Threshold List panel, which displays a list of thresholds of
correct type for the selected element or group.

5. Select an entry, then click OK.

6. Click OK again to save.

Threshold List Panel
The Threshold List panel displays global and local thresholds that you can select. You can access this
panel by creating a copy of an existing threshold.

Normally, only thresholds that match the selected data element are displayed. However, if you clear
Selected Type Only, other defined thresholds display in the list.
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Threshold Selectors
Threshold selectors are special threshold lists that allow threshold lists to be selected based on a
calendar.

Creating Threshold Selectors
When selecting which threshold list to use for an element, you can choose to create a threshold
selector and apply it to the list.

1. Open Data Definitions under Configuration in the Views Menu.

2. Right-click the element you want the threshold to apply to and select Properties.

3. On the Data Definition panel, click the tab for the type of threshold you want. You can choose
Global Threshold or Local Threshold.

4. From the Global Threshold or Local Threshold tabs, click Select a List. This opens the
Threshold List panel.
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5. Click Create Threshold Selector to create a new threshold selector. This opens the Threshold
Selector panel.
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6. Click Add to add a threshold selector to the threshold list. The Threshold Selector panel
displays.

7. Select a calendar from the drop-down. This calendar determines whether or not to use the
selected threshold list.

8. Select a threshold list from the drop-down. This threshold list will be used when the selected
calendar is available. Note: If you need to edit the chosen threshold list, click Edit.

9. Click Selected Type Only if only threshold lists of the selected type should be shown in the
Threshold List field.

User Guide www.helpsystems.com page: 224



Configuration / The Calendar Configuration View

10. Click OK twice to add the threshold selector to the threshold list.

11. Click the selector you just created, then click OK to add it to the Global Threshold for the data
definition you have selected.

Thresholds: Where Used
From the Thresholds view, you can right-click an threshold and selectWhere Used to see which
elements contain the threshold, and on which systems.

The Calendar Configuration View
NOTE: The Calendar Configuration View is accessible from the Configuration section of the Views
menu. If it is not visible, you can reach it by logging in to Security via the Authority Logon.

This Calendar Configuration view displays all calendars and calendar rules configured in Robot
Monitor.

There are two tabs in this view: Calendars and Calendar Rules.

The Calendars tab lists all the calendars currently configured in Robot Monitor.

Things You Can Do

l Right-click and select Add from the menu to create a new calendar.

l Right-click a calendar and select Delete from the menu to remove it. When prompted, click
OK.

l Right-click a calendar and select Properties to edit the calendar settings.

l Right-click a calendar and selectWhere Used to open the Where Used panel.

The Calendar Rules tab lists all the calendar rules currently configured in Robot Monitor.
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Things You Can Do

l Right-click and select Add from the menu to create a new calendar rule.

l Right-click a calendar rule and select Delete from the menu to remove it. When prompted,
click OK.

l Right-click a calendar rule and select Properties to edit the calendar rule settings.

l Right-click a calendar rule and selectWhere Used to open the Where Used panel.

Adding a Calendar
You can add a new calendar from the Calendar Configuration view. Follow these steps to create one.

1. If you are not on the Calendar Configuration view, click Calendars under the Configuration
section in the Views Menu.

2. On the Calendars tab, right-click anywhere and select Add. The Calendar panel displays.
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3. Enter a Calendar Name. The name is used as a reference when assigning the calendar to a
threshold selector.

4. Enter a short description for the calendar in the text field next to the calendar name.

5. Select which rules you want to assign to the calendar and click Add to add the calendar rule to
your calendar. Also, you can click Remove to remove the rule from your calendar. You can
select more than one by holding down Shift. Once they are selected, you can change the
position of each rule by using the Move Up andMove Down buttons.

Note: The rules added in this step determine the dates and times on which a threshold within
a threshold selector is available. See Adding Calendar Rules for more information.

6. (Optional) Set a Rule Action. Highlight a rule and use a rule action to set it to default, include,
or exclude.

7. Select the Available by default checkbox if you want the calendar to be available even when
no rules are assigned. This assigns rules to determine the times when the threshold should not
be used.

If left unchecked, the calendar will be unavailable when no rules are assigned. You can then
assign rules to determine the times when the threshold is selected in a threshold selector.

8. Preview your calendar. You can see what your calendar will look like before you save by
clicking on the Preview tab. The previewed calendar displays the duration of the rule(s) added
as a green line in the calendar. All other times not encompassed by a calendar rule will display
as a red line.
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9. Click OK to save and add the calendar to the Calendar Configuration view.

Adding a Calendar Rule
You can add a new calendar rule from the Calendar Configuration view. Follow these steps to create
one.

1. If you are not on the Calendar Configuration view, click Calendars under the Configuration
section in the Views Menu.

2. On the Calendar Rules tab, right-click anywhere and select Add. The Calendar Rule panel
displays.
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3. Enter a Rule Name. This name is used as a reference when assigning the rule to a calendar.

4. Enter a short description for the calendar rule in the text field next to the rule name.

5. Under Rule Time, enter a Start Time. This is the time of day that the rule will come into
effect.

6. Enter a Duration for the time period you are defining. The duration of the rule will depend on
the recurrence schedule you define below. Choose the number of days, hours and minutes
that the rule will be in effect.

7. Specify whether and when you want the time period to reoccur.

l Once - Specify a Start Date. The rule will only come into effect one time, at the date
and time specified, and only for the duration specified. See One-off Calendar Rules.

l Daily - Specify whether you want the rule to come into effect every nth day, the days of
the week that the rule will be valid on, and the Valid From date, on which the rule will
come into effect. See Daily Calendar Rules.

l Weekly - Specify whether you want the rule to come into effect every nth week, the
days of the week that the rule will be valid on, and the Valid From date, on which the
rule will come into effect. See Weekly Calendar Rules.

l Monthly - Specify whether you want the rule to come into effect every nth month, the
day of the month that the rule will be valid on, and the Valid From date, on which the
rule will come into effect. See Monthly Calendar Rules.

l Yearly - Specify a start month for the rule, the day of the month that the rule will be
valid on, and the Valid From date, on which the rule will come into effect. See Yearly
Calendar Rules.
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8. If you want the calendar rule to only be valid through a certain date, select Valid Until and
enter an end date. Otherwise, select Always Valid to keep the rule in effect indefinitely.

9. Click OK to save and add the calendar rule to the Calendar Configuration view.

About Calendar Rules
In the Calendar Configuration view, you can add calendar rules to your calendars. Calendar rules
allow you to define when and how often the rule should run.

The following sections provide descriptions of the calendar rules you can create. For more
information about a calendar rule, such as what it does and instructions on customizing it, click the
"Read more" link in the description.

This rule determines a single time period with no recurrence. Read more...

This rules determines time periods that re-occur either every day, every other day, every third day,
and so on. Read more...

This rule determines time periods that re-occur either every week, every other week, every third
week, and so on. Read more...

This rule determines time periods that re-occur either every month, ever other month, every third
month, and so on. Read more...

This rule determines time period that re-occur every year. Read more...

One-off Calendar Rules
A calendar rule that happens one time only is a one-off calendar rule.

To define this rule, right-click anywhere on the Calendar Configuration view and select Add to
display the Calendar Rules panel.

From there, select Once from the list of recurrence types and enter a start date for the rule. This
allows the rule to run one time for the duration set.
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Daily Calendar Rules
A calendar rule that reoccurs either every day, every other day, every third day, and so on is a daily
calendar rule.

To define this rule, right-click anywhere on the Calendar Configuration view and select Add to
display the Calendar Rules panel.

From there, select Daily from the list of recurrence types. Enter how often you want the rule to run
and select which days the rule should be valid on.

EXAMPLE:
This calendar rule is set to run every day at 8 a.m., valid Monday through Thursday.
Because only certain days are checked, however, the calendar rule will not run Friday through
Sunday.
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Weekly Calendar Rules
A calendar rule that reoccurs either every week, every other week, every third week, and so on is a
weekly calendar rule.

To define this rule, right-click anywhere on the Calendar Configuration view and select Add to
display the Calendar Rules panel.

From there, selectWeekly from the list of recurrence types. Enter how often you want the rule to
run and select which days the rule should be valid on.

EXAMPLE:
This calendar rule is set to run every two weeks at 12 a.m., valid on weekends only (Saturday
and Sunday).

NOTE: The Valid From date determines which day is deemed the start of the week. In this
example, the Valid From day is a Thursday, so weeks run from Thursday to Wednesday.
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Monthly Calendar Rules
A calendar rule that reoccurs either every month, every other month, every third month, and so on
is a monthly calendar rule.

To define this rule, right-click anywhere on the Calendar Configuration view and select Add to
display the Calendar Rules panel.

From there, selectMonthly from the list of recurrence types. Enter which day of the month you
want the calendar rule to run on OR determine whether you want it to run on the first, second,
third... Monday, Tuesday, Wednesday... of the month.

EXAMPLE:
This calendar rule is set to define a monthly meeting. it will run for 2 hours, starting at 9 a.m., on
the last Friday of every month.

User Guide www.helpsystems.com page: 233



Configuration / The Calendar Configuration View

Yearly Calendar Rules
A calendar rule that reoccurs every year is a yearly calendar rule.

To define this rule, right-click anywhere on the Calendar Configuration view and select Add to
display the Calendar Rules panel.

From there, select Yearly from the list of recurrence types. Enter which month you want the
calendar rule to run in, then determine whether you want it to run on a specific day that month OR
on the first, second, third... Monday, Tuesday, Wednesday... of the month.

EXAMPLE:
This calendar rule is set to run for two days in December, starting December 1, every year.
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The SST Configuration View
NOTE: The SST Configuration View is accessible from the Configuration section of the Views
menu. If it is not visible, you can reach it by logging in to Security via the Authority Logon.

The SST Configuration View allows you to review and change the attributes used by MSM to access
functions in System Service Tools.

MSM uses System Service Tools to monitor Battery Cache status. When Robot Monitor requires SST
access to fetch data to be monitored, it uses the security information entered here to create an
interactive session, sign on to the system, and collect the required information.

Security information is held on the system in encrypted form and uses MD5 hash values to detect
any attempts to change the security files from outside the product.

For maximum security, we recommend you allow MSM to manage all profiles. This ensures that each
profile on each system is assigned a random password and held in encrypted form. No one knows the
passwords being used to gain access to SST. You can, however, create the profiles yourself and
provide the details to MSM. If you do this, MSM flags the profiles as having been created outside the
product and limits what can be done with them using this view to update the records. It will not
change passwords or delete profiles that were created outside the product.
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In addition to passwords, the initial program used for the iSeries profile provides a second level of
authentication to ensure that this sign on can only be used by MSM. This second level of
authentication requires responses that cannot be generated from a workstation.

Things You Can Do
l To configure a system for SST access, select it (or multiple systems using Shift) from the list
and click Configure. The SST Configuration Details panel opens.

NOTE:You can also double-click a system to open the SST Configuration Details panel.

l Click Test to perform a test run of the battery cache monitor and update the status and
message fields with the results.

NOTE: Systems must be configured with SST access before they can be tested.

Virtual Device
In order to perform Configure or Test a system, Robot Monitor requires access to a virtual device. It
first looks for a virtual device called MSMSST and uses this if configured. If not found, or if MSMSST
is in use, it selects an existing device or uses automatic configuration to create a new one instead.

SST Configuration Details Panel
The SST Configuration Details panel is used to configure SST access for MSM. To access this panel,
open the SST Configuration view, highlight a system, and select Configure.

In this example, we have entered options to create OS and SST profiles and generate random
passwords for the MSMSST profile on each system.
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Options and Descriptions
The following sections list the options in this screen and their descriptions.

Actions to be taken
For Actions to be taken, you can choose from several options for the OS and SST profiles:

No Change: Take no action for this profile.

Create: Create a profile.

Change Password: Change the password for the indicated profiles.

Use Existing Profile: Record the details provided for the indicated profile. Once this option has been
used for a profile, the profile is marked as created outside MSM and cannot be managed directly by
Robot Monitor. To re-enable direct management, manually delete the profile and use MSM to create
it again.

Delete Profile: Delete the profile (where possible) and clear the record. For profiles created outside
of MSM, this option only clears the record.

Clear Configuration: Clear MSM's record of the indicated profiles.

OS User Profile
This profile is an OS user profile used to sign on to the system to access SST.

If this profile is created outside of MSM, the profile must be dedicated to this function and must be
authorized to command STRSST.

If this profile is created by MSM, QSECOFR owns the profile. Note: In order to have MSM create an
OS user profile, you must provide a user profile and password that has *SECADM rights on the host
system.

Enter a valid password. It can be short or long, depending on the system's security settings, and may
be mixed case if long passwords are in use. If short passwords are used, the password will be
translated to upper case by the monitor.

Generate a Password

Check this box to have the monitor generate a random password. Passwords are up to 120
characters long and may be mixed case, depending on the system security settings. Each system is
assigned a different password.

SST Profile
This profile is a SST user profile used by Robot Monitor after signing on to the system and starting
SST.

If this profile is created outside of MSM, it must be authorized to use SST and have
Display/Alter/Dump capabilities.

Enter a valid password. It can be short or long, depending on the DST security settings. Note: SST
passwords are case sensitive.
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Generate a Password

Check this box to have the system generate a random password for this profile. Each system is
assigned a different password.

SST Secofr Signon
If you selected an option that requires MSM to perform SST Management functions (create, change
password, or delete), you must provide the sign on details for a SST profile with sufficient authority
to perform the requested operation.

NOTE: SST passwords are case sensitive.
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Reports
These topics describe general information about reports in Robot Monitor.

Click the following link to learn more about the topic.

l The PTF Comparison View

The PTF Comparison View
The PTF Comparison view displays a table of PTFs installed on systems at the same release level.
These PTFs are compared, and any differences between them are highlighted.

One system can be selected as the model system, which becomes the standard by which the PTF
listings for other systems are judged. If there is not a model system, Robot Monitor determines
which PTFs are missing or in the wrong status based on a series of internal algorithms.

PTF information is collected from each system when Robot Monitor starts. It submits the job
GET.PTF, which fetches the complete PTF listing, compares it to the previous PTF listing, and sends
changes back to the host system.
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When the PC monitor starts, the complete PTF listing for all systems is sent. This can be a lengthy
process, as there is a lot of data space to be sent. This process occurs in the background, and
progress messages display on the status bar as each system's PTF information is received.

A summary of the PTF status for each system is available as a data element and can be added to a
group.

Things You Can Do
l Double-click a PTF ID to run a search for it in Google.

l Double-click a PTF status or status date to display the PTF Details view.

Options and Descriptions
The following sections list the options in this screen and their descriptions. Some options differ
depending on the tab selected.

Release
Select the Release version you want from the drop-down. Different systems may be listed depending
on the version you select.

Model
Select the Model system you want to use from the drop-down, or select None to have Robot Monitor
consider each PTF on an individual basis.

For PTFs
Select
Use the drop-down to limit the amount of PTF information displayed. You can choose from the
following options:

All: Display all PTFs.

Action Required: Display only PTFs that require action on the part of the operator.

Action Pending: Display only PTFs that have action pending, typically during the next IPL.

Mismatched: Display only PTFs that appear to be in error.

Exceptions: Display all PTFs that require attention.

Show
Select what information should be shown in the system column.

Status Date: Show the date of the PTF status.

PTF Status: Show the PTF status.

Find
Enter a PTF to quickly find and highlight it from the list.
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Product
Select a product from the drop-down to limit the display to a selected licensed program.

For Groups
Select
Use the drop-down to limit the amount of PTF information displayed. You can choose from the
following options:

All: Display all PTFs.

Mismatched: Display only PTFs that appear to be in error.

Exceptions: Display all PTFs that require attention.

Show
Select what information should be shown in the system column.

Level: Show the level of the PTF group

Status: Show the status of the PTF group. Possible Statuses are:

l Unknown

l Not Applicable

l Supported Only

l Not Installed

l Installed

l Error

l Apply at next IPL

l Related group

l On order

Find

Enter a PTF to quickly find and highlight it from the list.

Right-Click Menu
When you right-click a PTF, a context menu displays. This menu provides a list of options you can
select.

Refresh PTF lists: Fetch all PTF listings from the selected systems again.

Look up Release: Look up the release on the internet using the website templates specified under
Miscellaneous on the Options window.

Look up PTF: Look up the PTF on the internet using the website templates specified under
Miscellaneous on the Options window.

User Guide www.helpsystems.com page: 241



Data Types and Parameters / The PTF Comparison View

Search PTF:Run a general internet search for the PTF using the website templates specified under
Miscellaneous on the Options window.

PTF Details
The PTF Details panel displays detailed information for the selected PTF.

You can access this panel by double-clicking a PTF status date on the PTF Comparison view.

Data Types and Parameters
Robot Monitor allows you to create a number of different types of elements. Most of these elements
have parameters that define what data is collected. For example, a subsystem monitor requires the
subsystem name and library in order to collect data.

Many data types have the same set of parameters, and most parameters can be prompted.

Currently, there are data types available for the IBM i, AIX, Linux, and VIOS.

The following pages describe the data types and parameters available in Robot Monitor. Definitions
that are specific to AIX, Linux, and VIOS, are located in the Unix sub-sections.
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Element Types
Data and element types are often classified into groups. The groups and their members are listed in
the following sections, and two elements (built-in elements and user defined values) are described
below.

Built-In Elements
The following data types are always collected by Robot Monitor. They are sorted by processor.

Built-in elements for IBM i:

Abbreviation Element Description

ABJ Active Batch
Jobs

The number of batch jobs that were active during the
last sampling interval. A batch job is considered active
if it uses more then 100 milliseconds of CPU time
during the interval.

A/I Active to
Ineligible
Transitions

This happens when a job is forced to give up the
processor because of an external limit (such as the job
timeslice), and is then forced to wait for an activity level
to become available.

AIJ Active
Interactive
Jobs

An active interactive job is defined for this purpose as a
workstation that has processed at least one transaction
in the last sample.Note: This is not the same definition
as used by IBM performance tools for active
workstations.

A/W Active to Wait
Transitions

This column gives a relative idea of the amount of work
being processed by the system. Sudden increases in this
figure can be an indication that something abnormal is
happening, such as save/restore activity, or
communications error recovery.

Autopwr Auto Restart
when Power
Restored

This indicates whether the system will restart
automatically when power is restored after an outage.
Auto Restart when Power Restored is controlled by the
QPWRRSTIPL system value.

AUX Auxiliary
Storage

The proportion of disk space used in the system ASP or
ASP 1. It is a percentage of the total disk space in the
system ASP.
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Abbreviation Element Description

BSY Disks Busy This figure gives an idea of the loading on the disk arms
across the system. It is based on a sampling mechanism.
The system checks the disk arms on frequent basis, and
looks to see whether there are any tasks waiting for
another request to be serviced. This element shows the
percentage of times that his was done, and there were
tasks waiting for other requests to be fulfilled by the
disks.

Disk busy figures for individual ASPs can be shown
using the User Data Bars.

Bypass UPS Bypass If the UPS bypass is active, this means the UPS will not
be used if power fails. This function may be enabled
when maintenance is done on the UPS.

CPT CPU Seconds
per
Transaction

This shows the complexity of the interactive work
being processed by the system.

CPU CPU Usage This value is always expressed as a percentage of the
amount of available processing power for a partition.
System performance is typically degraded when this
figure exceeds 80%.

CRI Current
Interactive
Percent

The proportion of the interactive feature currently
allocated to the partition. The Interactive Feature limits
the amount of interactive work that can be done on
many models. When such a model is partitioned, the
interactive limit can be apportioned independently to
the partitions.

CRM Current
Memory

The amount of memory (in megabytes) allocated to the
partition.

CRP Current
Processors

The number of processors allocated to the partition.

DCP Database CPU
usage

The amount of processing power used for database
activity. This figure is a percentage of the total amount
of processing power available.

FPBatt Front Panel
Battery Status

The status of the front panel battery for the primary
partition. The front panel battery keeps the system
clock going if there is a power failure. The status can be
OK, low, or failed.
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Abbreviation Element Description

ICP Interactive
CPU Usage

The amount of processing power being used by
interactive jobs. Interactive jobs are jobs that use the
IBM i, also known as a 5250 interface. This figure is a
percentage of the total amount of processing power
available.

IJB Interactive
Jobs

The total number of interactive jobs on the system.
This figure includes jobs such as suspended group jobs
and disconnected jobs.

JBS Jobs Running
in the System

The total number of jobs running on the system.

Key Key Position This shows the mode the partition is operating in. It is
set differently on different models and types of
partition, but for historical reasons, it is known as the
key position. It may be set by a key, by buttons, by
buttons and a key stick, from the console, or using the
CHGIPLA command.

Possible values are Auto, Manual, Normal, and Secure.

MCH Machine
Pool Faults

A machine pool fault occurs when a task in the machine
pool wants to use something that has been paged out
of memory, and it has to be paged in again from disk.
The machine pool is the memory pool in which most
system tasks run, so a lot of paging in this pool can
have a significant effect on all system performance.

MS Damaged
Main Storage
Units

The number of failed memory cards detected during the
last IPL of the primary partition. These cards are
marked as unusable, and the system operates with only
the functional cards.

NDB Non-Database
Faults

A non-database fault occurs when a user's program or
local storage is required but has been paged out and
must be fetched again from disk.

NextIPL Next IPL Type This shows the current front panel setting for which
microcode version will be used by default on the next
IPL.

Panel Front Panel
Status

This shows whether the front panel passed all its self
checks during the last IPL.
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Abbreviation Element Description

PrcNW Processors
Not Working

The number of processors that were not operating at
all during the last IPL of the primary partition.
Currently, this problem can only be detected on the
first 16 processors.

PrcPart Processors
Partly OK

The number of processors that had failures detected
but still operate with reduced performance. Currently,
this problem can only be detected on the first 16
processors.
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Abbreviation Element Description

Ptf Ptf Status The PTF status for a system is derived from the system
PTF listing. Optionally, it is also derived by comparing
the PTFs to a model system. The model system can be
selected from the PTF Comparison view. When a
system is selected as the model, the monitor takes this
list as the PTFs required for all systems at the same OS
release. If the PTF lists and statuses do not match, then
a status ofMismatched will be returned for this metric.

If no model system is selected, or if the PTF lists match,
then the following values can be returned. These values
match the values shown in the DSPPTF display.

Damaged:One or more PTFs are damaged.

Action Required:One or more PTFs have a status of
Action Required. This means that a PTF needs some
special action to make it active. Consult the PTF
Comparison view for instructions.

Action Pending:One or more PTFs have a status of
Action Pending.

IPL Action Pending:One or more PTFs have this
status. This means that the status of the PTF is set to
be changed during the next IPL. Typically, this means
the PTF will be applied or removed when the system is
next restarted.

When multiple conditions exist, only one will be shown
for the PTF status. The priority list (in descending
order) is as follows:

l Damaged

l Action Required

l Action Pending

l IPL Action Pending

l Mismatch

RmtPwr Remote Power
On Enabled

Indicates whether the system can be powered on
remotely by calling up the ECS modem. This attribute is
controlled by the QRMTIPL system value.
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Abbreviation Element Description

RSP Response
Time

The average response time for all interactive jobs in the
system. Interactive jobs are jobs that use the IBM i
(also known as a 5250 interface). Response time is the
elapsed time taken from an operator pressing a
function key (such as Enter or F6) to the time that the
terminal is ready for new input. This is an internal
measurement and does not include overheads such as
communications delays.

Term Last
Termination
Cause

This shows why the partition last ended. You can have
one of the following causes:

Normal (PWRDWNSYS): The user issued the
PWRDWNSYS command.

Power Failed: Power failed and there was no UPS
available.

Battery failed while running on UPS: Power failed and
had not been restored by the time the UPS ran out of
power.

System powered down from Front Panel: The user
forced an immediate termination of the system.

TRN Transactions
per Hour

This shows the number of transactions per hour being
processed by the system. A transaction is when a user
of the IBM i presses a function key, such as Enter or F6.

UnalcDisk Unallocated
Disk Units

The number of disk units that have not been assigned
to an ASP.

UPS Running on
UPS

This shows whether the system is currently running on
UPS.

UpsBatt UPS Battery
Status

This can show a status of OK or Low. Rarely, it may
show a status of Dead, but never for long.

W/I Wait to
Ineligible
Transitions

This happens when a job has finished waiting for a long
delay (such as user input), then changes immediately to
another wait state, as there is no activity level available
for the job to start running. The number of activity
levels is set as part of the memory pool definition and
is tuned to limit the number of jobs competing for
memory at the some moment.
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Built-in elements for AIX/Linux/VIOS:

Abbreviation Element Description

ALG Users
Online

Stands for Active Logins. The number of users who are
currently on the system.

BSY Disks Busy This number gives an idea of the loading on disk arms
across the system. it is based on a sampling mechanism.
The system checks the disk arms on a frequent basis and
looks to see whether there are any tasks waiting for
another request to be serviced. This element shows the
percentage of times that this was done with tasks waiting
for other requests to be fulfilled by the disks. Disk busy
figures for individual ASPs can be shown using the User
Data bars.

CPU CPU Usage This value is always expressed as a percentage of the
amount of available processing power for a partition.
System performance is typically degraded when this
figure exceeds 80%.

CRM Current
Memory

The amount of memory (in megabytes) allocated to the
partition.

CRP Current
Processors

The number of processors allocated to the partition.

CSW Context
Switch Rate

The number of context switches per second. A context
switch (also known as a process switch or a task switch)
is the switching of a CPU from one process/thread to
another. A low context switch rate on a busy system
indicates a process or thread may be hogging the system.
A high context rate might indicate too much contention
for the number of processors on the system. A significant
increase in context switch rate, considerably above disk
I/O or network packet rates, may be cause for
investigation.

DTX Disk I/O
Rate

The number of disk transfers (to/from disk) per second
over the sample interval.

FKR Fork Rate The number of processes created, per second, over the
sample interval for all CPUs.

FLG Failed Log-in
Attempts

The number of failed log-in attempts made.
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Abbreviation Element Description

HPF Hard Fault
Rate

The number of hard page faults during the sample
interval. Hard page faults result in swap activity that
requires disk I/O.

IRR Interrupt
Request
Rate

The rate at which the processor receives and services
hardware interrupts. Processes generate an interrupt
when they finish a task and need to report that fact to
the CPU. Abnormally high rates can be an indication of
hardware or device driver problems.

JBS Jobs
Running in
the System

The total number of jobs running on the system.

LA1 Load
Average 1
Minute

"Load average" is an exponentially-weighted average of
the load number. An idle computer has a load number of
0, and each process using or waiting for CPU time
increments the number by 1. The load average can be
used to better budget the number of CPUs required by a
system. This number is the load average calculated over
the last minute.

LA2 Load
Average 5
Minutes

"Load average" is an exponentially-weighted average of
the load number. An idle computer has a load number of
0, and each process using or waiting for CPU time
increments the number by 1. The load average can be
used to better budget the number of CPUs required by a
system. This number is the load average calculated over
the last five minutes.

LA3 Load
Average 15
Minutes

"Load average" is an exponentially-weighted average of
the load number. An idle computer has a load number of
0, and each process using or waiting for CPU time
increments the number by 1. The load average can be
used to better budget the number of CPUs required by a
system. This number is the load average calculated over
the last fifteen minutes.

NPR Network
Packet Rate

The number of packets received and transmitted per
second over the sample interval.

PBL Blocked
Processes

The number of processes blocked waiting for I/O at the
end of the collection period (for all CPUs). If this number
is high for longer than short periods of time, it could
indicate slow or problematic devices.
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Abbreviation Element Description

RQS Runnable
Processes

Stands for Run Queue Size. The average number of
running processes (in the run queue, in the running state)
for all CPUs over the sample period.

SCR System Call
Rate

The number of system calls per second over the sample
interval. it is not possible to define how many system
calls are too many, but over 10k system calls per second
per processor could be a cause for further investigation.

SSP System
Storage

The proportion of space used in O/S filesystems as a
percentage of the total space available.

UPT System Up-
time

The length of time the system has been up.

TAJ Total Active
Jobs

The total number of interactive jobs on the system. This
figure includes jobs such as suspended group jobs and
disconnected jobs.

User Supplied Values
User supplied values allow you to write programs to add new data types to Robot Monitor. You can
have as many user supplied values as you like.

You write a program that fetches the data required. This could be additional performance metrics,
information from the production database, BRMS status, mirroring status... anything you like.

The program should use command MONAPUPD or MONTXUPD to pass the value to the monitor.
Use MONAPUPD for numeric elements and MONTXUPD for text items.

Between collections, use the command MONAPWAT to wait for the next collection cycle.

Here is a minimal example program to demonstrate the basic idea:

Pgm &Inc

DCL VAR(&INC) TYPE(*DEC) LEN(15 5) /* Increment amount */

DCL VAR(&VALUE) TYPE(*DEC) LEN(9 2)

Loop:
MONAPUPD VALUE(&Value)
monapwat
monmsg mon0000 *n return
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chgvar &value (&value + &inc)

goto loop

endpgm

This program simply accepts an amount by which to count and keeps adding that value to the current
value of the element.

NOTE:Regarding the MonMsg for message mon0000 on the MONWAT command, MONWAT
issues an escape message when the monitor is ended. The program should monitor for this and
end as shown.

Here is an example script to demonstrate the basic idea:

[/opt/helpsystems/rbtmon/node/log] cat
/opt/helpsystems/rbtmon/node/bin/usercount.ksh
#!/bin/ksh
#

1. user-example.sh
#

2. Robot Monitor example script to deliver user-supplied metrics
#

3. Copyright (c) 2017 HelpSystems LLC
All rights reserved
#

4. set up path to locate monapupd and monapwat
PATH="$PATH:$RBTMON_HOME/bin"
export PATH

1. what type of metric to deliver
2. command-line argument can be integer, decimal, percentage or text
3. default is text

mtype="$1"

1. standard input, output, error are connected to /dev/console
2. two file descriptors are used for pipes back to the service

1. you could use these lines to set stdout and stderr to go to a
2. file instead:

#exec >/tmp/script.sh.out
#exec 2>&1

1. here we loop waiting for a trigger from the host (monapwat),
2. upon which we obtain and send back a metric (using monapupd)

#
3. note that the script should exit upon receipt of a non-zero
4. exit code from monapwat or monapupd, as this indicates loss
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5. of connectivity with the service on the node
#

value=0
while true; do

1. wait for a message from the service to begin collection
monapwat || exit $?

1. exec >/tmp/script.sh.out
2. echo `id` woke @ `date`
3. generate a value and post it back to the service

value=`ps -ef |grep "-f=6" |wc -l`
case "$mtype" in
integer)
monapupd -i $value || exit $?
;;
decimal)
monapupd -f ${value}.33 || exit $?
;;
percentage)
value=`expr $value % 99`
monapupd -p ${value}.55 || exit $?
;;
none)
monapupd -n || exit $?
;;
text|*)
monapupd -t "$value @ `date`" || exit $?
;;
esac
done

Configuring user supplied values
Once your program is ready, create a new element in the usual way. Select one of the user supplied
values:

User Supplied Decimal: Value is a number with a fractional value.

User Supplied Integer: Value is an integer. If a fractional value is passed to MONAPUPD, it rounds
up or down to the nearest whole number.

User Supplied Percentage: Value is a percentage, with decimals, and is typically between 0 and 100.

User Supplied Text: Value is a one or two character value that is translated to a description using a
threshold.
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Collection Services
Some data types use collection services APIs, including communications performance, IOP
monitoring, and system overhead.

When these APIs are used, the collection services are started by i5/OS. This is a mandatory
requirement of the API since version 5.1.

The collection services stores performance data in management collection objects. By default, it
keeps a months worth of these on disk. You can change this figure to something more sensible, such
as one day, by following these steps:

1. Enter the command CFGPFRCOL and press F4 or prompt on it.
2. Change the *MGTCOL retention period fields to 24 *HOURS or 1 *DAYS

3. Press Enter.

System Metrics
System metrics always exist and are always collected by the monitor. They cannot be selected as a
monitor type, and no parameters can be set.

These element types can be added to groups, however, and different thresholds can be assigned as
required, the same as any other element type. You can also assign messages to thresholds attached to
system metrics.

Metrics Taken from the System Information View
The following metrics are the same as those displayed on the System Information view:
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l UPS Battery Status

l Running on UPS

l UPS Bypass

l Unallocated Disk Units

l Damaged Main Storage Units

l Front Panel Battery Status

l Processors Not Working

l Processors Partly OK

l Front Panel Status

l Last Termination Cause

l Remote Power On Enabled

l Auto Restart when Power Restored

l Next IPL Type

l Key Position

Ptf Status
The PTF status for a system is derived from the system PTF listing (optionally, you can also derive it
by comparing your PTFs to a model system).

The model system can be selected from the PTF Comparison view. When a system is selected as the
model, Robot Monitor takes this list as the PTFs required for all systems at the same OS release. If
the PTF lists and statuses do not match, then a status of Mismatched will be returned for this metric.

If no model system is selected, or if the PTF lists match, then the following values can be returned.
These values match the values shown in the DSPPTF display.

Damaged: One or more PTFs are damaged.

Action Required: One or more PTFs have a status of Action Required. This means that a PTF needs
some special action to make it active.

Action Pending: One or more PTFs have a status of Action Pending.

IPL Action Pending: One or more PTF's have this status. This means that the status of the PTF is set
to be changed during the next IPL. This usually means the PTF will be applied or removed when the
system is next restarted.

When multiple conditions exist, only one will be shown for the PTF status. The priority list (in
descending order) is as follows:

Damaged

Action Required

Action Pending

IPL Action Pending

Mismatch

See the PTF Comparison view for a detailed comparison of PTFs on systems.
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ASP Information Data Types
This group of element types monitors individual ASPs.

TIP: In the following tables, 'Rqd' means the parameter is required, 'Gen' means the parameter
can be generic, and '*ALL' means select all instances for the parameter.

ASP Busy
Parameters

Parameter Rqd Gen *ALL Notes

ASP Number Yes No No The System ASP is ASP 1. User ASPs are
numbered 2-32. Independent ASPs are
numbered 33-255.

Description

For the selected ASP, the microcode checks the disk controllers at regular, frequent intervals. It
records the number of times the controller was busy processing disk requests. This figure shows the
percentage of times that the disks were busy.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Notes

Performance of jobs using this ASP will be affected when this figure reaches 60% and are greatly
affected around 80%.
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ASP Busy Unit#
Parameters

Parameter Rqd Gen *ALL Notes

ASP Number Yes No No The System ASP is ASP 1. User ASPs are
numbered 2-32. Independent ASPs are
numbered 33-255.

Description

For the selected ASP, this is the unit number (or disk number) that is busiest.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Notes

If a unit is consistently very busy, disk traces should be done to determine the cause. Disk balancing
may be required to redistribute data in the ASP and improve performance.

ASP Busy Unit%
Parameters

Parameter Rqd Gen *ALL Notes

ASP Number Yes No No The System ASP is ASP 1. User ASPs are
numbered 2-32. Independent ASPs are
numbered 33-255.

Description

Percent busy of the busiest unit in the select ASP.
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Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Notes

If the same unit is consistently very busy, disk traces should be done to determine the cause. Disk
balancing may be required to redistribute data in the ASP to improve performance.

ASP Space Free
Parameters

Parameter Rqd Gen *ALL Notes

ASP Number Yes No No The System ASP is ASP 1. User ASPs are
numbered 2-32. Independent ASPs are
numbered 33-255.

Report size as No No No Select whether to report this value in gigabytes
or terabytes. The default is gigabytes.

Description

The amount of free disk space remaining in the selected ASP.

If the scale value for this data type is left as zero, Robot Monitor uses the ASP size as the scale
value.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x
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OS Yes No

Linux x

VIOS x

ASP Space Used
Parameters

Parameter Rqd Gen *ALL Notes

ASP Number Yes No No The System ASP is ASP 1. User ASPs are
numbered 2-32. Independent ASPs are
numbered 33-255.

Report size as No No No Select whether to report this value in gigabytes
or terabytes. The default is gigabytes.

Description

The amount of disk space used in the selected ASP.

If the scale value for this data type is left as zero, the monitor will use the ASP size as the scale
value.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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ASP Status
Parameters

Parameter Rqd Gen *ALL Notes

ASP Number Yes No No The System ASP is ASP 1. User ASPs are
numbered 2-32. Independent ASPs are
numbered 33-255.

Description

The status of the selected ASP. This could include Offline, Vary on Pending, and Active.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

ASP Usage
Parameters

Parameter Rqd Gen *ALL Notes

ASP Number Yes No No The System ASP is ASP 1. User ASPs are
numbered 2-32. Independent ASPs are
numbered 33-255.

Description

The percentage disk used in the selected ASP.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Assure MIMIXMonitors Data Types
Robot Monitor supports a number of monitors for Assure MIMIX version 8 and above. These
monitors replace the functionality of the MONCHKMXS command. These are grouped according to
the object type monitored.

MIMIX Replication Status Metrics
This group brings together elements related to MIMIX Replication Status.

MIMIX Rollup Data Group Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The rollup data group status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MIMIX Database Source Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The database source status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Database Target Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The database target status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MIMIX Object Source Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The object source status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Object Target Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The object target status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MIMIX RJ Link Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The RJ link status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Database Send Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The database send status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MIMIX Database Read Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The database read status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Database Apply A Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The database apply A status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MIMIX Database Apply B Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The database apply B status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Database Apply C Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The database apply C status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MIMIX Database Apply D Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The database apply D status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Database Apply E Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The database apply E status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MIMIX Database Apply F Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The database apply F status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Object Send Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The object send status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MIMIX Object Retrieve Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The object retrieve status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Connector Send Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The connector send status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MIMIX Object Apply Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The object apply status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Database Apply A Threshold Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The database apply A threshold status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MIMIX Database Apply B Threshold Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The database apply B threshold status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Database Apply C Threshold Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The database apply C threshold status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MIMIX Database Apply D Threshold Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The database apply D threshold status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Database Apply E Threshold Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The database apply E threshold status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MIMIX Database Apply F Threshold Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The database apply F threshold status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Object Apply Threshold Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The object apply threshold status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MIMIX Number of Objects in Error
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The number of objects in error.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Number of Files on Hold
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The number of files on hold.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MIMIX Number of Files on Hold for Other Reasons
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The number of files on hold for other reasons.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Number of Files Not Journaled on System 1
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The number of files not journaled on system 1.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MIMIX Number of Files Not Journaled on System 2
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The number of files not journaled on system 2.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Number of IFS Objects in *HOLD Error
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The number of IFS objects in *HOLD error.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MIMIX Number of IFS Files on Hold for Other Reasons
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The number of IFS files on hold for other reasons.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Number of IFS Files Not Journaled on System 1
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The number of IFS files not journaled on System 1.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

User Guide www.helpsystems.com page: 277



Data Types and Parameters / Assure MIMIX Monitors Data Types

MIMIX Number of IFS Files Not Journaled on System 2
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The number of IFS files not journaled on System 2.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Number of DA/DQ Objects in *Hold Error
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The number of DA/DQ objects in *HOLD error.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MIMIX Number of DA/DQ Objects on Hold for Other
Reasons
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The number of DA/DQ objects on hold for other reasons.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Number of DA/DQ Objects Not Journaled on
System 1
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The number of DA/DQ objects not journaled on System 1.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x
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OS Yes No

Linux x

VIOS x

MIMIX Number of DA/DQ Objects Not Journaled on
System 2
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The number of DA/DQ objects not journaled on System 2.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Audit Compliance Status
Parameters

Data Group Name - The name of the Data Group to be monitored.

Description

The audit compliance status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Manager Status Metrics
This group brings together elements related to MIMIX Manager Status.

MIMIX System Manager Status
Parameters

System Name - The name of the system to be monitored.

Description

The system manager status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Journal Manager Status
Parameters

System Name - The name of the system to be monitored.

Description

The journal manager status.
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Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Monitor Process Status
Parameters

System Name - The name of the system to be monitored.

Description

The monitor process status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Master Monitor Status
Parameters

System Name - The name of the system to be monitored.

Description

The master monitor status.
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Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Collector Services Status
Parameters

System Name - The name of the system to be monitored.

Description

The collector services status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Monitor Status Metrics
This group brings together elements related to MIMIX Monitor Status.
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MIMIX Monitor Status
Parameters

Monitor Name - The name of the monitor to be monitored.

Description

The monitor status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MIMIX Audit Status Metrics
This group brings together elements related to MIMIX Audit Status.

MIMIX Audit Status
Parameters

Short Data Group Name - The short name of the Data Group to be monitored

Rule Name - The name of the rule to be monitored

Description

The audit status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Communications Performance Data Types
This type of group element monitors the performance of communication links (such as lines and
remote locations) for the IBM i and network performance statistics (at the adapter and interface
levels) for AIX, Linux, and VIOS partitions.

TIP: In the following tables, 'Rqd' means the parameter is required, 'Gen' means the parameter
can be generic, and '*ALL' means select all instances for the parameter.

APPC Pinger
Robot Monitor's APPC Pinger data type performs the same processing that the IBM i command
APING does. It uses CPI-C to send a start request to the target system, which responds by sending
the associated data packet back. Robot Monitor times the transaction, giving a numeric indication of
the speed of the link and a confirmation that the line and the system are up.

Parameters

Parameter Rqd *ALL Notes

Remote
Location

No No Choose a remote location to connect with. Right-click to
prompt location. The information is taken from the
topology database on the prompt system.

Network ID No No Specify a network ID.

Mode No No Specify the name of the mode used for the APPC
conversation. You can right-click to prompt and select a
mode from the drop-down.

Collection
Job Priority

No No Pingers run in separate jobs, one for each location.
Because the collection job times the packets by looking
at the clock, it has to run at a high priority in order to get
accurate results. The default priority for these jobs is 5.
This parameter can be used to override the priority by
entering a number from 1 to 99. If you lower the priority
of the job, the measurements will be affected by system
performance.
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Description

The round trip time in milliseconds.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Comms (Ethernet) More than 16 Retries
Parameters

Parameter Rqd *ALL Notes

Line Description Yes No Enter a line description.

Description

The number of times more than sixteen retries were required to send a packet on the Ethernet link.
If this figure stays high, this is an indication that there are serious collisions or other errors taking
place.

Type

Integer

Notes

All line types are supported. This monitor type invokes PM/400.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Comms (Ethernet) More than One Retry
Parameters

Parameter Rqd *ALL Notes

Line Description Yes No Enter a line description.

Description

The number of times one to fifteen retries were required to send a packet on the Ethernet link. If
this figure stays high, this is an indication that there are serious collisions or other errors taking
place.

Type

Integer

Notes

All line types are supported. This monitor type invokes PM/400.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Comms (Ethernet) One Retry
Parameters

Parameter Rqd *ALL Notes

Line Description Yes No Enter a line description.

Description

The exact number of times one retry was required to send a packet on the ethernet link. This is an
indication that there are low level collisions taking place.

Type

Integer
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Notes

All line types are supported. This monitor type invokes PM/400.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Comms Error Count
Parameters

Parameter Rqd *ALL Notes

Line Description Yes No Enter a line description.

Description

The error count for the monitoring interval.

Type

Float

Notes

All line types are supported. This monitor type invokes PM/400.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Comms Throughput Receive
Parameters

Parameter Rqd *ALL Notes

Line Description Yes No Enter a line description.

Description

The data received on one line in kilobytes per second.

Type

Float

Notes

All line types are supported. This monitor type invokes PM/400.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Comms Throughput Transmit
Parameters

Parameter Rqd *ALL Notes

Line Description Yes No Enter a line description.

Description

The data transmitted on the line in kilobytes per second.

Type

Float

Notes

All line types are supported. This monitor type invokes PM/400.
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OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Comms Utilization
Parameters

Parameter Rqd *ALL Notes

Line Description Yes No Enter a line description.

Description

The percentage of capacity used for the specified line.

Type

Float

Notes

All line types are supported. This monitor type invokes PM/400.

The monitor takes the line speed from the line description and the number of bytes received and
transmitted. From this, it estimates the percentage of capacity used.

For a full duplex line, it takes the larger of bytes sent and received and divides it by the line speed
times the interval time. For a half duplex line, it adds the two byte counts and divides the sum by the
line speed times the interval time.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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IOP Utilization (Comms Only)
See IOP Monitor Data Types for more information.

TCP Ping
Parameters

Parameter Rqd *ALL Notes

TCP Address Yes No This parameter can be in symbolic form (a website) or
entered as a dotted IP address. It cannot be prompted.

Collection
Job Priority

No No Pingers run in separate jobs, one for each location.
Because the collection job times the packets by looking
at the clock, it runs at a high priority in order to get
accurate results. The default priority for these jobs is 5.
This parameter can be used to override the priority, by
entering a number from 1 to 99. If you lower the priority
of the job, the measurements will be affected by system
performance.

Description

The average of three pings to the specified address.

Single character values are returned in the case of error:

Value Meaning

L Packet Loss: The program did not receive as many responses as expected.

R No response: No packets were returned from the target address.

N Not Found: The symbolic address could not be resolved by the DNS server.

Type

Integer, or alpha for errors

Notes

Pinging a system means that a special type of packet is sent to the system and the system
immediately sends the packet back. The sending system times this transaction, and from this is able
to calculate the average time taken for a packet to cross the network and return. This gives a
numeric indication of network performance. It also makes sure the network and remote system are
operating correctly.

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Communications Status Data Types
This group of element types monitors the status of communications objects, such as lines and
controllers.

TIP: In the following tables, 'Rqd' means the parameter is required, 'Gen' means the parameter
can be generic, and '*ALL' means select all instances for the parameter.

Controller Status
Parameters

Parameter Rqd Gen *ALL Notes

Controller Description Yes No No Choose a name for the controller.

Description

The status of the selected controller. This could include Offline, Vary on Pending, and Active.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Device Status
Parameters

Parameter Rqd Gen *ALL Notes

Device Description Yes No No Choose a name for the device.

Description

The status of the selected device. This could include Offline, Vary on Pending, and Active.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Distribution Queue Status
Parameters

Parameter Rqd Gen *ALL Notes

Distribution Queue No No No Choose a distribution queue.

Description

The status of the selected distribution queue.

Type

Alpha, translated

Notes

A print-scraping approach is used to collect this information, as there is no API to collect the data in
a structured way. However, if one element of this type is defined, adding more will not increase the
overhead as the program fetches information for all queues regardless.

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

IP Interface Status
Parameters

Parameter Rqd Gen *ALL Notes

IP Address No No No Choose an IP address from the drop-down list.

Description

The status of the IP interface.

Two special values can be returned.

N: Interface was not found. T: TCP is down, so all interfaces are down. If you are sending messages
for an interface, we recommend you do not select messages for this value so you will not get a
message for each interface.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Line Status
Parameters

Parameter Rqd Gen *ALL Notes

Enter a line description. Yes No No Choose a name for the line.
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Description

The status of the selected line. This could include Offline, Vary on Pending, and Active.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Network Interface Status
Parameters

Parameter Rqd Gen *ALL Notes

Network Interface
Name

Yes No No Choose a name for the network
interface.

Description

The status of the selected interface. This could include Offline, Vary on Pending, and Active.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Network Server Status
Parameters

Parameter Rqd Gen *ALL Notes

Network Server
Description

Yes No No Choose a name for the network
server.

Description

The status of the selected server. This could include Offline, Vary on Pending, and Active.

Type

Integer

Notes

An IP interface is the address to which the system responds on a given network connection. This
monitor type is intended for fixed IP addresses only. DHCP assigned addresses are not supported.

This monitor type returns the current status of a single interface and supports starting and ending
the interface.

The status of the IP interface is returned as a number, which is translated to the status using the
threshold. The standard global threshold assumes that interfaces should normally be up, but
additional thresholds can be created for interfaces that are normally down by copying and modifying
the standard threshold.

Right-click an element to start or end the interface.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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TCP Port Status
Parameters

Parameter Rqd Gen *ALL Notes

From Port No No No The from and to ports can be specified as raw
numbers or symbolic names. Right-click to
prompt this parameter for a list of symbolic
names, which are taken from the known port
table on the prompt system.

To Port No No No To monitor a single port, specify only the From
Port. To monitor a range of ports with this
element, specify the from and to ports.

Listening No No N/A Select Yes to include servers with this status.

Starting No No N/A Select Yes to include servers with this status.

Established No No N/A Select Yes to include servers with this status.

Closing No No N/A Select Yes to include servers with this status.

Closed No No N/A Select Yes to include servers with this status.

UDP No No N/A Select Yes to include servers with this status.

Description

The number of connections for the specified port or range of ports.

Type

Integer

Notes

Translation of port numbers and prompting is done using the information held in the known port
table on the host system.

You can edit this table using the WRKSRVTBLE command.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x
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OS Yes No

VIOS x

IOPMonitors Data Types
This group of element types monitors input/output processor attributes.

TIP: In the following tables, 'Rqd' means the parameter is required, 'Gen' means the parameter
can be generic, and '*ALL' means select all instances for the parameter.

Cache Battery Life
Parameters

None

Description

The estimated number of days until a battery will fail in the disk controllers for this system.

Type

Integer

Notes

In order to monitor disk cache battery life, you must first configure SST Access.

The cache battery monitor returns the lowest value for all disk controllers that have battery backed
cache. In order to see the full details, right-click it and select Display Details. This opens a detailed
view for the monitor, showing full details for all disk controllers with batteries. If the element is in a
multiple system view, the detail view shows details for all systems for that view.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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IOP Utilization
Parameters

Parameter Rqd *ALL Notes

IOP Resource Name Yes No Select a resource name.

Description

The percentage CPU utilization on the I/O Processor.

Type

Float

Notes

I/O Processors for internal partition connections will always return 0. This is because there is not
actually an IOP there, so although i5/OS reports an IOP, the performance APIs do not return any
information.

This monitor type invokes PM/400.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

IOP Utilization (Comms Only)
Parameters

Parameter Rqd *ALL Notes

IOP Resource Name Yes No Select a resource name.

Description

The percentage of CPU utilization on the I/O processor that was used to service communications
lines.

Type

Float
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Notes

I/O processors for internal partition connections always return 0. This is because there is not
actually an IOP there, so although i5/OS reports an IOP, the performance APIs do not return any
information.

This monitor type invokes PM/400.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

IOP Utilization (Disk Only)
Parameters

Parameter Rqd *ALL Notes

IOP Resource Name Yes No Select a resource name.

Description

The percentage of CPU utilization on the I/O Processor that was used servicing disk requests.

Type

Float

Notes

This monitor type invokes PM/400.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Job Performance Data Types
This group of element types monitor the performance of individual jobs or groups of jobs.

TIP: In the following tables, 'Rqd' means the parameter is required, 'Gen' means the parameter
can be generic, and '*ALL' means select all instances for the parameter.

Check Job CPU and Hinder
This element type is a special form of the user supplied data type. It runs the MONCHKJCP
command, which checks job CPU or Disk IO and holds or lowers job priority in order to stop
runaway jobs from adversely affecting the rest of the system.

Parameters

None

Description

The number of jobs currently being hampered (held or with priority lowered).

Right-click a Check Job CPU element and select Details to see a list of jobs currently being
hampered by this element.

Notes

This element type has a command associated with it, generally the MONCHKJCP command. Use the
Prompt command to fill in the parameters and control the way in which jobs should be treated. See
the Robot Monitor IBM i User Guide on the MONCHKJCP command for more information on this.

The MONCHKJCP command runs as a user defined collection job in the usual way. It starts and ends
with Robot Monitor. When the monitor ends, any hampered jobs are restored.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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CPU Seconds per Transaction
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No Yes No Job accounting code. This is prompted from job
accounting data, so it can only be prompted if
job accounting data has been collected.

User Name No Yes No Job User Name. Prompted from list of user
profiles.

Current User No Yes No Prompted from list of user profiles.

Job Name No Yes No Prompted from currently active jobs.

Function No Yes No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be either a generic or a specific entry.

Max Jobs In
List

No No No The maximum number of jobs to show in the
details display.

Description

The average number of CPU seconds it takes to process each transaction for the selected jobs.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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CPU Usage
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No Yes No Job accounting code. This is prompted from job
accounting data, so can only be prompted if job
accounting data have been collected.

User Name No Yes No Job User Name. Prompted from list of user
profiles.

Current User No Yes No Prompted from list of user profiles.

Job Name No Yes No Prompted from currently active jobs.

Function No Yes No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be either a generic or a specific entry.

Max Jobs In
List

No No No The maximum number of jobs to show in the
details display.

Description

The percentage of CPU being used by jobs that meet the selection criteria. This value is always
scaled to 100%.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Database CPU Usage
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No Yes No Job accounting code. This is prompted from job
accounting data, so it can only be prompted if
job accounting data has been collected.

User Name No Yes No Job User Name. Prompted from list of user
profiles.

Current User No Yes No Prompted from list of user profiles.

Job Name No Yes No Prompted from currently active jobs.

Function No Yes No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be either a generic or a specific entry.

Max Jobs In
List

No No No The maximum number of jobs to show in the
details display.

Description

The percentage of database CPU being used by jobs meeting the selection criteria. This value is
always scaled to 100%.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Disk I/O
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No Yes No Job accounting code. This is prompted from job
accounting data, so it can only be prompted if
job accounting data has been collected.

User Name No Yes No Job User Name. Prompted from list of user
profiles.

Current User No Yes No Prompted from list of user profiles.

Job Name No Yes No Prompted from currently active jobs.

Function No Yes No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be either a generic or a specific entry.

Max Jobs In
List

No No No The maximum number of jobs to show in the
details display.

Description

The average number, per second, of disk I/O requests for the selected jobs.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Faults per Second
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No Yes No Job accounting code. This is prompted from job
accounting data, so it can only be prompted if
job accounting data has been collected.

User Name No Yes No Job User Name. Prompted from list of user
profiles.

Current User No Yes No Prompted from list of user profiles.

Job Name No Yes No Prompted from currently active jobs.

Function No Yes No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be either a generic or a specific entry.

Max Jobs In
List

No No No The maximum number of jobs to show in the
details display.

Description

The number, per second, of faults for meeting the selection criteria.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Interactive CPU Usage
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No Yes No Job accounting code. This is prompted from job
accounting data, so it can only be prompted if
job accounting data has been collected.

User Name No Yes No Job User Name. Prompted from list of user
profiles.

Current User No Yes No Prompted from list of user profiles.

Job Name No Yes No Prompted from currently active jobs.

Function No Yes No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be either a generic or a specific entry.

Max Jobs In
List

No No No The maximum number of jobs to show in the
details display.

Description

The percentage of CPU being used by interactive jobs meeting the selection criteria. This value is
always scaled to 100%.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Job Queue Average Wait Time
Parameters

Parameter Rqd Gen *ALL Notes

Job queue No Yes Yes Select a job queue.Note: A library must be
specified first before you can prompt this value.

Library No Yes Yes Select a library.

Include
Scheduled
Jobs

No No N/A Choose whether or not you want to include
scheduled jobs.

Include Held
Jobs

No No N/A Choose whether or not you want to include
held jobs.

Description

For the selected queues, the monitor determines the length of time each job has been waiting to run.
It then calculates an average wait time (in minutes), which is the total wait time divided by the
number of jobs waiting to run. For most jobs, the time used for the calculation will be the time since
the job was put on the queue. For scheduled jobs that have reached their scheduled run time, this
will be the time since they were scheduled to run.

Notes

You can exclude scheduled jobs from this calculation. Once a scheduled job has reached its
scheduled time, it will then be included in the test.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Job Queue Max Wait Time
Parameters

Parameter Rqd Gen *ALL Notes

Job queue No Yes Yes Select a job queue.Note: A library must be
specified first before you can prompt this value.

Library No Yes Yes Select a library.

Include
Scheduled
Jobs

No No N/A Choose whether or not you want to include
scheduled jobs.

Include Held
Jobs

No No N/A Choose whether or not you want to include
held jobs.

Description

For the selected queues, Robot Monitor determines which job has been waiting the longest and
returns the number of minutes that job has been waiting to run. For most jobs, this will be the time
since the job was put on the queue. For scheduled jobs that have reached their scheduled run time,
this will be the time since they were schedule to run.

Notes

You can exclude scheduled jobs from this calculation. Once a scheduled job has reached its
scheduled time, it will then be included in the test.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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LockWait Time
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No Yes No Job accounting code. This is prompted from job
accounting data, so it can only be prompted if
job accounting data has been collected.

User Name No Yes No Job User Name. Prompted from list of user
profiles.

Current User No Yes No Prompted from list of user profiles.

Job Name No Yes No Prompted from currently active jobs.

Function No Yes No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be either a generic or a specific entry.

Max Jobs In
List

No No No The maximum number of jobs to show in the
details display.

Description

The average time per transaction spent waiting for locks and seize conflicts.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Maximum Job Run Time
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No Yes No Job accounting code. This is prompted from job
accounting data, so it can only be prompted if
job accounting data has been collected.

User Name No Yes No Job User Name. Prompted from list of user
profiles.

Current User No Yes No Prompted from list of user profiles.

Job Name No Yes No Prompted from currently active jobs.

Function No Yes No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be either a generic or a specific entry.

Min Run
Time
(Minutes)

No No No Enter the number of minutes this monitor type
should run.

Max Jobs In
List

No No No The maximum number of jobs to show in the
details display.

Description

The maximum time that a job matching the selection criteria has been running.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Response Time
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No Yes No Job accounting code. This is prompted from job
accounting data, so it can only be prompted if
job accounting data has been collected.

User Name No Yes No Job User Name. Prompted from list of user
profiles.

Current User No Yes No Prompted from list of user profiles.

Job Name No Yes No Prompted from currently active jobs.

Function No Yes No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be either a generic or a specific entry.

Max Jobs In
List

No No No The maximum number of jobs to show in the
details display.

Description

The average response time for the selected jobs.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Subsystem Transactions/Hour
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No Yes No Job accounting code. This is prompted from job
accounting data, so it can only be prompted if
job accounting data has been collected.

User Name No Yes No Job User Name. Prompted from list of user
profiles.

Current User No Yes No Prompted from list of user profiles.

Job Name No Yes No Prompted from currently active jobs.

Function No Yes No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be either a generic or a specific entry.

Max Jobs In
List

No No No The maximum number of jobs to show in the
details display.

Description

The projected number of transactions per hour for jobs meeting the selection criteria.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Temporary Storage per Job
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No Yes No Job accounting code. This is prompted from job
accounting data, so it can only be prompted if
job accounting data has been collected.

User Name No Yes No Job User Name. Prompted from list of user
profiles.

Current User No Yes No Prompted from list of user profiles.

Job Name No Yes No Prompted from currently active jobs.

Function No Yes No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be either a generic or a specific entry.

Max Jobs In
List

No No No The maximum number of jobs to show in the
details display.

Description

The average temporary storage per job, allocated by the selected jobs.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Temporary Storage Total
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No Yes No Job accounting code. This is prompted from job
accounting data, so it can only be prompted if
job accounting data has been collected.

User Name No Yes No Job User Name. Prompted from list of user
profiles.

Current User No Yes No Prompted from list of user profiles.

Job Name No Yes No Prompted from currently active jobs.

Function No Yes No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be either a generic or a specific entry.

Max Jobs In
List

No No No The maximum number of jobs to show in the
details display.

Description

The total temporary storage allocated by the selected jobs.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Thread Count per Job
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No No No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No No No Job accounting code. This is prompted from job
accounting data, so it can only be prompted if
job accounting data has been collected.

User Name No No No Job User Name. Prompted from list of user
profiles.

Current User No No No Prompted from list of user profiles.

Job Name No No No Prompted from currently active jobs.

Function No No No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be either a generic or a specific entry.

Max Jobs In
List

No No No The maximum number of jobs to show in the
details display.

Description

The average number of active threads per job running in the selected jobs.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Thread Count Total
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No Yes No Job accounting code. This is prompted from job
accounting data, so it can only be prompted if
job accounting data has been collected.

User Name No Yes No Job User Name. Prompted from list of user
profiles.

Current User No Yes No Prompted from list of user profiles.

Job Name No Yes No Prompted from currently active jobs.

Function No Yes No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be either a generic or a specific entry.

Max Jobs In
List

No No No The maximum number of jobs to show in the
details display.

Description

The total number of active threads running in the selected jobs.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Total Job CPU
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No No No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No No No Job accounting code. This is prompted from job
accounting data, so it can only be prompted if
job accounting data has been collected.

User Name No No No Job User Name. Prompted from list of user
profiles.

Current User No No No Prompted from list of user profiles.

Job Name No No No Prompted from currently active jobs.

Function No No No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be either a generic or a specific entry.

Max Jobs In
List

No No No The maximum number of jobs to show in the
details display.

Description

The total CPU seconds that have been used by jobs meeting the selection criteria.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Job Status Data Types
This group of element types monitors the jobs and objects that control jobs, such as subsystems and
job queues.

TIP: In the following tables, 'Rqd' means the parameter is required, 'Gen' means the parameter
can be generic, and '*ALL' means select all instances for the parameter.

NOTE:Batch Job totals also include BCI (Batch Immediate) jobs.

Batch Job Count
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Select or enter name of the subsystem for jobs
to be monitored. You can prompt from active
subsystems.

Accounting
Code

No Yes No Select a job accounting code. You can prompt
from job accounting data. Note: This can only be
prompted if job accounting data has been
collected.

User Name No Yes No Select a job user name. You can prompt from list
of user profiles.

Current User No Yes No Select a current user name. You can prompt from
list of user profiles.

Job Name No Yes No Select a job name. You can prompt from
currently active jobs.

Function No Yes No The job function is a three character code, as
shown on WRKACTJOB. For instance, CMD-*
could be used to selected all jobs running
commands. This can be a generic or specific
entry. If you wanted to select all jobs displaying
menu PAYROLL, for example, enterMNU-
PAYROLL.

Status No No No Prompt for a full list of options and their
definitions.

Max Jobs In
List

No No No Enter the maximum number of jobs to show in
the details display. You cannot go higher than
30.
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Description

The number of batch jobs meeting the selection criteria.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Batch Jobs Held on Job Queue
Parameters

None

Description

The count of held batch jobs on job queues.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Batch Jobs on Held Job Queue
Parameters

None
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Description

The count of batch jobs on job queues that have been held.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Batch Jobs on Job Queue without Subsystem
Parameters

None

Description

The count of batch jobs on job queues which are not attached to an active subsystem.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Batch Jobs on Output Queue
Parameters

None
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Description

The count of batch jobs that have finished but still have printed output on output queues.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Batch Jobs Waiting to Run
Parameters

None

Description

The count of batch jobs waiting to run, both on job queues and scheduled jobs.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Interactive Job Count
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Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Select or enter name of the subsystem for jobs
to be monitored. You can prompt from active
subsystems.

Accounting
Code

No Yes No Select a job accounting code. You can prompt
from job accounting data. Note: This can only be
prompted if job accounting data has been
previously collected.

User Name No Yes No Select a job user name. You can prompt from list
of user profiles.

Current User No Yes No Select a current user name. You can prompt from
list of user profiles.

Job Name No Yes No Select a job name. You can prompt from
currently active jobs.

Function No Yes No The job function is a three character code, as
shown on WRKACTJOB. For instance, CMD-*
could be used to selected all jobs running
commands. This can be a generic or specific
entry. If you wanted to select all jobs displaying
menu PAYROLL, for example, enterMNU-
PAYROLL.

Max Jobs In
List

No No No Enter the maximum number of jobs to show in
the details display.

Status No No No Prompt for a full list of options and their
definitions.

Description

The number of interactive jobs meeting the selection criteria.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x
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OS Yes No

Linux x

VIOS x

Interactive Jobs on Output Queue
Parameters

None

Description

The count of interactive jobs that have finished but have printed output waiting on output queues.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Job Count
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Select or enter name of the subsystem for jobs
to be monitored. You can prompt from active
subsystems.

Accounting
Code

No Yes No Select a job accounting code. You can prompt
from job accounting data. Note: This can only be
prompted if job accounting data has been
previously collected.

User Name No Yes No Select a job user name. You can prompt from list
of user profiles.
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Parameter Rqd Gen *ALL Notes

Current User No Yes No Select a current user name. You can prompt from
list of user profiles.

Job Name No Yes No Select a job name. You can prompt from
currently active jobs.

Function No Yes No The job function is a three character code, as
shown on WRKACTJOB. For instance, CMD-*
could be used to selected all jobs running
commands. This can be a generic or specific
entry. If you wanted to select all jobs displaying
menu PAYROLL, for example, enterMNU-
PAYROLL.

Status No No No Prompt for a full list of options and their
definitions.

Max Jobs In
List

No No No Enter the maximum number of jobs to show in
the details display. You cannot go higher than
30.

Description

The number of jobs with the selected status.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Job Queue Active Job Count
Parameters

Parameter Rqd Gen *ALL Notes

Job queue Yes Yes Yes You need to specify a library first before you can
choose a job queue.

Library Yes No Yes The library for the job queue.

Description

The number of running jobs that started from the specified queues.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Job Queue Average Wait Time
See Job Performance Data Types for more information.

Job Queue Count
Parameters

Parameter Rqd Gen *ALL Value

Job queue No Yes Yes You need to specify a library first before you
can choose a job queue.

Library No No Yes The library for the job queue.

Omit
Scheduled Jobs

No No No Yes, No
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Parameter Rqd Gen *ALL Value

Omit Held Jobs No No No Yes, No

Description

The number of jobs waiting on the specified queues.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Job Queue Max Wait Time
See Job Performance Data Types for more information.

Job Queue Status
Parameters

Parameter Rqd Gen *ALL Notes

Job queue Yes No No You need to specify a library first before you
can choose a job queue.

Library Yes No No The library for the job queue.

Description

The status of the specified job queue, including active, no subsystem, and held.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Job Status
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Select or enter name of the subsystem for jobs
to be monitored. You can prompt from active
subsystems.

Accounting
Code

No Yes No Select a job accounting code. You can prompt
from job accounting data. Note: This can only be
prompted if job accounting data has been
previously collected.

User Name No Yes No Select a job user name. You can prompt from list
of user profiles.

Current User No Yes No Select a current user name. You can prompt from
list of user profiles.

Job Name No Yes No Select a job name. You can prompt from
currently active jobs.

Function No Yes No The job function is a three character code, as
shown on WRKACTJOB. For instance, CMD-*
could be used to selected all jobs running
commands. This can be a generic or specific
entry. If you wanted to select all jobs displaying
menu PAYROLL, for example, enterMNU-
PAYROLL.

Max Jobs In
List

No No No Enter the maximum number of jobs to show in
the details display. You cannot go higher than
30.

Description

The status of the selected job. Displays *NF if not found.
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If the more than one job is found that fits the selection parameters, Robot Monitor selects the more
interesting status. Most status codes are considered uninteresting. The following list shows the
interesting codes in order of ascending interest:

Status Degree of Interest

RUN 1

SIGW 3

DSC 5

INEL 5

MTXW 5

THDW 5

EOJ 10

JVAW 10

SEMW 10

HLD 40

INQW 50

LCKW 60

For instance, if jobs were found that match the filter with statuses of DSPW, RUN, and HLD, Robot
Monitor returns a status of HLD.

Special Status Values

MSGW: MSGW is not quite the same as the MSGW on the WRKACTJOB command. It means the job
is waiting for a message from a queue and does not include jobs waiting for a reply to specific
message, such as a failure message sent to QSYSOPR.

INQW: INQW means the job is waiting for a reply to a message, such as a failure message sent the
QSYSOPR or a printer message sent to the printer's message queue.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x
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OS Yes No

VIOS x

QTemp Count
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No No No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No No No Job accounting code. This is prompted from job
accounting data, so it can only be prompted if
job accounting data has been collected.

User Name No No No Job User Name. Prompted from list of user
profiles.

Current User No No No Prompted from list of user profiles.

Job Name No No No Prompted from currently active jobs.

Function No No No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be either a generic or a specific entry.

Object Name No Yes Yes Type an object name into the value field.

Object Type No Yes Yes Select an object type.

Max Objects
in List

No No No The maximum number of objects to show in the
details display. You cannot go higher than 30.

Description

The number of objects within the QTEMP libraries of jobs with the selected status.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x
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OS Yes No

AIX x

Linux x

VIOS x

QTemp Size
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No No No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No No No Job accounting code. This is prompted from job
accounting data, so it can only be prompted if
job accounting data has been collected.

User Name No No No Job User Name. Prompted from list of user
profiles.

Current User No No No Prompted from list of user profiles.

Job Name No No No Prompted from currently active jobs.

Function No No No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be either a generic or a specific entry.

Object Name No Yes Yes Type an object name into the value field.

Object Type No Yes Yes Select an object type.

Max Objects
in List

No No No The maximum number of objects to show in the
details display. You cannot go higher than 30.

Report size as No No No Allows you to select whether size should be
reported in MB or GB. The default is MB.

Description

The total size of the objects within the QTEMP libraries of jobs with the selected status.

Type

Integer

User Guide www.helpsystems.com page: 331



Data Types and Parameters / Job Status Data Types

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Subsystem Status
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

Yes No No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.
You need to specify a library first before you can
choose a subsystem.

Subsystem
Library

Yes No No The library for the subsystem.

Description

Returns the status of the selected subsystem: up, down, or ending.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Total Jobs in System (Count)
See System Performance Data Types for more information.
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Total Jobs in System (Percentage)
Parameters

None

Description

The total percentage of all jobs that are in the system.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Total Jobs on Output Queue
Parameters

None

Description

The count of all jobs that have finished but still have printed output on output queues.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Memory Pool Performance Data Types
This type of group element monitors the attributes and performance of memory pools for the IBM i.

Memory Pool Performance

Pool Active to Ineligible
Parameters

Values Red Gen *ALL Description

Pool Name No No No Select a pool name.

Description

The number, per second, of active to ineligible transitions for the selected pool.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Pool Active to Wait
Parameters

Values Red Gen *ALL Description

Pool Name No No No Select a pool name.

Description

The number, per second, of active to wait transitions for the selected pool.

Type

Integer
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OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Pool Activity Level
Parameters

Values Red Gen *ALL Description

Pool Name No No No Select a pool name.

Description

The activity level for the selected pool.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Pool Database Faults
Parameters

Values Red Gen *ALL Description

Pool Name No No No Select a pool name.
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Description

The number, per second, of database faults for the selected pool.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Pool Database Pages
Parameters

Values Red Gen *ALL Description

Pool Name No No No Select a pool name.

Description

The number, per second, of database pages for the selected pool.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Pool Faults DB+NDB
Parameters

Values Red Gen *ALL Description

Pool Name No No No Select a pool name.

Description

The number, per second, of DB faults plus the number of NDB faults for the selected pool.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Pool Nondatabase Faults
Parameters

Values Red Gen *ALL Description

Pool Name No No No Select a pool name.

Description

The number, per second, of nondatabase faults for the selected pool.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x
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OS Yes No

AIX x

Linux x

VIOS x

Pool Nondatabase Pages
Parameters

Values Red Gen *ALL Description

Pool Name No No No Select a pool name.

Description

The number, per second, of nondatabase pages for the selected pool.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Pool Reserved Memory
Parameters

Values Red Gen *ALL Description

Pool Name No No No Select a pool name.

Description

The reserved size of the specified memory pool in MB. The reserved size is the amount of memory
reserved by the machine for internal tasks, such as Save/Restore.
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Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Pool Size
Parameters

Values Red Gen *ALL Description

Pool Name No No No Select a pool name.

Description

The size of the specified memory pool in MB.

Type

Integer

Notes

If the scale for an element of this type is left at 0, the program uses the memory allocated to the
partition for the scale value.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Pool Wait to Ineligible
Parameters

Values Red Gen *ALL Description

Pool Name No No No Select a pool name.

Description

The number, per second, of wait to ineligible transitions for the selected pool.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MQ Series Monitors Data Types
Robot Monitor supports a number of monitors for MQ Series (also known as Websphere MQ)
version 6. These are grouped according to the object type monitored.

Some monitor types require monitoring to be enabled for the queue or channel being monitored. If
monitoring is not enabled, MSM will display the message "MQSeries API reports Not Available".

Monitoring can be enabled at the queue manager level, or by individual queue/channel, by using the
chgxxx command to set parameter MONx to the level of monitoring required. *LOW appears to be
sufficient for most cases. The level of monitoring affects the frequency of updates to the internal
counters in MQS.

For example:

CHGMQMQ QNAME('GBCCS207.TO.GBCCS150') MQMNAME('GBCCS207.QUEUE.MANAGER')
MONQ(*LOW)

MQ Channel
This group brings together elements related to the channel, which handles communications with
remote systems.
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MQ Channel Avg Time on Transmit Queue
Parameters

Queue Manager. The name of the queue manager to be monitored, or the name of the queue
manager that owns the object to be monitored. Use *DFT to denote the default queue manager for
this system.

Channel (parameter required). The name of the channel to be monitored. If prompting this
parameter, the queue manager must be selected first.

Description

The average time (in microseconds) each message spends on the transmit queue before being sent
by the channel.

This is not the same as MQ Average Queue Time.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MQ Channel Bytes Received per Second
Parameters

Queue Manager. The name of the queue manager to be monitored, or the name of the queue
manager that owns the object to be monitored. Use *DFT to denote the default queue manager for
this system.

Channel (parameter required). The name of the channel to be monitored. If prompting this
parameter, the queue manager must be selected first.

Description

The average bytes per second received by the channel. This figure is an average measurement
calculated by the channel over the last 64 messages.

Type

Integer
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OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MQ Channel Bytes Sent per Second
Parameters

Queue Manager. The name of the queue manager to be monitored, or the name of the queue
manager that owns the object to be monitored. Use *DFT to denote the default queue manager for
this system.

Channel (parameter required). The name of the channel to be monitored. If prompting this
parameter, the queue manager must be selected first.

Description

The average Bytes per Second sent by the channel. This figure is an average measurement
calculated by the channel over the last 64 messages.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MQ Channel Compression Radio
Parameters

Queue Manager. The name of the queue manager to be monitored, or the name of the queue
manager that owns the object to be monitored. Use *DFT to denote the default queue manager for
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this system.

Channel (parameter required). The name of the channel to be monitored. If prompting this
parameter, the queue manager must be selected first.

Description

A measurement of the amount of data saved by using compression on records sent by the channel.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MQ Channel Compression Time
Parameters

Queue Manager. The name of the queue manager to be monitored, or the name of the queue
manager that owns the object to be monitored. Use *DFT to denote the default queue manager for
this system.

Channel (parameter required). The name of the channel to be monitored. If prompting this
parameter, the queue manager must be selected first.

Description

The average time spent (in microseconds) performing compression for each message. This figure is
an average measurement calculated by the channel over the last 64 messages.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x
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OS Yes No

Linux x

VIOS x

MQ Channel Exit Program Processing Time
Parameters

Queue Manager. The name of the queue manager to be monitored, or the name of the queue
manager that owns the object to be monitored. Use *DFT to denote the default queue manager for
this system.

Channel (parameter required). The name of the channel to be monitored. If prompting this
parameter, the queue manager must be selected first.

Description

The average time spent (in microseconds) by user exit programs for each message. This figure is an
average measurement calculated by the channel over the last 64 messages.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MQ Channel Message Count
Parameters

Queue Manager. The name of the queue manager to be monitored, or the name of the queue
manager that owns the object to be monitored. Use *DFT to denote the default queue manager for
this system.

Channel (parameter required). The name of the channel to be monitored. If prompting this
parameter, the queue manager must be selected first.

Description

The number of messages queued for transmission by the selected channel.
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Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MQ Channel Network Time
Parameters

Queue Manager. The name of the queue manager to be monitored, or the name of the queue
manager that owns the object to be monitored. Use *DFT to denote the default queue manager for
this system.

Channel (parameter required). The name of the channel to be monitored. If prompting this
parameter, the queue manager must be selected first.

Description

The average time taken (in microseconds) for a message sent from the channel to the remote
receiver and for the reply to come back to the channel. This figure is an average measurement
calculated by the channel over the last 64 messages.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MQ Channel Status
Parameters

Queue Manager. The name of the queue manager to be monitored, or the name of the queue
manager that owns the object to be monitored. Use *DFT to denote the default queue manager for
this system.

Channel (parameter required). The name of the channel to be monitored. If prompting this
parameter, the queue manager must be selected first.

Description

The status of the selected channel. Statuses can include active, failed, stopped, and so on.

Type

Alpha, special value

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MQ Listener
This group brings together elements related to named listeners. Listeners handle incoming requests
from remote queue managers.

Only named listeners (those created with CRTMQMLSR) can be monitored.

MQ Listener Status
Parameters

Queue Manager. The name of the queue manager to be monitored, or the queue manager that owns
the object to be monitored. Use *DFT to denote the default queue manager for this system.

Listener (parameter required). The name of the listener to be monitored. If you prompt this
parameter, the queue manager must be selected first. In order to be monitored, the listener must be
named and the name must be specified when the listener is started.

Description

The current status (started, stopped, failed, and so on) for the listener.
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Type

Alpha, special value

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MQ Queue
This group brings together elements related to the queues themselves.

MQ Queue Age of Oldest Message
Parameters

Queue Manager. The name of the queue manager to be monitored, or that queue manager that owns
the object to be monitored. Use *DFT to denote the default queue manager for this system.

Queue (parameter required). The name of the queue to be monitored. If prompting this parameter,
the queue manager must be selected first.

Description

The length of time (in seconds) that the oldest message on the queue has been waiting to be sent or
processed.

Monitoring must be enabled for the queue for this element to return a value.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MQ Queue Application Status
Parameters

Queue Manager. The name of the queue manager to be monitored, or the queue manager that owns
the object to be monitored. Use *DFT to denote the default queue manager for this system.

Queue (parameter required). The name of the queue to be monitored. If prompting this parameter,
the queue manager must be selected first.

Description

This is a status code, derived from the state of the queue and its application. This is calculated as
follows.

If the queue has no messages on it:

l If the queue is open for input, then R (Ready) is returned. There are no messages, but an
application is waiting to process any that arrive.

l If the queue is not open for input, then Q (Quiet) is returned.

If the queue has messages on it:

l If the queue is open for input, then A (Active) is returned. There are messages, and an
application is processing them.

l If the queue is not open for input, then M is returned. This could indicate a problem with the
application, as messages are waiting to be processed but no application is running to do this.

Type

Alpha, special values

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MQ Queue Average Queue Time
Parameters

Queue Manager. The name of the queue manager to be monitored, or the queue manager that owns
the object to be monitored. Use *DFT to denote the default queue manager for this system.
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Queue (parameter required). The name of the queue to be monitored. If prompting this parameter,
the queue manager must be selected first.

Description

The average length of time (in microseconds) that each message spends on the queue before being
sent or processed. This is principally useful for queues that receive messages and gives a
measurement of the length of time taken by the application to process these messages.

In order for this element to return a value, monitoring for the queue must be enabled.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MQ Queue Depth
Parameters

Queue Manager. The name of the queue manager to be monitored, or the queue manager that owns
the object to be monitored. Use *DFT to denote the default queue manager for this system.

Queue. The name of the queue to be monitored. If prompting this parameter, the queue manager
must be selected first.

Description

The number of messages on the queue waiting to be sent or processed.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x
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OS Yes No

Linux x

VIOS x

MQ Queue Depth/Maximum
Parameters

Queue Manager. The name of the queue manager to be monitored, or the queue manager that owns
the object to be monitored. Use *DFT to denote the default queue manager for this system.

Queue (parameter required). The name of the queue to be monitored. If prompting this parameter,
the queue manager must be selected first.

Description

The number of messages on the queue, as a percentage of the maximum number of messages
allowed. A figure of 100% would mean the queue can accept no more messages.

Type

Complex

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MQ Queue Depth/Trigger
Parameters

Queue Manager. The name of the queue manager to be monitored, or the queue manager that owns
the object to be monitored. Use *DFT to denote the default queue manager for this system.

Queue (parameter required). The name of the queue to be monitored. If prompting this parameter,
the queue manager must be selected first.

Description

The number of messages on the queue, as a percentage of the trigger depth. A figure of 100% or
more would mean the trigger event should have taken place. Very high figures could indicate a
problem with the application processing the queue.
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Type

Complex

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MQ Queue Open Count - Input
Parameters

Queue Manager. The name of the queue manager to be monitored, or the queue manager that owns
the object to be monitored. Use *DFT to denote the default queue manager for this system.

Queue (parameter required). The name of the queue to be monitored. If prompting this parameter,
the queue manager must be selected first.

Description

The number of applications that have the queue open for input.

Type

Complex

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MQ Queue Open Count - Output
Parameters

Queue Manager. The name of the queue manager to be monitored, or the queue manager that owns
the object to be monitored. Use *DFT to denote the default queue manager for this system.

Queue (parameter required). The name of the queue to be monitored. If prompting this parameter,
the queue manager must be selected first.

Description

The number of applications that have the queue open for output.

Type

Complex

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MQ Queue Uncommitted Message Count
Parameters

Queue Manager. The name of the queue manager to be monitored, or the queue manager that owns
the object to be monitored. Use *DFT to denote the default queue manager for this system.

Queue (parameter required). The name of the queue to be monitored. If prompting this parameter,
the queue manager must be selected first.

Description

The number of uncommitted messages on the queue. Uncommitted messages are messages that need
to be committed or rolled back.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MQ Queue Manager
This group brings together elements related to the queue manager.

MQ Queue Manager Channel Initiator Status
Parameters

Queue Manager. The name of the queue manager to be monitored, or the name of the queue
manager that owns the object to be monitored. Use *DFT to denote the default queue manager for
this system.

Description

The status of the initiator for the selected queue manager. Statuses can include active, failed,
stopped, and so on.

Type

Alpha, special value

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MQ Queue Manager Command Server Status
Parameters

Queue Manager. The name of the queue manager to be monitored, or the name of the queue
manager that owns the object to be monitored. Use *DFT to denote the default queue manager for
this system.
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Description

The status of the command server for the selected queue manager. Statuses can include active,
failed, and so on.

Type

Alpha, special value

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

MQ Queue Manager Connection Count
Parameters

Queue Manager. The name of the queue manager to be monitored, or the name of the queue
manager that owns the object to be monitored. Use *DFT to denote the default queue manager for
this system.

Description

The number of connections to the queue manager.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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MQ Queue Manager Status
Parameters

Queue Manager. The name of the queue manager to be monitored, or the name of the queue
manager that owns the object to be monitored. Use *DFT to denote the default queue manager for
this system.

Description

The status of the selected queue manager. Statuses can include active, stopped, and so on.

Type

Alpha, special value

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Objects Data Types
This group of element types monitors objects or groups of objects, such as size of number of delete
records.

TIP: In the following tables, 'Rqd' means the parameter is required, 'Gen' means the parameter
can be generic, and '*ALL' means select all instances for the parameter.

Data Queue Entries
Parameters

Parameter Rqd Gen *ALL Notes

Data Queue Yes No No Select or enter name of the data queue you
want.Note: You must specify a library before
you can prompt this value.

Library Yes No No Select a library.
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Description

The number of entries on the specified data queue.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Data Queue Percent
Parameters

Parameter Rqd Gen *ALL Notes

Data Queue Yes No No Select or enter name of the data
queue you want.Note: You must
specify a library before you can
prompt this value.

Library Yes No No Select a library.

Description

The percentage of capacity used by entries waiting on the specified data queue.

Notes

Data queues have a maximum size and entry length. From these figures, it is possible to calculate the
percentage of available capacity for a data queue. Once it reaches 100%, it will not accept further
entries.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x
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OS Yes No

AIX x

Linux x

VIOS x

Distribution Queue Entries
Parameters

Parameter Rqd Gen *ALL Notes

Distribution Queue No No No Choose a
distribution queue
name.

Description

The number of entries on the selected distribution queue.

Type

Integer

Notes

At security level 30, the collection for this data type is very efficient as the program looks directly
at the SNADS internal control areas. For higher security levels, a print-scraping approach is used.
However, if one element of this type is defined, adding more will not increase the overhead, as the
program fetches information for all queues regardless. The print-scraping approach is also used if
Distribution Queue Status is selected for any element.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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File Deleted Record Count
Parameters

Parameter Rqd Gen *ALL Notes

Object Name Yes Yes Yes Select or enter name of the object you
want.Note: You must specify a library
before you can prompt this value.

Library Name Yes No Yes Select a library name.

ASP Device
Name

No No No Select an ASP device name.

Description

The number of deleted records in the files specified.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

File Deleted Record Percentage
Parameters

Parameter Rqd Gen *ALL Notes

Object Name Yes No No Select or enter name of the object you
want.Note: You must specify a library
before you can prompt this value.

Library Name Yes No No Select a library name.

ASP Device
Name

No No No Select an ASP device name.
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Description

The percentage of deleted records in the specified files.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

File Record Count
Parameters

Parameter Rqd Gen *ALL Notes

Object Name Yes Yes Yes Select or enter name of the object you
want.Note: You must specify a library
before you can prompt this value.

Library Name Yes No Yes Select a library name.

ASP Device
Name

No No No Select an ASP device name.

Description

The number of records in the files specified. This figure does not include deleted records.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x
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OS Yes No

Linux x

VIOS x

Journal Receiver Size
Parameters

Parameter Rqd Gen *ALL Notes

Journal Yes No No Select or enter name of the journal
you want.Note: You must specify a
library before you can prompt this
value.

Library Yes No No Select a library name.

Description

The total size, in megabytes, of all receivers attached to the specified journal.

Type

Integer

Notes

Make sure you specify the journal, not the receiver name. The monitor will find all receivers
associated with the journal and tally their sizes.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

User Guide www.helpsystems.com page: 360



Data Types and Parameters / Objects Data Types

Journal Status
Parameters

Parameter Rqd Gen *ALL Notes

Journal Yes No No Select or enter name of the journal
you want.Note: You must specify a
library before you can prompt this
value.

Library Yes No No Select a library name.

Description

The status of the journal.

Type

Text

Notes

This is mostly useful for remote journals and shows whether the journal is active and communicating
with the remote system.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Largest Library
Parameters

Parameter Rqd Gen *ALL Notes

Object Name No Yes Yes Select or enter name of the
object you want.Note: You
must specify a library and
object type before you can
prompt this value.
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Parameter Rqd Gen *ALL Notes

Library Name No No Yes Select a library name.

Object Type No No Yes Select an object type.

Object Attribute No No No Type an object attribute into
the value field.

Owner No No No Select the owner of the object.

Max Libraries in
List

No No No Enter how many libraries
should be in the list.

Report size as No No No Choose whether you want the
size reported in megabytes
(MB) or gigabytes (GB).

ASP Device
Name

No No No Select an ASP device name.

Description

The total size of the objects specified.

Type

Integer

Notes

The 'largest object' and 'largest library' elements are always drawn from the disk data collection
results, so real time collection is a good idea if you intend to use these element types.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Largest Object
Parameters

Parameter Rqd Gen *ALL Notes

Object Name No Yes Yes Select or enter name of the
object you want.Note: You
must specify a library and
object type before you can
prompt this value.

Library Name No No Yes Select a library name.

Object Type No No Yes Select an object type.

Object Attribute No No No Type an object attribute into
the value field.

Owner No No No Select the owner of the object.

Max Objects in
List

No No No Enter how many objects
should be in the list.

Report size as No No No Choose whether you want the
size reported in megabytes
(MB) or gigabytes (GB).

ASP Device
Name

No No No Select an ASP device name.

Description

The size of the largest object that meets the criteria.

Type

Integer

Notes

The 'largest object' and 'largest library' elements are always drawn from the disk data collection
results, so real time collection is a good idea if you intend to use these element types.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x
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OS Yes No

Linux x

VIOS x

Network File Count
Parameters

Parameter Rqd Gen *ALL Notes

User No No No Select or enter name of the user
you want.

Description

The number of network files waiting to be received by a specified user. This is equivalent to the
number of files shown for the WRKNETF command.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Object Count
Parameters

Parameter Rqd Gen *ALL Notes

Object Name Yes Yes Yes Select or enter name of the object you
want.Note: You must specify a library
before you can prompt this value.

Library Name Yes No Yes Select a library name.

Object Type Yes No Yes Select an object type.
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Parameter Rqd Gen *ALL Notes

ASP Device
Name

No No No Select an ASP device name.

Description

The total count of the objects specified.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Object Size
Parameters

Parameter Rqd Gen *ALL Notes

Object Name Yes Yes Yes Select or enter name of the object you
want.Note: You must specify a
library before you can prompt this
value.

Library Name Yes No Yes Select a library name.

Object Type Yes No Yes Select an object type.

Report size as No No No Choose whether you want the size
reported in megabytes (MB) or
gigabytes (GB). See the section on
notes below for more details.

ASP Device
Name

No No No Select an ASP device name.

Description

The total size of the objects specified.
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Type

Integer

Notes

The size is always collected and stored in MB (1 MB = 1048576 bytes). This means that objects of
less than 1 MB in size will show as a size of 0.

Report size as only changes the way the figure is presented, not the way it is stored. It can be
changed at any time.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Output Queue Status
Parameters

Parameter Rqd Gen *ALL Notes

Output
queue

Yes No No Select or enter name of the output
queue you want.Note: You must
specify a library before you can
prompt this value.

Library Yes No No Select a library name.

Description

The status of the specified output queue, including held, no writer, writing, and so on.

See the section on notes below for more details.

Type

Text

Notes

If the queue has no writer, then the queue's status is returned.

If the queue has an active writer, then the writer's status is returned.
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For queues with remote writers, limited information is returned for the writer. Robot Monitor shows
whether the writer is active, but no more.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

QTemp Count
See Job Status Data Types for more information.

QTemp Size
See Job Status Data Types for more information.

Remote Journal Lag
Parameters

Parameter Rqd Gen *ALL Notes

Remote
Journal

Yes No No Select or enter name of the remote
journal you want.Note: You must
specify a library before you can
prompt this value.

Library Yes No No Select a library name.

Description

The number of entries behind the remote journal is from the source journal.

Type

Integer

Notes

You must specify the remote journal, rather than the source journal, for this function. A source
journal can have many remotes, so specifying the source journal would not make any sense.
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For the system with the source journal
Robot Monitor will locate the source journal for the specified remote journal and start a
communications job with that system.

Robot Monitor must be installed on the system with the source journal, although it does not have to
be running. If you want to use TCP, the TCP server is required. The MSM user profile and password
also need to match the one used on the systems being monitored by MSM. No MSM license is
required for this system.

Because the program gets the system name for the system with the source journal, it then has to
make a few guesses as to how to connect to it. The system name is not necessarily the name by
which it is known to MSM, if it is known to MSM at all. It does not have to beconfigured as an MSM
system, although setting up at least a system entry (with Always Monitor set to X) is probably a good
idea.

The program uses the following three methods to determine the system name (tried in order):

1. It tries to find the system name in the Relational Database directory. If found, it will use the
connection details found there.

2. It looks up the system name in the DNS table. If found, it will use the IP address from there.

3. It will use the system name as a location name for an SNA connection.

For the system with the remote journal
MSMmust be installed and running.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Spool File Count
Parameters

Parameter Rqd Gen *ALL Notes

Output
queue

Yes No No Select or enter name of the output
queue you want.Note: You must
specify a library before you can
prompt this value.

Library Yes No No Select a library name.
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Description

The number of files on the specified output queue.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

System Performance Data Types
This type of group element monitors items that reflect or affect system performance, such as CPU
usage.

TIP: In the following tables, 'Rqd' means the parameter is required, 'Gen' means the parameter
can be generic, and '*ALL' means select all instances for the parameter.

Active Batch Jobs
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No Yes No Job accounting code. This is prompted from job
accounting data, so it can only be prompted if
job accounting data has been collected.

User Name No Yes No Job User Name. Prompted from list of user
profiles.

Current User No Yes No Prompted from list of user profiles.

Job Name No Yes No Prompted from currently active jobs.
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Parameter Rqd Gen *ALL Notes

Function No Yes No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be a generic or specific entry. If you wanted
to select all jobs displaying menu PAYROLL, you
would enterMNU-PAYROLL.

Max Jobs In
List

No No No The maximum number of jobs to show in the
details display.

Description

The number of active batch jobs meeting the selection criteria. A batch job is considered active if it
used at least 100 milliseconds of CPU time during the monitoring interval.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Active Interactive Jobs
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

No Yes No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.

Accounting
Code

No Yes No Job accounting code. This is prompted from job
accounting data and can only be prompted if job
accounting data has been collected.

User Name No Yes No Job User Name. Prompted from list of user
profiles.

Current User No Yes No Prompted from list of user profiles.
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Parameter Rqd Gen *ALL Notes

Job Name No Yes No Prompted from currently active jobs.

Function No Yes No Job function is a three character code, as shown
on WRKACTJOB. For instance, CMD-* could be
used to selected all jobs running commands. This
can be a generic or specific entry. If you want to
select all jobs displaying the menu PAYROLL,
enterMNU-PAYROLL.

Max Jobs In
List

No No No The maximum number of jobs to show in the
details display.

Description

The number of interactive jobs meeting the selection criteria that have processed at least one
transaction during the monitoring interval.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

CFInt Overhead
Parameters

Parameter Rqd Gen *ALL Notes

Max Jobs in List No No No Enter a number between 1 and 30.

Description

The percentage of CPU being used by CFInt microcode tasks.

Notes

On some older models, processor limits such as interactive capacity are enforced by microcode tasks
known as the CFInt tasks. These start using CPU as interactive usage approaches capacity, and they
can run completely out of control, taking up 100% of the system if left unchecked.
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Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

CPU Seconds per Transaction
See Built-in Element Types for more information.

CPU Usage
See Built-in Element Types for more information.

CPW Available
Parameters

None

Description

The CPW rating of the partition.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x
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OS Yes No

VIOS x

Example

A system has two processors and a CPW rating of 1,000. A partition is allocated one processor. The
CPW available to that partition is 500.

CPW Percent of Available
Parameters

None

Description

The percentage of CPW being used.

Type

Composite

Notes

This figure is equivalent to CPU usage scaled to 100% for single partitions. This is particularly useful
when you want to summarize CPU usage across partitions.

Because this is a composite figure based on CPW usage, it can be used to produce meaningful results
when averages are calculated across partitions.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

CPW Percent of Configured
Parameters

None

Description

The percentage of CPW being used.
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Type

Composite

Notes

This figure is equivalent to CPU usage for single partitions. For partitions configured with capacity on
demand, this figure can go over 100%. This is particularly useful when you want to summarize CPU
usage across partitions.

Because this is a composite figure based on CPW usage, it can be used to produce meaningful results
when averages are calculated across partitions.

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

CPW Used
Parameters

None

Description

The CPW used on the partition.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

User Guide www.helpsystems.com page: 374



Data Types and Parameters / System Performance Data Types

Example

A system has two processors and a CPW rating of 1,000. A partition is allocated one processor. The
CPW available to that partition is 500. CPU usage is 75%. The CPW used on that partition is 375.

Database CPU Usage
See Built-in Element Types for more information.

Disk I/O
See Job Performance Data Types for more information.

Faults per Second
See Job Performance Data Types for more information.

Interactive Capacity Used
Parameters

None

Description

The percentage of the interactive capacity used for the partition.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Example

A system has an interactive capacity of 8%. Interactive CPU is running at 4%. The Interactive
Capacity Used is 50%.
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Interactive CPU Usage
See Built-in Element Types for more information.

LockWait Time
See Job Performance Data Types for more information.

Microcode Overhead
Parameters

Parameter Rqd Gen *ALL Notes

Max Jobs in List No No No Enter a number between 1 and 30.

Description

The percentage of CPU being used by microcode overhead.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Permanent Addresses Used
Parameters

None

Description

The percentage of possible permanent addresses used by the system.
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Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Processors Used
Parameters

Parameter Rqd Gen *ALL Notes

Status No No No Select a status.

Description

The number of available processors being used. If 8 processors are available and the CPU
percentage is 50%, the Processors Used value totals to 4 (50% of 8).

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Response Time
See Built-in Element Types for more information.
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Subsystem Transactions/Hour
See Job Performance Data Types for more information.

System Overhead
Parameters

Parameter Rqd Gen *ALL Notes

Max Jobs in List No No No Enter a number between 1 and 30.

Description

The percentage of CPU being used by system tasks. System tasks include system jobs, microcode
tasks, subsystem monitors, spool readers and writers, and SCPF.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Temporary Addresses Used
Parameters

None

Description

The percentage of possible temporary addresses used by the system.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Temporary Storage per Job
See Job Performance Data Types for more information.

Temporary Storage Total
See Job Performance Data Types for more information.

Thread Count per Job
See Job Performance Data Types for more information.

Thread Count Total
See Job Performance Data Types for more information.

Total Jobs in System (Count)
Parameters

None

Description

Total jobs in system. This figure includes all job types, including subsystem monitors and system jobs.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Total Jobs in System (Percent)
Parameters

None

Description

Total jobs in system as a percentage of the configured maximum (system value QMAXJOB). This
figure includes all job types, including subsystem monitors and system jobs.

Type

Complex

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

W/I Over A/W
Parameters

Values Red Gen *ALL Description

Pool Name No No No Select a pool name.

Description

A figure derived by dividing wait to ineligible transitions by active to wait.

Type

Float
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OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Unix Communication Adapters Data Types
This group of element types monitors communication adapters for AIX and VIOS partitions.

TIP: In the following tables, 'Rqd' means the parameter is required, 'Gen' means the parameter
can be generic, and '*ALL' means select all instances for the parameter.

Communications Adapter > 1 Retry
Parameters

Parameter Rqd Gen *ALL Notes

Communications Adapter Yes No No The communications adapter name.

Description

Returns the number of times one to fifteen retries were required to send a packet by this adapter. If
the figure is consistently high, it is a possible indication that serious collisions are taking place.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Communications Adapter > 16 Retries
Parameters

Parameter Rqd Gen *ALL Notes

Communications Adapter Yes No No The communications adapter name.

Description

Returns the number of times more than sixteen retries were required to send a packet by this
adapter. If the figure is consistently high, it is an indication that serious collisions or other errors are
taking place.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Communications Adapter 1 Retry
Parameters

Parameter Rqd Gen *ALL Notes

Communications Adapter Yes No No The communications adapter name.

Description

Returns the number of exact times one retry was required to send a packet by this adapter. This is
an incredible that low level collisions are taking place.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Communications Adapter Collisions
Parameters

Parameter Rqd Gen *ALL Notes

Communications Adapter Yes No No The communications adapter name.

Description

Returns the number of transmission collisions detected for the specified adapter over the sample
interval.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Communications Adapter Packets Received
Parameters

Parameter Rqd Gen *ALL Notes

Communications Adapter Yes No No The communications adapter name.

Description

Returns the number of packets received for the specified adapter over the sample interval.
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Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Communications Adapter Packets Transmitted
Parameters

Parameter Rqd Gen *ALL Notes

Communications Adapter Yes No No The communications adapter name.

Description

Returns the number of packets transmitted for the specified adapter over the sample interval.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Communications Adapter Receive Errors
Parameters

Parameter Rqd Gen *ALL Notes

Communications Adapter Yes No No The communications adapter name.

Description

Returns the number of input errors for the specified adapter over the sample interval.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Communications Adapter Receive Throughput
Parameters

Parameter Rqd Gen *ALL Notes

Communications Adapter Yes No No The communications adapter name.

Description

Returns (in KB) the data received during the sample interval for the specified network adapter.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x
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OS Yes No

AIX x

Linux x

VIOS x

Communications Adapter Transmit Errors
Parameters

Parameter Rqd Gen *ALL Notes

Communications Adapter Yes No No The communications adapter name.

Description

Returns the number of output errors for the specified adapter over the sample interval.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Communications Adapter Transmit Throughput
Parameters

Parameter Rqd Gen *ALL Notes

Communications Adapter Yes No No The communications adapter name.

Description

Returns (in KB) the data transmitted during the sample interval for the specified network adapter.

Type

Float
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OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Unix Communication Interfaces Data Types
This group of element types monitors communication interfaces for AIX, Linux, and VIOS partitions.

TIP: In the following tables, 'Rqd' means the parameter is required, 'Gen' means the parameter
can be generic, and '*ALL' means select all instances for the parameter.

Communications Interface Collisions
Parameters

Parameter Rqd Gen *ALL Notes

Communications Interface Yes No No The communications interface
name.

Description

Returns the number of transmission collisions detected over the sample interval for the specified
network interface.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Communications Interface Packets Received
Parameters

Parameter Rqd Gen *ALL Notes

Communications Interface Yes No No The communications interface
name.

Description

Returns the number of packets received over the sample interval on the network interface.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Communications Interface Packets Transmitted
Parameters

Parameter Rqd Gen *ALL Notes

Communications Interface Yes No No The communications interface
name.

Description

Returns the number of packets transmitted over the sample interval on the network interface.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Communications Interface Receive Errors
Parameters

Parameter Rqd Gen *ALL Notes

Communications Interface Yes No No The communications interface
name.

Description

Returns the number of input errors detected over the sample interval for the specified network
interface.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Communications Interface Receive Throughput
Parameters

Parameter Rqd Gen *ALL Notes

Communications Interface Yes No No The communications interface
name.
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Description

Returns the data received, in KB per second, over the sample interval on the specified interface.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Communications Interface Transmit Errors
Parameters

Parameter Rqd Gen *ALL Notes

Communications Interface Yes No No The communications interface
name.

Description

Returns the number of output errors over the sample interval for the specified network interface.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Communications Interface Transmit Throughput
Parameters

Parameter Rqd Gen *ALL Notes

Communications Interface Yes No No The communications interface
name.

Description

Returns the data transmitted, in KB per second, over the sample interval for the specified network
interface.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Communications Interface Utilization
Parameters

Parameter Rqd Gen *ALL Notes

Communications Interface Yes No No The communications interface
name.

Description

Returns the percentage of capacity used over the sample interval for the specified network
interface.

Notes

Robot Monitor takes the “line” speed from the network interface configuration and the number of
bytes received and transmitted. From this, it estimates the percentage of capacity used. For a full
duplex line, it takes the larger of bytes sent and received and divides it by the line speed x the
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interval time. For a half-duplex line, it adds the two byte counts and divides the sum by the line
speed x the interval time.

This will result as 0 for interfaces that do not report a line speed (for example, the loopback
interface). Full duplex configuration is assumed.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Unix Disk Adapters Data Types
This group of element types monitors disk adapters for AIX and VIOS partitions.

TIP: In the following tables, 'Rqd' means the parameter is required, 'Gen' means the parameter
can be generic, and '*ALL' means select all instances for the parameter.

NOTE: For all adapter metrics, if the adapter is not found on the node, Robot Monitor returns a
value of *NF.

Adapter Frame Error Count
Parameters

Parameter Rqd Gen *ALL Notes

Adapter Yes No No The disk adapter name.

Description

Returns the total number of frames received with errors over the collection interval. This is only
available for fiber-channel adapters (otherwise, Robot Monitor returns a value of *NA).

Type

Integer
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OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Adapter Link Failure Count
Parameters

Parameter Rqd Gen *ALL Notes

Adapter Yes No No The disk adapter name.

Description

Returns the total number of link failure events over the collection interval. This is only available for
fiber-channel adapters (otherwise, Robot Monitor returns a value of *NA).

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Adapter Read Throughput
Parameters

Parameter Rqd Gen *ALL Notes

Adapter Yes No No The disk adapter name.
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Description

Returns the amount of data read, in KB per second, through the adapter over the collection interval.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Adapter Transfer Rate
Parameters

Parameter Rqd Gen *ALL Notes

Adapter Yes No No The disk adapter name.

Description

Returns the rate of data transfer (to+from) the disks connected to this adapter (requests/sec).

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Adapter Write Throughput
Parameters

Parameter Rqd Gen *ALL Notes

Adapter Yes No No The disk adapter name.

Description

Returns the amount of data written, in KB per second, through the adapter over the collection
interval.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Free Disk Space Across All Disks on Adapter
Parameters

Parameter Rqd Gen *ALL Notes

Adapter Yes No No The disk adapter name.

Description

Returns the amount of free disk space remaining across disks connected to this adapter. If we cannot
get the necessary data from the adapter, the value will be *NA. If the scale value is left as 0, Robot
Monitor uses the total size of all connected disks as the scale value.

Reports as GB or TB, with a default of GB.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Name of Busiest Disk on Adapter
Parameters

Parameter Rqd Gen *ALL Notes

Adapter Yes No No The disk adapter name.

Description

Returns the name of the disk that is busiest, in definition order, for the selected adapter. If no disk
statistics are available, Robot Monitor returns a value of *NA.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Percentage Busy of Busiest Disk on Adapter
Parameters

Parameter Rqd Gen *ALL Notes

Adapter Yes No No The disk adapter name.
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Description

Returns the percent busy of the busiest disk for the selected adapter. If no disk statistics are
available, Robot Monitor returns a value of *NA.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Percentage of Disk Space Across All Disks on
Adapter
Parameters

Parameter Rqd Gen *ALL Notes

Adapter Yes No No The disk adapter name.

Description

Returns the percentage of disk space used across disks connected to this adapter. If no disk statistics
are available, Robot Monitor returns a value of *NA.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Percentage of Time Disks on Adapter Busy
Parameters

Parameter Rqd Gen *ALL Notes

Adapter Yes No No The disk adapter name.

Description

Returns the percentage of time disks were busy for the selected adapter. If no disk statistics are
available, Robot Monitor returns a value of *NA.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Status of Disk Adapter
Parameters

Parameter Rqd Gen *ALL Notes

Adapter Yes No No The disk adapter name.

Description

Returns the status of the disk adapter. It can show a status of available, stopped, defined, or
undefined.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Usage of Disk Space Across All Disks on Adapter
Parameters

Parameter Rqd Gen *ALL Notes

Adapter Yes No No The disk adapter name.

Description

Returns the percentage of disk space used across all disks connected to this adapter. If no disk
statistics are available, Robot Monitor returns a value of *NA

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Unix File System Monitors Data Types
This group of element types monitors file system monitors for AIX, Linux, and VIOS partitions.

TIP: In the following tables, 'Rqd' means the parameter is required, 'Gen' means the parameter
can be generic, and '*ALL' means select all instances for the parameter.
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Error Report Count
Parameters

Parameter Rqd Gen *ALL Notes

Label No No Yes Label text

Class No No Yes Any combination of H, S, O, U (hardware,
software, operator, undefined)

Type No No Yes Any of P, T, I, U (permanent, temporary,
information, unknown)

Resource
Name

No No Yes Name of resource

Description

Returns the number of error reports meeting the selection criteria of the configured parameters
during the Collection Interval.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

File Count
Parameters

Parameter Rqd Gen *ALL Notes

Path Name Yes No No The starting directory.
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Parameter Rqd Gen *ALL Notes

File Name No No No Defaults to *. May include simple wildcards: ?
to represent one character, or * to represent
more. May not include path elements '..' or
'/'.

Max Depth No No Yes Maximum path depth (number of levels to
seek in the directory tree). The default is
'*ALL'. '0' means to search no further than
the starting directory.

Type No No No One or more of the following: b (block files), c
(character files), d (directory), l (filesystem
link), f (regular file), p (named pipe file), s
(socket file), 'empty' (default - any type)

Owner No No No The account name or UID for the file or
directory.

Group No No No The group name or GID for the file or
directory.

Permissions No No No File or directory permissions, in octal
representation.

Max Files in
List

No No No This is the maximum number of files to
include in results.

Description

Returns the number of files under the starting directory meeting the selection criteria of the
configured parameters.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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File Size
Parameters

Parameter Rqd Gen *ALL Notes

Path Name Yes No No The starting directory.

File Name No No No Defaults to *. May include simple wildcards: ?
to represent one character, or * to represent
more. May not include path elements '..' or
'/'.

Max Depth No No Yes Maximum path depth (number of levels to
seek in the directory tree). The default is
'*ALL'. '0' means to search no further than
the starting directory.

Type No No No One or more of the following: b (block files), c
(character files), d (directory), l (filesystem
link), f (regular file), p (named pipe file), s
(socket file), 'empty' (default - any type)

Owner No No No The account name or UID for the file or
directory.

Group No No No The group name or GID for the file or
directory.

Permissions No No No File or directory permissions, in octal
representation.

Max Files in
List

No No No This is the maximum number of files to
include in results.

Description

Returns the size of all files under the starting directory meeting the selection criteria of the
configured parameters.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x
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OS Yes No

AIX x

Linux x

VIOS x

Filesystem Blocks Free
Parameters

Parameter Rqd Gen *ALL Notes

Mount Point Yes No No The mount point.

Description

Returns the amount of free disk space remaining. If the scale value for this type is left as 0, Robot
Monitor uses the disk size as the scale value.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Filesystem Blocks Used
Parameters

Parameter Rqd Gen *ALL Notes

Mount Point Yes No No The mount point.

Description

Returns the number of file system blocks used.
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Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Filesystem Device Name
Parameters

Parameter Rqd Gen *ALL Notes

Mount Point Yes No No The mount point.

Description

Returns the device name of a mounted file system. This may map to a local volume if under the
control of a volume group.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Filesystem Inode Usage
Parameters

Parameter Rqd Gen *ALL Notes

Mount Point Yes No No The mount point.

Description

Returns the percentage of total available inodes that are in use.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Filesystem Inodes Free
Parameters

Parameter Rqd Gen *ALL Notes

Mount Point Yes No No The mount point.

Description

Returns the number of file system inodes free. File system entries (files and directories) each have
an inode. it is possible to have a file system with space free on which you cannot create new files
due to a lack of inodes.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Filesystem Inodes Used
Parameters

Parameter Rqd Gen *ALL Notes

Mount Point Yes No No The mount point.

Description

Returns the number of file system inodes used.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Filesystem Mounted State
Parameters

Parameter Rqd Gen *ALL Notes

Mount Point Yes No No The mount point.

Description

Returns 0 if not mounted, or 1 if mounted.
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Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Filesystem Space Free
Parameters

Parameter Rqd Gen *ALL Notes

Mount Point Yes No No The mount point.

Description

Returns the amount of free disk space remaining. If the scale value for this type is left as 0, Robot
Monitor uses the disk size as the scale value.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Filesystem Space Usage
Parameters

Parameter Rqd Gen *ALL Notes

Mount Point Yes No No The mount point.

Description

Returns the percentage of space used for the selected file system.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Filesystem Space Used
Parameters

Parameter Rqd Gen *ALL Notes

Mount Point Yes No No The mount point.

Description

Returns the amount of file system space used. If the scale value for this type is left as 0, Robot
Monitor uses the file system size as the scale value.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Unix Logical Volumes Data Types
This group of element types monitors logical volumes for AIX, Linux, and VIOS partitions.

TIP: In the following tables, 'Rqd' means the parameter is required, 'Gen' means the parameter
can be generic, and '*ALL' means select all instances for the parameter.

Logical Volume Read Throughput
Parameters

Parameter Rqd Gen *ALL Notes

Logical Volume Yes No No The logical volume name.

Description

Returns the data read rate, in KB per second, over the collection interval.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Logical Volume Stale PP Count
Parameters

Parameter Rqd Gen *ALL Notes

Logical Volume Yes No No The logical volume name.

Description

Returns the total number of stale physical partitions in the volume group.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Logical Volume Status
Parameters

Parameter Rqd Gen *ALL Notes

Logical Volume Yes No No The logical volume name.

Description

Returns the status of the selected logical volume. The status can be undefined, defined, opened/stale,
opened/synced, or closed.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

User Guide www.helpsystems.com page: 410



Data Types and Parameters / Unix Logical Volumes Data Types

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Logical Volume Transfer Rate
Parameters

Parameter Rqd Gen *ALL Notes

Logical Volume Yes No No The logical volume name.

Description

The transfer rate (in and out) in requests per second over the collection interval.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Logical VolumeWrite Throughput
Parameters

Parameter Rqd Gen *ALL Notes

Logical Volume Yes No No The logical volume name.

Description

Returns the data write rate, in KB per second, over the collection interval.
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Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Unix Memory Data Types
This type of group element monitors the details of the memory allocated to the partition for Unix.

Page Faults per Second
Parameters

None

Description

The number of page faults per second over the sample interval. This includes faults that do not cause
disk activity.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Pages Read from Paging Space, per Second
Parameters

None

Description

The number of pages read from paging space per second over the sample interval.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Pages Written to Paging Space, per Second
Parameters

None

Description

The number of pages written to paging space per second over the sample interval.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Percentage of Memory Used by Processes
Parameters

None

Description

The total percentage of real memory allocated to computational page frames (processes).

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Real Memory Free
Parameters

None

Description

The amount (in MB) of physical memory remaining unused, taken at the end of the sample interval. If
the scale value for this data is left as 0, Robot Monitor uses the total physical memory as the scale
value.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x
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OS Yes No

Linux x

VIOS x

Real Memory Usage
Parameters

None

Description

The amount of used physical memory, as a percentage of total physical memory. This is taken at the
end of the sample interval.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Real Memory Used
Parameters

None

Description

The amount (in MB) of physical memory in use at the end of the sample interval. If the scale value
for this data is left as 0, Robot Monitor uses the total physical memory as the scale value.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Swap Space Free
Parameters

None

Description

The amount (in MB) of swap space remaining unused at the end of the sample interval. If the scale
value for this data is left as 0, Robot Monitor uses the total virtual memory as the scale value.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Swap Space Usage
Parameters

None

Description

Swap space utilization, as a percentage of total swap size. This is taken at the end of the sample
interval.

Type

Composite
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OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Swap Space Used
Parameters

None

Description

The amount (in MB) of swap space used at the end of the sample interval. If the scale value for this
data is left as 0, Robot Monitor uses the total virtual memory as the scale value.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Total Virtual Memory
Parameters

None

Description

The total size (in MB) of active swap space taken at the end of the sample interval.
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Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Unix Physical Disks Data Types
This group of element types monitors physical disks for AIX, Linux, and VIOS partitions.

TIP: In the following tables, 'Rqd' means the parameter is required, 'Gen' means the parameter
can be generic, and '*ALL' means select all instances for the parameter.

Average Disk I/O Queue Length
Parameters

Parameter Rqd Gen *ALL Notes

Disk Yes No No The disk name.

Description

The average length of the queue of I/O requests issued to the device over the collection interval.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x
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OS Yes No

VIOS x

Average Disk Service Time
Parameters

Parameter Rqd Gen *ALL Notes

Disk Yes No No The disk name.

Description

The average service time in milliseconds for I/O requests that were issued to the device over the
collection interval. This includes wait time and I/O time.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Disk I/O Wait Time
Parameters

Parameter Rqd Gen *ALL Notes

Disk Yes No No The disk name.

Description

The average time in milliseconds for I/O requests issued to the device to be served over the
collection period. This includes the time spent by the requests in the wait queue and the time spent
servicing them.

Type

Float
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OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Disk Read Throughput
Parameters

Parameter Rqd Gen *ALL Notes

Disk Yes No No The disk name.

Description

The amount of data read, in KB per second, from the device over the collection interval.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Disk Space Free
Parameters

Parameter Rqd Gen *ALL Notes

Disk Yes No No The disk name. Select GB or TB - default is GB.
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Description

The amount of free disk space remaining. If the scale value for this type is left as 0, Robot Monitor
uses the disk size as the scale value.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Disk Space Used
Parameters

Parameter Rqd Gen *ALL Notes

Disk Yes No No The disk name. Select GB or TB - default is
GB.

Description

The amount of disk space used. If the scale value for this type is left as 0, Robot Monitor uses the
disk size as the scale value.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Disk Status
Parameters

Parameter Rqd Gen *ALL Notes

Disk Yes No No The disk name.

Description

The status of the selected disk device. Can report as undefined or combinations of active, missing,
removed, noalloc, stale, hotspare, or backup.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Disk Transfer Rate
Parameters

Parameter Rqd Gen *ALL Notes

Disk Yes No No The disk name.

Description

The rate of I/O requests that were issued to the device over the collection interval
(requests/second).

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Disk Usage %
Parameters

Parameter Rqd Gen *ALL Notes

Disk Yes No No The disk name.

Description

The percentage disk used for the selected disk.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Disk Utilization %
Parameters

Parameter Rqd Gen *ALL Notes

Disk Yes No No The disk name.

Description

The amount of time over the sample interval in which disks were active.
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Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Disk Write Throughput
Parameters

Parameter Rqd Gen *ALL Notes

Disk Yes No No The disk name.

Description

The amount of data written, in KB per second, to the device over the collection interval.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Service Queue Rate Full
Parameters

Parameter Rqd Gen *ALL Notes

Disk Yes No No The disk name.

Description

The number of times in the collection interval that the service queue was full (not accepting any
more requests).

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Unix Processes Data Types
This group of element types monitors processes for AIX, Linux, and VIOS partitions.

TIP: In the following tables, 'Rqd' means the parameter is required, 'Gen' means the parameter
can be generic, and '*ALL' means select all instances for the parameter.

Maximum Process Run Time
Parameters

Parameter Rqd Gen *ALL Notes

User Yes No No Process user name. Prompted from
list of user profiles.

Group No No No Select a group.

Current User No No No Prompted from list of user profiles.
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Parameter Rqd Gen *ALL Notes

Command No No No Select a command.

Status No No No Select a status.

Description

The maximum time that a process matching the selection criteria has been running.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Process Count
Parameters

Parameter Rqd Gen *ALL Notes

User Yes No No Process user name. Prompted from list of user
profiles.

Group No No No Select a group.

Current User No No No Prompted from list of user profiles.

Command No No No Select a command.

Status No No No Select a status.

Description

The number of processes with the selected status.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

User Guide www.helpsystems.com page: 426



Data Types and Parameters / Unix Processes Data Types

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Process I/O Rate
Parameters

Parameter Rqd Gen *ALL Notes

User Yes No No Process user name. Prompted from list of user
profiles.

Group No No No Select a group.

Current User No No No Prompted from list of user profiles.

Command No No No Select a command.

Status No No No Select a status.

Description

The number of process transfers per second over the sample interval.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Process Resident Memory
Parameters

Parameter Rqd Gen *ALL Notes

User Yes No No Process user name. Prompted from list of user
profiles.

Group No No No Select a group.

Current User No No No Prompted from list of user profiles.

Command No No No Select a command.

Description

The amount (in MB) of non-swapped physical memory used by the processes at the sample time.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Process Status
Parameters

Parameter Rqd Gen *ALL Notes

User Yes No No Process user name. Prompted from list of user
profiles.

Group No No No Select a group.

Current User No No No Prompted from list of user profiles.

Command No No No Select a command.
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Description

The status of the selected job. *NF if not found. If more than one job is found that fits the selection
parameters, Robot Monitor selects the more interesting status.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Process Thread Count Total
Parameters

Parameter Rqd Gen *ALL Notes

User Yes No No Process user name. Prompted from list of user
profiles.

Group No No No Select a group.

Current User No No No Prompted from list of user profiles.

Command No No No Select a command.

Status No No No Select a status.

Description

The total number of active threads running in the selected processes.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x
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OS Yes No

AIX x

Linux x

VIOS x

Process Total CPU Usage
Parameters

Parameter Rqd Gen *ALL Notes

User Yes No No Process user name. Prompted from list of user
profiles.

Group No No No Select a group.

Current User No No No Prompted from list of user profiles.

Command No No No Select a command.

Status No No No Select a status.

Description

The percentage of CPU power used by the processes over the sample interval.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Process Virtual Memory
Parameters

Parameter Rqd Gen *ALL Notes

User Yes No No Process user name. Prompted from list of user
profiles.

Group No No No Select a group.

Current User No No No Prompted from list of user profiles.

Command No No No Select a command.

Status No No No Select a status.

Description

The total size (in MB) of active swap space taken at the end of the sample interval.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Subsystem Status (Process)
Parameters

Parameter Rqd Gen *ALL Notes

Subsystem
Name

Yes No No Name of the subsystem for jobs to be
monitored. Prompted from active subsystems.
You need to specify a library first before you can
choose a subsystem.

Subsystem
Library

Yes No No The library for the subsystem.
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Description

Returns the status of the selected subsystem: running, stopped, locked, or disabled.

Type

Text

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Thread Count per Process
Parameters

Parameter Rqd Gen *ALL Notes

User Yes No No Process user name. Prompted from list of user
profiles.

Group No No No Select a group.

Current User No No No Prompted from list of user profiles.

Command No No No Select a command.

Status No No No Select a status.

Description

The average number of active threads per process, running in the selected processes.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x
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OS Yes No

Linux x

VIOS x

Total Jobs in System (Count)
See System Performance Data Types for more information.

Total Process CPU
Parameters

Parameter Rqd Gen *ALL Notes

User Yes No No Process user name. Prompted from list of user
profiles.

Group No No No Select a group.

Current User No No No Prompted from list of user profiles.

Command No No No Select a command.

Status No No No Select a status.

Description

The total amount of CPU time in seconds consumed by the selected processes.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Unix Processors Data Types
This group of element types monitors processors for AIX, Linux, and VIOS partitions.
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TIP: In the following tables, 'Rqd' means the parameter is required, 'Gen' means the parameter
can be generic, and '*ALL' means select all instances for the parameter.

CPU Pressure
Parameters

None

Description

Percentage of time that processes were starved of CPU.

Note: Only available on Linux kernels 5.2 and later.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Percentage of CPU Entitlement Used
Parameters

None

Description

The percentage of entitled CPU capacity consumed. This is only useful if the partition is sharing
processors.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.
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OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Physical CPUs in Use
Parameters

None

Description

The number of physical processors used. This is only useful if the partition is sharing processors.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Processor CPU Usage
Parameters

Parameter Rqd Gen *ALL Notes

Processor Yes No No Select a processor.

Description

The CPU utilization, non-idle time as a percentage of available CPU time. This value will never
exceed 100%.

Type

Composite
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OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Processor CPU Usage I/O Wait
Parameters

Parameter Rqd Gen *ALL Notes

Processor Yes No No Select a processor.

Description

The percentage of CPU time over the collection period that the CPU was idle, during which the
system had outstanding I/O request.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Processor CPU Usage Idle
Parameters

Parameter Rqd Gen *ALL Notes

Processor Yes No No Select a processor.
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Description

The percentage of CPU time over the collection period that the CPU was idle without outstanding
I/O requests.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Processor CPU Usage Kernel
Parameters

Parameter Rqd Gen *ALL Notes

Processor Yes No No Select a processor.

Description

The percentage of CPU utilization for the sample period that occurred while executing at the system
(kernel) level. This value will never exceed 100%.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Processor CPU Usage User
Parameters

Parameter Rqd Gen *ALL Notes

Processor Yes No No Select a processor.

Description

The percentage of CPU utilization for the sample period that occurred while executing at the user
(application) level.

Type

Composite

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Unix Volume Groups Data Types
This group of element types monitors volume groups for AIX, Linux, and VIOS partitions.

TIP: In the following tables, 'Rqd' means the parameter is required, 'Gen' means the parameter
can be generic, and '*ALL' means select all instances for the parameter.

Volume Group Read Throughput
Parameters

Parameter Rqd Gen *ALL Notes

Volume Group Yes No No The volume group name.

Description

The data read rate, in KB per second, over the collection interval.
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Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Volume Group Stale PV Count
Parameters

Parameter Rqd Gen *ALL Notes

Volume Group Yes No No The volume group name.

Description

The current number of stale physical volumes in the volume group.

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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Volume Group Status
Parameters

Parameter Rqd Gen *ALL Notes

Volume Group Yes No No The volume group name.

Description

The status of the selected volume group (active/complete, active/partial, or inactive).

Type

Integer

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x

Volume Group Transfer Rate
Parameters

Parameter Rqd Gen *ALL Notes

Volume Group Yes No No The volume group name.

Description

The transfer rate (in and out) in requests per second over the collection interval.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x
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OS Yes No

AIX x

Linux x

VIOS x

Volume Group Write Throughput
Parameters

Parameter Rqd Gen *ALL Notes

Volume Group Yes No No The volume group name.

Description

The data write rate, in KB per second, over the collection interval.

Type

Float

OS Compatible?

This table shows which operating systems you can add this data type to.

OS Yes No

IBM i x

AIX x

Linux x

VIOS x
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